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1 Introduction

1.1 Purpose of the Operating Guide
The purpose of this operating guide is to describe the VLT® Multiaxis Servo Drive MSD 520 System.

This operating guide contains information about:

l Installation

l Commissioning

l Programming

l Operation

l Troubleshooting

l Service and Maintenance

This operating guide is intended for use by qualified personnel. Read the operating guide in full to use the servo system safely and

professionally, and pay particular attention to the safety instructions and general warnings.

This operating guide is an integral part of the servo system and also contains important service information. Therefore always keep this

operating guide available with the servo system.

Compliance with the information in the guide is a prerequisite for:

l Trouble-free operation

l Recognition of product liability claims

Therefore, read this operating guide before working with the VLT® Multiaxis Servo Drive MSD 520 System.

1.2 Additional Resources
Table 1: Additional Resources

Guide Description

VLT® Servo Drive System ISD520/DSD520 Operating Guide. Information about the installation, commissioning, and operation
of the system.

Advanced Functional Safety for VLT® FlexMotion™ Information about the installation, commissioning, operation,
programming, and troubleshooting of the Advanced Functional
Safety option for VLT® FlexMotion™

1.3 Trademarks

Automation Studio™ is a trademark of Famic Technologies Inc.

FlexMotion™ is a trademark of Danfoss A/S.

FlexSafety™ is a trademark of Danfoss A/S.

CANopen® is a registered community trademark of CAN in Automation e.V.

CODESYS® is a registered trademark of CODESYS Development GmbH.

EtherCAT® is a registered trademark and patented technology, licensed by Beckhoff Automation GmbH, Germany.

EnDat® and EnDat 3 ® are registered trademarks of Dr. Johannes Heidenhain GmbH.

Ethernet POWERLINK® is a registered trademark of ABB Asea Brown Boveri Ltd.

HIPERFACE® is a registered trademark of SICK STEGMANN GmbH.

ISD® is a registered trademark of Danfoss A/S.



LITTELFUSE® is a registered trademark of Littelfuse, Inc.

PLCopen® is a registered trademark owned by the association PLCopen.

PROFIBUS® and PROFINET® are registered trademarks of PROFIBUS and PROFINET International (PI).

PRONETA® is a registered trademark of Siemens AG.

SIMOTION SCOUT® is a registered trademark of Siemens AG.

SIBA® is a registered trademark of SIBA GmbH.

TIA Portal® is a registered trademark of Siemens AG.

TwinCAT® is a registered trademark of Beckhoff Automation GmbH, Germany.

VLT® is a registered trademark for Danfoss A/S.

Wireshark® is a registered trademark of the Wireshark Foundation.

1.4 Document Version
The original language of this guide is English.

Version Remarks

AQ448939736224, version 01 First release

1.5 Approvals and Certifications
Table 2: Product and System Approvals and Certifications

Certification Description

IEC/EN 61800-3 Adjustable speed electrical power drive systems.

Part 3: EMC requirements and specific test methods.

IEC/EN 61800-5-1 Adjustable speed electrical power drive systems.

Part 5-1: Safety requirements - Electrical, thermal, and energy.

IEC/EN 61800-5-2 Adjustable speed electrical power drive systems.

Part 5-2: Safety requirements - Functional.

IEC/EN 61508-1 Functional safety of electrical/electronic/programmable electronic
safety-related systems.

Part 1: General requirements.

IEC/EN 61508-2 Functional safety of electrical/electronic/programmable electronic
safety-related systems.

Part 2: Requirements for electrical/electronic/programmable elec-
tronic safety-related systems.

EN ISO 13849-1 Safety of machinery - Safety-related parts of control systems.

Part 1: General principles for design.

EN ISO 13849-2 Safety of machinery - Safety-related parts of control systems.

Part 2: Validation.

IEC/EN 60529 Degrees of protection provided by enclosures (IP Code).

UL 61800-5-1 Adjustable speed electrical power drive systems.

Part 5-1: Safety requirements - Electrical, thermal, and energy.

CSA C22.2 No. 274 Standard specifying requirements for adjustable speed drives with
regard to electrical, thermal, and energy safety considerations.
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Table 2: Product and System Approvals and Certifications - (continued)

Certification Description

CE

2014/30/EU Electromagnetic Compatibility (EMC) Directive.

2014/35/EU Low Voltage Directive (LVD).

2011/65/EU amended (EU) 2015/863 Restriction of Hazardous Substances (RoHS).

2006/42/EC Machinery Directive (MD).

Ethernet POWERLINK® Ethernet-based fieldbus system.

Ethernet PROFINET® Ethernet-based fieldbus system.

Ethernet PROFIsafe® Safety profile for sending safety-critical data via PROFINET.

Ethernet EtherCAT® Ethernet-based fieldbus system.

EtherCAT® is a registered trademark and patented technology, li-
censed by Beckhoff Automation GmbH, Germany.

Safety over EtherCAT® (FSoE) Safety profile for sending safety-critical data over EtherCAT®.

Safety over EtherCAT® is a registered trademark and patented
technology, licensed by Beckhoff Automation GmbH, Germany.

PLCopen® Technical specification. Function blocks for motion control (for-
merly Part 1 and Part 2) Version 2.0 March 17, 2011.

1.6 Areas of Application
Potential areas of application are:

l Food and beverage machines

l Packaging machines

l Pharmaceutical machines

l Applications running with a group of servo drives

1.7 Software
Updates to the firmware, VLT® Servo Toolbox software, and PLC libraries may be available. Download the available updates from the VLT®

Servo Toolbox (danfoss.com) website.

The VLT® Servo Toolbox software or the PLC libraries can be used to install the firmware on the system components.

1.8 Terminology
Table 3: Terminology

Term Description

DSD 520 Decentral Servo Drive.

DVC Decisive Voltage Class.

EXM 520 Expansion module.

Feed-in cable Hybrid cable which connects the PSM 520 to the 1st servo drive.

VLT® Multiaxis Servo Drive MSD 520 > Operating Guide > Introduction

https://www.danfoss.com/en-us/service-and-support/downloads/dds/vlt-servo-toolbox/
https://www.danfoss.com/en-us/service-and-support/downloads/dds/vlt-servo-toolbox/


Table 3: Terminology - (continued)

Term Description

ISD 520 Integrated Servo Drive.

LCP Local control panel.

Loop cable Hybrid cable for connecting servo drives in daisy-chain format.

MSD 520 Multiaxis Servo Drive.

PLC Programmable Logic Controller (external device for controlling the servo system).

PSM 520 Power Supply Module.

SDM 521 Servo Drive Module (single axis).

SDM 522 Servo Drive Module (double axis).

Servo drives SDM 521/SDM 522, ISD 520/DSD 520.

System components Includes PSM 520, SDM 521/SDM 522, EXM 520, ISD 520/DSD 520.

System modules Includes PSM 520, SDM 521/SDM 522, EXM 520.

VIN PSM Input of PSM 520 (V AC).

VOUT PSM Output of PSM 520 (V DC).
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2 Safety

2.1 Safety Symbols
The following symbols are used in Danfoss documentation and products.

  DANGER

Indicates a hazardous situation which, if not avoided, will result in death or serious injury.

  WARNING

Indicates a hazardous situation which, if not avoided, could result in death or serious injury.

  CAUTION

Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

  NOTICE

Indicates information considered important, but not hazard-related (for example, messages relating to property damage).

ISO warning symbol for general warnings

ISO warning symbol for hot surfaces and burn hazard

ISO warning symbol for high voltage and electric shock

Symbol for indicating the required discharge time of the capacitors in the product.

ISO action symbol for referring to the instructions

2.2 Important Safety Warnings
The following safety instructions and precautions relate to the MSD 520 system. Read the safety instructions carefully before starting to

work in any way with the servo system or its components. Pay particular attention to the safety instructions in the relevant sections of

this guide.

  WARNING

HAZARDOUS SITUATION

If the servo system components, or the bus lines are incorrectly connected, there is a risk of death, serious injury, or damage to the

unit.

l Always comply with the instructions in this guide and national and local safety regulations.
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  WARNING

HIGH VOLTAGE

The servo system contains components that operate at high voltage when connected to the electrical supply

network. Not all components have indicators that indicate the presence of mains supply. Incorrect installation,

commissioning, or maintenance may lead to death or serious injury.

l Installation, commissioning, and maintenance may only be performed by qualified personnel.

  WARNING

DISCHARGE TIME

The servo system contains DC-link capacitors that remain charged for some time after the mains supply is

switched off at the Power Supply Module (PSM 520). Failure to wait the specified time after power has been

removed before performing service or repair work could result in death or serious injury.

l To avoid electric shock, fully disconnect the Power Supply Module (PSM 520) from the mains and wait

for the capacitors to fully discharge before carrying out any maintenance work on the servo system or

replacing components.

Minimum waiting time (minutes)

15

  WARNING

TOUCH CURRENT HAZARD

The touch current is the electric current passing through a person when touching conductive accessible parts

of an electrical device. This is > 3.5 mA. Improper grounding of the system components may result in death or

serious injury.

l For reasons of personal safety, use a certified electrical installer to ground the system correctly in

accordance with the applicable local and national electrical standards and directives, and the instructions

in this guide.

l The minimum size of the PE conductor shall comply with the local safety regulations for high touch

current.

  WARNING

RISK OF ELECTRIC SHOCK

More than 1 disconnect switch is required to de-energize the equipment before servicing (Mains and Auxiliary

supply). Failure to switch off both sources of supply before performing service or repair work could result in

death or serious injury.

l Ensure both sources of supply are de-energized before servicing.

  WARNING

ELECTRIC SHOCK HAZARD

The system modules are open type and provide protection against direct contact to hazardous live parts.

l These are intended to be installed inside a supplementary enclosure to improve protection against

electric shock, thus ensuring over time no direct contact to hazardous live parts.
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  WARNING

FIRE HAZARD

The system modules are open type and do not provide comprehensive mitigation for fire hazard.

l These are intended to be installed inside a supplementary enclosure or in a restricted-access area which provides appropriate

protection against the spread of fire.

  WARNING

UNINTENDED START

The servo system is connected to the electrical supply network and can start running at any time. This may be caused by a

fieldbus command, a reference signal, or clearing a fault condition. Servo drives and all connected devices must be in good

operating condition. A deficient operating condition may lead to death, serious injury, damage to equipment, or other material

damage when the unit is connected to the electrical supply network.

l Take suitable measures to prevent unintended starts.

  WARNING

UNINTENDED MOVEMENT

Unintended movement may occur immediately when parameter changes are carried out, which may result in death, serious

injury, or damage to equipment.

l When changing parameters, take suitable measures to ensure that unintended movement cannot pose any danger.

  CAUTION

DANGER OF BURNS

The surface of the servo drives can reach high temperatures of over 80 °C (176 °F) during operation.

l Do not touch the servo drives until they have cooled down.

  CAUTION

CONNECTING/DISCONNECTING HYBRID CABLES

Never connect or disconnect the hybrid cable to or from the servo drives when the servo system is connected to mains or auxiliary

supply, or when voltage is still present. Doing so damages the electronic circuitry. Ensure that the mains supply is disconnected

and the required discharge time for the DC-link capacitors has elapsed before disconnecting or connecting the hybrid cables to

the PSM 520.

l To avoid electrical shock, fully disconnect the PSM 520 from the mains and wait for the discharge time to elapse before

disconnecting or connecting the hybrid cables or disconnecting cables from the PSM 520.
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  NOTICE

RCD COMPATIBILITY

The servo system contains components that can cause a DC current in the protective earthing conductor, which may result in

malfunction in any devices connected to the system.

l Where a residual current-operated protective device (RCD) is used for protection against electric shock, only an RCD of Type B

is allowed on the supply side of this product. All upstream RCD, up to the supply transformer, shall be of Type B.

l Recommended RCD sensitivity is 300 mA. For complex systems with more than 10 drives, it is recommended to consider RCD

with lower sensitivity (>300 mA, for example, 500 mA).

2.3 Safety Instructions and Precautions
Compliance with the safety instructions and precautions is necessary at all times.

l Orderly and proper transport, storage, fitting, and installation, as well as careful operation and maintenance, are essential for the

trouble-free and safe operation of the servo system and its components.

l Only suitably trained and qualified personnel may work on the servo system and its components or in its vicinity.

l Only use accessories and spare parts approved by Danfoss.

l Comply with the specified ambient conditions.

l The information in this guide about the use of available components is provided solely by way of examples of applications and

suggestions.

l The plant engineer or system engineer is personally responsible for checking the suitability of the supplied components and the

information provided in this guide for the specific application concerned:

¢ For compliance with the safety regulations and standards relevant to the specific application.

¢ For implementing the necessary measures, changes, and extensions.

l Commissioning the servo system or its components is not allowed until it has been ascertained that the machine, system, or plant in

which they are installed conforms to the statutory provisions, safety regulations, and standards that apply to the application in the

country of use.

l Operation is only allowed in compliance with the national EMC regulations for the application concerned.

l Compliance with the limit values specified by national regulations is the responsibility of the producer of the plant, system, or

machine.

l Compliance with the specifications, connection conditions, and installation conditions in this guide is mandatory.

l The safety regulations and safety provisions of the country in which the equipment is used must be observed.

l To protect the user against electric shock and to protect the servo system against overload, protective grounding is obligatory and

must be performed in accordance with local and national regulations.

2.4 Operational Safety
l Safety-related applications are only allowed if they are explicitly and unambiguously mentioned in this guide.

l All applications that can cause hazards to people or damage to property are safety-related applications.

l The stop functions implemented in the software of the PLC do not interrupt the mains supply to the Power Supply Module

(PSM 520). Therefore, they must not be used for electrical safety for the servo system.

l The servo system can be brought to a stop by a software command or a zero-speed setpoint, however DC voltage remains present

on the servo drives and/or mains voltage in the PSM 520. Also, when the system is stopped, it may start up again on its own if the

circuitry is defective or after the elimination of a temporary overload, a problem with the supply voltage, or a problem with the

system. If personal safety risks (such as injury from moving parts after an unintended start) must be prevented, these stop functions
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are not sufficient. In this case, ensure that the servo system is detached from the mains network, and prevent unintended motor

starting, for example, by using the Safe Torque Off (STO) function.

l The servo system may start running unintentionally during parameter configuration or programming. If this poses a risk to personal

safety (for example, risk of personal injury due to contact with moving machine parts), prevent unintended motor starting, for

example, by using the Safe Torque Off (STO) function, or by safe disconnection of the servo drives.

l In addition to the L1, L2, and L3 supply voltage inputs on the PSM 520, the servo system has other supply voltage inputs, including

external auxiliary voltage. Before commencing repair work, check that all supply voltage inputs are switched off and that the

necessary discharge time for the DC-link capacitors has elapsed.

2.5 Qualified Personnel
Installation, commissioning, and maintenance may only be carried out by qualified personnel. For the purposes of this guide and the

safety instructions in this guide, qualified personnel are trained personnel who are authorized to fit, install, commission, ground, and

label equipment, systems, and circuits in accordance with the standards for safety technology and who are familiar with the safety

concepts of automation engineering.

Also, the personnel must be familiar with all the instructions and safety measures described in this guide. They must have suitable safety

equipment and be trained in first aid.

2.6 Due Diligence
The operator and/or fabricator must ensure that:

l The servo system and its components are used only as intended.

l The components are operated only in a perfect operational condition.

l The operating instructions are always available near the servo system in complete and readable form.

l The servo system and its components are fitted, installed, commissioned, and maintained only by adequately qualified and

authorized personnel.

l These personnel are regularly instructed on all relevant matters of occupational safety and environmental protection, as well as the

contents of the operating instructions and the instructions it contains.

l The product markings and identification markings applied to the components, as well as safety and warning instructions, are not

removed and are always kept in a legible condition.

l The national and international regulations regarding the control of machinery and equipment, that are applicable at the place of use

of the servo system, are complied with.

l The users always have all current information relevant to their interests about the servo system and its use and operation.

2.7 Intended Use
The components of the servo system are intended to be installed in machines used in industrial environments in accordance with local

laws and standards.

  NOTICE

l This equipment is not intended for use in residential locations and may not provide adequate protection to radio reception in

such locations.

l This product is not intended to be used on a low voltage public network which supplies residential premises, and radio

frequency interference is expected if used on such a network.

l In a domestic environment, this product may cause radio interferences, in which case supplementary mitigation measures

may be required.
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To ensure that the product is used as intended, the following conditions must be fulfilled before use:

l Everyone who uses Danfoss products in any manner must read and understand the corresponding safety regulations and the

description of the intended use.

l Do not alter hardware from its original state.

l Do not reverse-engineer software products or alter their source code.

l Do not install or operate damaged or faulty products.

l Ensure that the products are installed in conformance with the regulations mentioned in the documentation.

l Observe any specified maintenance and service intervals.

l Comply with all protective measures.

l Only fit or install the components described in this operating guide. Third-party devices and equipment may be used only in

consultation with Danfoss.

2.8 Prohibited Application Areas
The servo system may not be used in the following application areas:

l Areas with potentially explosive atmospheres.

l Mobile or portable systems.

l Floating or airborne systems.

l Inhabited facilities.

l Sites where radioactive materials are present.

l Areas with extreme temperature variations or in which the maximum rated temperatures may be exceeded.

l Under water.

2.9 Foreseeable Misuse
Any use not expressly approved by Danfoss constitutes misuse. This also applies to failure to comply with the specified operating

conditions and applications. Danfoss assumes no liability of any sort for damage attributable to improper use.

2.10 Service and Support
Contact the local service representative for service and support.
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3 System Description

3.1 Overview of the VLT® Multiaxis Servo Drive System MSD 520
The VLT® Multiaxis Servo Drive System MSD 520 is a high-performance central servo motion solution.

The open system supports the real-time Ethernet protocols:

l EtherCAT®

l Ethernet POWERLINK®

l PROFINET®

e3
0b

m
67

6.
10

PSM 520

SDM 521 (FS2)

SDM 521 (FS1)

SDM 522 (FS1)

EXM 520

Figure 1: MSD Modules

The system comprises:

l Power Supply Module (PSM 520)

¢ Available with DAM option

l Drive Modules:

¢ Single-axis Servo Drive Module (SDM 521)

¢ Double-axis Servo Drive Module (SDM 522)
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l Expansion Module (EXM 520)

l Software:

¢ Firmware for the Power Supply Module (PSM 520)

¢ Firmware for the Servo Drive Modules (SDM 521 and SDM 522)

¢ Pc software tool: VLT® Servo Toolbox

¢ PLC libraries for Automation Studio™, TwinCAT®, SIMOTION SCOUT®, and TIA Portal®

The SDM 521 modules are available in 2 enclosure (frame) sizes with widths of (FS1) 50 mm (2.0 in) or (FS2) 100 mm (3.9 in) depending on

the power size.

Depending on the application, the system can be used exclusively as a central system, or together with Danfoss Decentral Servo Drives

(ISD 520 and DSD 520) as a mixed system. Use of an AC choke is mandatory, for further information see 5.9.1 AC Line Choke.

The system modules PSM 520, SDM 521/SDM 522, and EXM 520 are mounted to a backplate inside the control cabinet. DC link and the

control voltage supply are integrated in the backplate. The 'click and lock' backplate concept offers easy mounting and installation.

  NOTICE

l The system modules cannot be used in servo systems from other manufacturers. Drives from other manufacturers cannot be

used in the MSD 520 system.

l Contact Danfoss for further information.

  NOTICE

l The system modules have a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00). They are

only designed for use within a control cabinet. The system modules can be damaged if exposed to fluids.

  NOTICE

l Only the components described in this guide may be fitted or installed. Third-party devices and equipment may be used only

in consultation with Danfoss.

l For security reasons, do not connect the system components to the internet.

l Only configure the system components using the specified HMI or the VLT® Servo Toolbox software.

l Contact Danfoss for further information.

3.2 Applications and Module Limits

3.2.1 Application Examples

There are numerous potential areas of application for the servo system including, but not limited to, the examples in Table 4.

Table 4: Application Examples 

Category Machine type

Filling

PET blow-moulding

Capping

Beverage machines

Labeling
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Table 4: Application Examples  - (continued)

Category Machine type

Flow wrapping

Bag maker

Tray sealing

Food and beverage packaging machines

Shrink wrapping

Palletization

Top loader

Cartoning

Tube filling

Blister machine

Liquid filling

Industrial and pharmaceutical packaging machines

Solid dosing

3.2.2 Maximum Number of Modules

The maximum number of modules in the VLT® Multiaxis Servo Drive MSD 520 System is:

l PSM 520: 2 per system

l SDM 521/SDM 522: Depends on the current rating and output power of the servo drive modules and the AUX current consumption

during operation. Contact Danfoss for further information about the maximum number of servo drive modules.

3.3 Power Supply Module PSM 520

3.3.1 Overview of PSM 520

PSM is the abbreviation for Power Supply Module. It is the power supply to the servo system. The PSM 520 supplies a DC power voltage

and guarantees high-density output power. The DC link and 24/48 V DC are distributed via the backlink in the backplates to all system

modules. The DAM option (factory-mounted option) of the PSM 520 is used to supply the decentral servo system with power and

fieldbus. The PSM 520 can be controlled via Ethernet-based fieldbus.

Indicator lights (LEDs) on the front of the PSM 520 show the operating status and warnings.

  NOTICE

l The MSD 520 system is designed for use within a control cabinet. If the STO function or another safety function is used, the

cabinet must be rated at least IP54.

l The PSM 520 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

l The PSM 520 can be damaged if exposed to fluids.

  NOTICE

l The connectors at the top side do not fulfill strain relief requirements. When using digital I/Os, configure the logic values that

ensure that the system enters a known state if a wire disconnects.

All power cables are wired into the PSM 520, therefore at least 1 PSM 520 is required for each system.

The PSM 520 also performs service functions, such as voltage measuring, and is cooled with an internal fan.

The PSM 520 incorporates a brake chopper and internal brake resistor, at the same time there is the possibility to connect an external

brake resistor.
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The PSM 520 is available in 3 power sizes and delivers an output power of 10 kW, 20 kW, or 30 kW with 200% overload capacity for 3 s. To

achieve an output power of up to 60 kW, 2 PSM 520 modules can be used in parallel.

An example type code for the PSM 520 is: MSD-520SAPS04-30P0EC. Definition of PSM 520 type codes, refer to Table 6.
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Figure 2: Power Supply Module PSM 520

1 Backplate 2 24/48 V input connector

3 Cable relief and shielding 4 Connectors: Digital input, STO, relay, and Ethernet

5 Operating indicator lights (LEDs) 6 LCP connector

7 PE screws 8 External brake resistor

9 AC mains supply 10 DAM option connectors: AUX, Ethernet, STO, and UDC

11 Cable relief and shielding

3.3.2 PSM 520 Types

  NOTICE

l The type code defines the specification of the module included in the delivery. It is shown on the product label and the

package label.

l The type code is made of standard codes and plus codes. Each part of the type code corresponds to the data in the order.

l The Drive Configurator shows the valid configuration variants.

l Only selected options are visible in the type code. Standard characteristics do not appear.
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Table 5: Type Code for PSM 520 (Example)
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MSD-520 SA PS A4 –30P0 PL See Table 6.

Table 6: Legend Table for Type Code PSM 520

1 Product group + Functional safety

MSD-520 VLT® Multiaxis Servo Drive 520 +BEF1 Hard wired STO (standard)

2 Product category + Option board

SA Air-cooled +CTXX Without option board (stan-
dard)

3 Product type + Integrated brake chopper

PS Power supply module +ACBC Yes (with integrated resistor)

4 Mains voltage + Integrated common-mode fil-
ter

A4 208–480 V AC +AIC1 Yes (with integrated filter)

D6 600 V DC + DC fuses and devices

5 Output +AKXX Without (standard)

-10P0 10 kW +AKD1 DAM option 12 A

-20P0 20 kW +AKD2 DAM option 20 A

-30P0 30 kW +AKD3 DAM option 28 A

6 Communication interface + Standard I/Os

PL Ethernet POWERLINK® +BDS1 With basic I/Os

EC EtherCAT® + Product software

PN PROFINET® +ECXXX Latest released version (stan-
dard)

+ Technical documentation

+EGXX Without (standard)

+EGIN Installation guide

+ Packaging

+TACB Cardboard box (standard)

3.3.3 Connectors on the Top of PSM 520
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Figure 3: Connectors on the Top of Power Supply Module PSM 520

1 Relay connector 2 Ethernet connector IN

3 Ethernet connector OUT 4 Digital input

5 STO connector OUT 6 STO connector IN

7 24/48 V IN connector

3.3.4 Connectors on the Bottom of PSM 520
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Figure 4: Connectors on the Bottom of Power Supply Module PSM 520

1 AC mains supply connector 2 External brake resistor connector

3 UDC connector 4 STO connector

5 AUX connector 6 Ethernet connector

The connectors 3–6 are only available if the DAM option is mounted.

3.3.5 DAM Option

The Decentral Access Module (DAM) option is a central interface/gateway to the decentral servo system, which is an optional feature to

the PSM 520. The DAM option board is used to connect the Danfoss VLT® Integrated Servo Drive (ISD) 520 and VLT® Decentral Servo Drive

(DSD) 520 to the servo system via a hybrid feed-in cable.

The DAM option board supplies the decentral servo drives with DC link, UAUX, STO, and the Ethernet-based fieldbus via the hybrid feed-

in cable.

Functions that the DAM option board provides:

l Overcurrent protection of the hybrid cable.
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l Short-circuit protection of the hybrid cable.

l Under-/overvoltage protection of the AUX voltage on the hybrid cable.

l Overcurrent protection of the AUX voltage on the hybrid cable.

Current sizes for DAM option:

l AUX 15 Arms, DC-link 12.8 A (+AKD1).

l AUX 15 Arms, DC-link 20 A (+AKD2).

l AUX 25 Arms, DC-link 28 A (+AKD3).

Refer to the fuse datasheet for overload capability.

Table 7: Type Code for PSM 520 with DAM Option (Example)
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MSD-520 SA PS A4 –30P0 EC – – – – +AKD3 – – – –

Definition of PSM 520 type codes, refer to Table 6.

3.4 Servo Drive Module SDM 521/SDM 522

3.4.1 Overview of SDM 521/SDM 522

SDM is the abbreviation for Servo Drive Module. The SDM 521 is a single-axis servo drive available in 5 power sizes and 2 enclosure sizes

(FS1 is 50 mm (2.0 in) and FS2 is 100 mm (3.9 in) ). The SDM 522 is a double-axis servo drive available in 3 power sizes and 1 enclosure

size (FS1, 50 mm (2.0 in)). A double-axis module operates 2 servo motors independently. The SDMs are equipped by default with digital I/

Os and Safe Torque Off (STO) and support several motor feedback encoders.

  NOTICE

l The MSD 520 system is designed for use within a control cabinet. If the STO function or another safety function is used, the

cabinet must be rated at least IP54.

l The SDMs have a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

l The SDMs can be damaged if exposed to fluids.

  NOTICE

l The connectors at the top side do not fulfill strain relief requirements. When using digital I/Os, configure the logic values that

ensure that the system enters a known state if a wire disconnects.
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Figure 5: Servo Drive Module SDM 521/SDM 522

1 Connectors: I/O, STO, relay, and Ethernet 2 Operating indicator lights (LED)

3 LCP Connector 4 PE screws

5 Connectors: Motor, motor feedback, thermistor, and brake 6 Cable relief and shielding

7 Cable relief and shielding 8 Back plate

3.4.2 SDM 521/SDM 522 Types

  NOTICE

l The type code defines the specification of the module included in the delivery. It is shown on the product label and the

package label.

l The type code is made of standard codes and plus codes. Each part of the type code corresponds to the data in the order.

l The Drive Configurator shows the valid configuration variants.

l Only selected options are visible in the type code. Standard characteristics do not appear.
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Table 8: Type Code for SDM 521/SDM 522 (Example)
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MSD-520 SA AS D6 –40A0 EC See Table 9.

Table 9: Legend Table for Type Code SDM 521/SDM 522

1 Product group + Functional safety

MSD-520 VLT® Multiaxis Servo Drive 520 +BEF1 Hard-wired STO (standard)

2 Product category +BEFS VLT® FlexSafety™ over fieldbus

SA Air-cooled + Option board

3 Product type +CTXX Without option board (stan-
dard)

AS Axis single module +CTIO Standard I/O option board

AD Axis double module +CTSO Safe I/O board

4 Mains voltage + DC fuses and devices

A4 208–480 V AC +AKFX With DC-link fuses (standard)

D6 600 V DC + Standard I/Os

5 Output +BDS1 With basic I/Os

-02A5 2.5 A + Motor feedback

-05A0 5.0 A +FFMF Multi feedback (standard)

-10A0 10 A + Motor brake control

-20A0 20 A +IDBS With brake control (standard)

-40A0 40 A + Product software

6 Communication interface +ECXXX Latest released version (stan-
dard)

PL Ethernet POWERLINK® + Technical documentation

EC EtherCAT® +EGXX Without (standard)

PN PROFINET® +EGIN Installation guide

+ Packaging

+TACB Cardboard box (Standard)

3.4.3 Components

3.4.3.1 Cooling

The Servo Drive Modules SDM 521 and SDM 522 are cooled with a speed-controlled internal fan.
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3.4.4 Connectors on SDM 521

3.4.4.1 Connectors on the Top of SDM 521

For SDM 521 enclosure size 1 (FS1), 50 mm (2.0 in) and enclosure size 2 (FS2), 100 mm (3.9 in).
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Figure 6: Servo Drive Module SDM 521, Enclosure Size 1 (FS1)

1 I/O connector 2 Ethernet connector IN

3 Ethernet connector OUT 4 STO connector OUT

5 STO connector IN 6 Safe I/O connector
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Figure 7: Servo Drive Module SDM 521, Enclosure Size 2 (FS2)

1 I/O connector 2 Ethernet connector IN

3 Ethernet connector OUT 4 STO connector OUT

5 STO connector IN 6 Safe I/O connector

3.4.4.2 Connectors on the Bottom of SDM 521

For SDM 521 enclosure size 1 (FS1), 50 mm (2.0 in) and enclosure size 2 (FS2), 100 mm (3.9 in).
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Figure 8: Servo Drive Module SDM 521, Enclosure Size 1 (FS1)
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1 Motor feedback connector 2 Motor brake, thermistor and motor feedback (single
wire/1-cable technology) connector

3 Motor connector
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Figure 9: Servo Drive Module SDM 521, Enclosure Size 2 (FS2)

1 Motor feedback connector 2 Motor brake, thermistor and motor feedback (single
wire/1-cable technology) connector

3 Motor connector

3.4.5 Connectors on SDM 522

3.4.5.1 Connectors on the Top of SDM 522

For SDM 522 enclosure size 1 (FS1), 50 mm (2.0 in).
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Figure 10: Servo Drive Module SDM 522, Enclosure Size 1 (FS1)

1 I/O Connector SDM1 2 I/O Connector SDM2

3 Ethernet connector IN SDM1 4 Ethernet connector OUT SDM1

5 Ethernet connector IN SDM2 6 Ethernet connector OUT SDM2

7 STO Connector OUT SDM1 8 STO Connector IN SDM1

9 STO Connector IN SDM2 10 STO Connector OUT SDM2

11 Safe I/O SDM2 12 Safe I/O SDM1

3.4.5.2 Connectors on the Bottom of SDM 522

For SDM 522 enclosure size 1 (FS1), 50 mm (2.0 in).
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Figure 11: Servo Drive Module SDM 522, Enclosure Size 1 (FS1)

1 Motor feedback connector SDM2 2 Motor feedback connector SDM1

3 Motor brake, thermistor and motor feedback (single
wire/1-cable technology) connector

4 Motor connector SDM1

5 Motor brake, thermistor and motor feedback (single
wire/1-cable technology) connector

6 Motor connector SDM2

3.5 Expansion Module (EXM 520)
The EXM 520 supports modular machine setup by splitting the system modules into 2 control cabinets. The maximum length of the

cable between the EXM 520 modules is 5 m (16.4 ft).
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Figure 12: Expansion Module EXM 520

1 EMC shielding plate 2 Backplate

3 PE screw 4 Expansion connector

  NOTICE

l The system modules are designed for use within a control cabinet. If the STO function or another safety function is used, the

cabinet must be rated at least IP54.

l The EXM 520 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

l The EXM 520 can be damaged if exposed to fluids.

3.6 Local Control Panel (LCP)

3.6.1 Overview of the Local Control Panel

The LCP is the graphical user interface for diagnostic and operating purposes. It is available as an option and can be connected to the

system modules using an optional cable (M8 connector on ISD 520 and DSD 520 and a D-SUB connector on the system modules).

The LCP display provides the operator with a quick view of the state of the system modules, depending on which device it is connected

to. The display shows parameters and alarms/errors and can be used for commissioning and troubleshooting.
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It can also be used to perform simple functions, for example, activating and deactivating the output lines on the DAM option and

opening the mechanical brake on the SDM 521/522.

The LCP can be mounted on the front of the control cabinet. Use a mounting set (available as an accessory) and connect it to the

modules via M8 to SUB-D cables (available as an accessory).

  NOTICE

l Further information on the accessory code numbers can be found in the VLT® Servo Drive System ISD 520,

DSD 520, MSD 520 (VLT® FlexMotion™) Design Guide.

l Further information on the LCP functions can be found in the VLT® Servo Drive System ISD 520, DSD 520,

MSD 520 (VLT® FlexMotion™) Programming Guide.

3.6.2 Layout of the Local Control Panel

The local control panel is divided into 4 functional groups:

l A: Display area

l B: Display menu keys

l C: Navigation keys and indicator lights (LEDs)

l D: Operation keys and reset

To adjust the display contrast, press [Status] and the [▲/▼] keys.

3.6.3 A: Display Area

The values in the display area differ depending on which module the LCP is connected to.

The display area is activated when the module is connected to receive power from UAUX.
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Figure 13: Display Area when Connected to the Power Supply Module PSM 520
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Table 10: Legend Table for Display Area when Connected to the Power Supply Module PSM 520

Description

1 UAUX line voltage

2 Temperature power board

3 Actual UDC (current)

4 Power consumption

5 Actual UDC (voltage)
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Figure 14: Display Area when Connected to the Servo Drive Modules SDM 521/SDM 522

Table 11: Legend Table for Display Area when Connected to the Servo Drive Modules SDM 521/SDM 522

Description

1 Current actual value

2 Temperature power board

3 Position actual value

4 Actual velocity

3.6.4 B: Display Menu Keys

Menu keys are used for menu access for parameter setup, toggling through status display modes during normal operation, and viewing

fault log data.
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Table 12: Display Menu Keys

Key Function

6 Status Shows operational information.

7 Quick Menu Allows access to parameters.

8 Main Menu Allows access to parameters.

9 Alarm Log Shows the last 10 alarms.

3.6.5 C: Navigation Keys and Indicator Lights (LEDs)

Navigation keys are used for moving the display cursor and provide operation control in local operation. There are also 3 status indicator

lights (LEDs) in this area.

Table 13: Navigation Keys

Key Function

10 Back Reverts to the previous step or list in the menu struc-
ture.

11 Cancel Cancels the last change or command as long as the
display mode is not changed.

12 Info Press for a definition of the function being shown.

13 Navigation keys Use the 4 navigation keys to move between items in
the menu.

14 OK Use to access parameter groups or to enable a selec-
tion.

Table 14: Indicator Lights (LEDs)

LED Color Function

15 On Green The On LED activates when the servo drive or
module it is connected to receives power from
UAUX.

16 Warn Yellow When warning conditions are met, the yellow
Warn LED is activated and text appears in the dis-
play area identifying the problem.

17 Alarm Red A fault condition causes the red Alarm LED to
flash and an alarm text is shown.

3.6.6 D: Operation Keys and Reset

The operation keys are at the bottom of the LCP.
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Table 15: Operation Keys and Reset

Key Function

18 Hand On Enables the connected MSD 520 servo drive or PSM 520 to be con-
trolled via the LCP.

19 Off Puts the MSD 520 servo drive into state Switch on Disabled and the
PSM 520 into state Standby.

This only works in hand-on mode.

Off mode enables transition from hand-on mode to auto-on
mode.

20 Auto On Puts the system in remote operational mode.

In auto-on mode, the device is controlled with fieldbus (PLC).
Switching between auto-on and hand-on modes is only possible
when the drive is in state Switch on Disabledand/or the PSM 520 is
in state Standby.

21 Reset Resets the MSD 520 servo drive or PSM 520 after a fault has been
cleared.

The reset is only possible when in hand-on mode.

3.7 Cables

3.7.1 Hybrid Cable Specifications

3.7.1.1 Hybrid Cable

All dimensions are in mm.
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Figure 15: Hybrid Loop Cable

Pre-configured hybrid cables are used to connect the ISD 520/DSD 520 servo drives to the PSM 520 with DAM option.

There are 2 types of hybrid cables that are available with both angled and straight M23 connectors:

l Feed-in cable for connecting the 1st ISD 520/DSD 520 servo drive of a group to the connection point on the PSM 520 with DAM

option.

l Loop cable for connecting the ISD 520/DSD 520 servo drives in daisy-chain format in an application.

Both these cables are provided by Danfoss and are available in various lengths. See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520

(VLT® FlexMotion™) Design Guide for further information.

Both ends of the loop cable are fitted with M23 connectors.

The feed-in cable is fitted with an M23 connector at the output end for connection to the 1st ISD 520/DSD 520 servo drive. At the input

end, it is pigtailed and the connectors are mounted on the corresponding terminals on the DAM option.

Table 16: Hybrid Cables

Cable type Shielded/unshielded Notes

Feed-in cable

Loop cable

Shielded Hybrid cable (overall shield with additional
fieldbus and safety section shield).
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  NOTICE

l Hybrid cables are available in 2 cross-sections: 2.5 mm2 (16 A) and 4 mm2 (25 A for CE and UL, 20 A for

CSA).

l See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Design Guide for further

information.

VLT® ISD520 Hybrid Cable
175G0554
175r1192             Rev 001
11.08.2023
Loop Cable, 0.5m, 90° <> 90°
(2x2x24 AWG) PN+5G2.5+(2G0.5) C
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Figure 16: Example of a Hybrid Cable Product Label

1 Article number 2 Specification number

3 Production date 4 Cable configuration

5 Cable specification 6 Approvals

7 Data matrix code containing article number and
production date

8 Cable characteristics, for example, drag chain

3.7.1.2 Minimum Bending Radius for Hybrid Cable

Table 17: Minimum Bending Radius

Static cable Dynamic cable

Cable diameter 13.8 mm 15.6 mm

Permanent installation 25 mm bending radius 5 x cable diameter

Flexible installation Not allowed 12 x cable diameter

3.7.2 Ethernet Cable
Table 18: Ethernet Cable Recommendations

Characteristic Specification

Ethernet standard Standard Ethernet (in accordance with IEEE 802.3), 100Base-TX (Fast Ethernet)

Cable type S/FTP (shielded foiled twisted pair), ISO (IEC 11801 or EN 50173), CAT 5e or 6

Damping 23.2 dB (at 100 Mhz and 90 m (295.3 ft) each)

Crosstalk damping 24 dB (at 100 Mhz and 90 m (295.3 ft) each)

Return loss 10 dB (100 m (328.1 ft) each)

Surge impedance 100 Ω

Maximum cable length 90 m (295.3 ft) between switches or network devices

  NOTICE

l Ground the Ethernet cable through the RJ45 connector. Do not ground it on the strain relief.
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3.7.3 LCP Cable

The LCP cable is used to connect an LCP to a system module via the M8 connector on the front of each system module.

The LCP cable can be purchased from Danfoss.

For further information on the LCP cable and code numbers, see the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™)

Design Guide.

3.7.4 Cable Layout and Routing

3.7.4.1 Modules Connections

The system modules are connected via the backlink connector. For further information, see 11.5.2 Backlink Connector.

Connect the real-time Ethernet fieldbus to the 1st module in the MSD 520 system using a standard Ethernet cable. (The standard

Ethernet cable is not provided).

Use the Ethernet loop cables provided by Danfoss to connect to the other modules in daisy-chain format.

3.7.4.2 Maximum Cable Lengths

Table 19: Maximum Cable Lengths

Cable type Specification Maximum length

M23 Feed-in 35 m (114.8 ft)

M23 Loop 20 m (65.6 ft)

Fieldbus extension Length: 2 m (6.6 ft)

Maximum length to next port: 90 m (295.3 ft)

Hybrid cable

Maximum cable length per line 90 m (295.3 ft)

Motor cable – Maximum length without additional output filter or choke: 30 m
(98.4 ft)

Maximum length with additional output filter or choke: 80 m
(262.5 ft)

Feedback cable – 80 m (262.5 ft)

Expansion module cable – 5 m (16.4 ft)

3.7.4.3 Wiring of Output Filter

The SDM 521/SDM 522 modules use an IGBT transistor as an output element. These semiconductors generate the correct voltage for the

motor switching at a relatively high speed (4–6 kV/μs) with unloaded IGBT. Under certain circumstances, this high switching speed can

cause extra voltage stress on the main insulation of the motor. Usually, this is not a problem for motors designed for a 400 V supply. Such

motors are typically designed for a voltage level of 1200 V, which exceeds the induced stress of the variable frequency drive. There may

be cases where a dU/dt or sine-wave filter is required to avoid exceeding the allowable voltage stress.

  NOTICE

l In certain cases, verify the rating of the motor in variable frequency drive application with the motor manufacturer.
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  NOTICE

FILTER SWITCHING FREQUENCY

Set the switching frequency parameter to correspond to the value printed on the product label of the filter and the output

voltage level.

l Do not increase the switching frequency above the rated value of the filter. Decreasing switching frequency to a value lower

than the rated value is allowed.

Select the filters so their rated current is larger than the drive rated current. This ensures that the filters thermally withstand the same

overload specifications as the drive. In addition, the filter must be properly selected to withstand the drive operation conditions, and the

maximum output frequency.

Figure 17 illustrates the wiring connections between the SDM 521/SDM 522, output filter, and electric motor.
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Figure 17: Wiring Diagram of Output Filter

1 SDM 521/SDM 522 2 Output filter

3 Electric motor

The filter is cooled with natural air convection. During assembly, ensure that the filter is placed inside a ventilated enclosure to avoid

overheating and equipment damage.

The maximum motor cable length of 80 m (262.5 ft) includes the total distance from the drive to the motor, with the filter installed in

between.

3.8 Software
The software for the servo system comprises:

l The firmware of the system modules that is already installed on the system modules (except EXM 520).

l A package of PLC libraries for Automation Studio™ for operating the MSD 520 devices. See 6.11.2 Creating an Automation

Studio™ Project for further information.

l A PLC library for TwinCAT® 2 and 3 for operating the MSD 520 devices. See 6.12.2 Creating a TwinCAT® Project for further

information.

l A PLC library for SIMOTION SCOUT® for operating the MSD 520 devices. See 6.14.3 Creating a SIMOTION SCOUT® Project for further

information.

l A PLC library for TIA Portal® for operating the MSD 520 devices.

l VLT® Servo Toolbox: A Danfoss PC-based software tool for commissioning and debugging the devices.
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3.9 Fieldbus

3.9.1 Overview

The servo system has an open system architecture realized by fast Ethernet (100BASE-T) based communication. The system supports

EtherCAT®, Ethernet POWERLINK®, and PROFINET® fieldbuses.

In productive environments, communication to the devices always takes place via a PLC that acts as a master. The system components

can be controlled by these communication methods:

l Using the VLT® Servo Motion libraries (available for TwinCAT®, Automation Studio® and SIMOTION SCOUT®, TIA Portal®, and

CODESYS®).

l Using the NC axis functionality of TwinCAT® (ISD 520/DSD 520 and SDM 521/SDM 522 only).

l Using the CiA DS 402 standard by reading and writing to objects.

l Using application class 1 (AC1), (AC 4) PROFINET® only.

The system components can be operated with the following cycle times.

l EtherCAT® and Ethernet POWERLINK® fieldbuses:

¢ 400 μs and multiples of it (for example, 800 μs and 1200 μs).

¢ 500 μs and multiples of it (for example, 1 ms).

l PROFINET® fieldbus:

¢ IRT : 1 ms, 2 ms and 4 ms

¢ RT: 1 ms and multiples of it.

When the cycle time is a multiple of 400 μs and 500 μs, the time base of 500 μs is used.

The servo drives are certified for fieldbuses according to the corresponding rules and regulations. The servo drives conform to the

CANopen® CiA DS 402 Drive Profile.

3.9.2 EtherCAT®

The system components support the following EtherCAT® protocols:

l CANopen® over EtherCAT® (CoE)

l File Access over EtherCAT® (FoE)

l Ethernet over EtherCAT® (EoE)

The system components support distributed clocks. To compensate for the failure of a communication cable section in the system, cable

redundancy is available for all fieldbuses. See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®FlexMotion™) Design Guide for

further information.
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Figure 18: EtherCAT® Port Assignment for the ISD 520/DSD 520 Servo Drive
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X1 M23 hybrid cable connector to PSM 520 with DAM option

board or previous servo drive (EtherCAT® IN).

X2 M23 hybrid cable connector to the next servo drive
(EtherCAT® OUT 1 (B)).

X3 Logical port 1: M8 Ethernet cable connector to other

EtherCAT® slaves, for example, EtherCAT® encoder

(EtherCAT® OUT 2 (C)).

The connector is only available on the advanced servo

drives.
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Figure 19: EtherCAT® Port Assignment for the PSM 520 with DAM Option Board

X1 RJ45 cable connector to the previous slave or to the main
device (PLC).

X2 RJ45 to M23 hybrid feed-in cable to the 1st ISD 520/
DSD 520 servo drive (EtherCAT® OUT 2 (C)).

X3 RJ45 cable connector to the PLC (cable redundancy) or
next slave (EtherCAT® OUT 1 (B)).
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Figure 20: EtherCAT® Port Assignment for the Power Supply Module (PSM 520), Servo Drive Module SDM 521/SDM 522

X1 RJ45 cable connector to the PLC or previous slave
(EtherCAT® IN (A)).

X2 RJ45 cable connector to the PLC (cable redundancy) or
next slave (EtherCAT® OUT (C)).

3.9.3 Ethernet POWERLINK®

The system components conform to DS 301 V1.1.0 and support the following features:

l Work as a controlled node.

l Can be operated as multiplexed stations.

l Support of cross-communication.

l Ring redundancy supported for media redundancy.

l Specific ports are not assigned for Ethernet POWERLINK®.

3.9.4 PROFINET®

The system components support PROFINET® conformance class C as per IEC 61158-5-10:2014, IEC 61158-6-10:2014, IEC 61784-2:2014,

and IEC 61784-5-3:2013. All the system components act as I/O devices in a PROFINET®network.
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The following features are supported:

l I/O Device - Device controlled by the I/O-Controller

l Dynamic module configuration

l Net load class II

l Ring redundancy (MRPD) as client

PROFINET® fieldbus devices are always connected as network components via switches that are integrated in the fieldbus device.

There are 2 ports on the ISD 520/DSD 520 servo drives, SDM 521/SDM 522 servo drive modules and, PSM 520 with DAM option board.
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4 Mechanical Installation

4.1 Items Supplied
Depending on the application, the items supplied for the system are:

l VLT® Power Supply Module PSM 520

l VLT® Servo Drive Module SDM 521 (Single axis)

l VLT® Servo Drive Module SDM 522 (Double axis)

l VLT® Expansion Module EXM 520

l AC choke (see 5.9.1 AC Line Choke)

l This operating guide

l Feed-in (hybrid) cable

l Loop (hybrid) cable

  NOTICE

l The hybrid feed-in and loop cables are required when ISD 520/DSD 520 servo drives are used in the servo system.

The packaging unit depends on the number of modules delivered. Keep the packaging for potential return of the product.

4.2 Transport
l Always use means of transport and lifting gear with sufficient load capacity to transport the servo system components.

l Avoid vibration during transport.

l Avoid heavy impacts and blows.

4.3 Inspection on Receipt
Procedure

1. After receiving the delivery, immediately check whether the items supplied match the shipping documents. Danfoss does not

honor claims for faults registered later.

2. Register a complaint immediately with the carrier if there is visible transport damage.

3. Register a complaint immediately with the responsible Danfoss representative if there are visible defects or the delivery is

incomplete.

4.4 Safety Measures during Installation
Always observe the safety instructions in this guide during installation.

l Ensure that installation is performed by qualified personnel.

l Carry out installation with due care and attention.

l Comply with all safety regulations and protective measures and observe the environmental conditions.

l Ensure that this guide is read and understood.
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4.5 Installation Environment

4.5.1 System Modules

The environmental conditions for the system modules are:

l The allowable operating ambient temperature range, humidity, and vibration levels must not be exceeded (see 11.6 General

Specifications and Environmental Conditions for MSD 520 System).

l The minimum space required above and below the system modules is detailed in 4.7.1 Space Requirements for System Modules.

4.6 Preparation for Installation

4.6.1 Preparation for Installation of System Modules

Make the following preparations to ensure that the servo system can be installed reliably and effectively.

Always fit the system modules in accordance with local regulations.

Procedure

1. Provide a suitable mounting arrangement for the application. This depends on the type and weight of the modules.

2. To avoid misalignment, ensure that the backplates are perfectly level.

3. To ensure sufficient cooling, pay attention to the specified minimum space requirements, see 4.7.1 Space Requirements for

System Modules.

4. Ground the modules.

4.6.2 Drilling Templates

Dimensions in Figure 21 are in mm [in].
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Figure 21: Drilling Templates for (FS1) 50 mm (2.0 in) and (FS2) 100 mm (3.9 in) System Modules

Pay attention to the precision of the drilling pattern if multiple modules are mounted next to each other. Even small deviations can

accumulate, leading to difficult assembly or misalignment.

4.7 Installation Procedure

4.7.1 Space Requirements for System Modules

The modules can be mounted next to each other but require a minimum space at the top and bottom, and sides for optimal cooling.

Ensure that there is enough open space around the product to allow proper air circulation.

All dimensions are in mm [in]
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Figure 22: Minimum Space Required at the Top and Bottom

NOTE: Observe minimum spacing based on cable diameter and direction of run.
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Figure 23: Minimum Space Required at the Sides

4.7.2 Installation Aids and Tools Required

For installation of the system modules, the tools corresponding to the fixings screws (not included) are required.

4.7.3 Fitting Instructions for System Modules

  NOTICE

l Mount the system module with the highest output power next to the PSM 520. Mount the remaining system components in

descending order of output power.

Procedure

1. Drill the holes for mounting the backplate according to the drilling template.

See 4.6.2 Drilling Templates for detailed dimensions and positioning.

2. Connect the backplates via the click-and-lock method.
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Figure 24: Connecting the Backplates

1 Backplate end cap

3. Mount the backplates to the mounting plate in the control cabinet using M5 screws with a minimum head diameter or washer

diameter of 9.5 mm (0.37 in).

Torque 3.0 Nm (26.6 in-lb)
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Figure 25: Mounting the Backplates in the Control Cabinet

4. Slide the module onto the carrier at the bottom of the backplate.

5. Press the 1st module onto the backlink connector at the top of the backplate.
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Figure 26: Pressing the Module onto the Backlink Connector

6. To secure the module, pull down the holding clamp at the top of the backplate.
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Figure 27: Pulling Down the Holding Clamp at the Top of the Backplate

1 Holding clamp

7. For the remaining modules repeat steps 4, 5, and 6.

Ensure that the lip at the left side of the 2nd module is inside the guiding groove at the right side of the 1st module.
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Figure 28: Guiding Groove

1 Guiding groove
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5 Electrical Installation

5.1 Warnings for Electrical Installation
During electrical installation, observe the relevant local and national regulations in addition to the information in this guide.

  WARNING

HIGH VOLTAGE

The system contains components that operate at high voltage when connected to the electrical supply

network. Not all components have indicators that indicate the presence of mains supply. Incorrect installation,

commissioning, or maintenance may lead to death or serious injury.

l Installation, commissioning, and maintenance may only be performed by qualified personnel.

  WARNING

HIGH VOLTAGE

Potentially lethal voltage is present on the connectors that may lead to death or serious injury.

l Before working on the power connectors (disconnecting or connecting the cable), disconnect the

PSM 520 from the mains and wait for the discharge time to elapse.

l Do not open under load. No isolating device is in place to interrupt load current.

  WARNING

TOUCH CURRENT HAZARD

The touch current is the electric current passing through a person when touching conductive accessible parts

of an electrical device. This is > 3.5 mA. Improper grounding of the system components may result in death or

serious injury.

l For reasons of personal safety, use a certified electrical installer to ground the system correctly in

accordance with the applicable local and national electrical standards and directives, and the instructions

in this guide.

l The minimum size of the PE conductor shall comply with the local safety regulations for high touch

current.

  NOTICE

PE conductor and grounding connection must comply with the requirements specified in chapter 5.4 Grounding.

If the PE conductor is damaged, disconnected, or leakage current exceeds 5% of rated input current, accessible parts may become

hazardous. Use a 16 mm2 PE conductor and properly ground the supplementary enclosure.

  NOTICE

l Use a motor with reinforced insulation between the thermistor and the motor windings (tested with 4300 V DC and

8000 Vpeak impulse).

l Use a motor with reinforced insulation between the brake and the motor windings (tested with 4300 V DC and 8000 Vpeak

impulse).
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  NOTICE

CABLE INSULATION REQUIREMENTS

Use cables with the following insulation:

l Minimum 0.4 mm for power cables.

l Minimum 0.2 mm for signal cables.

5.2 Electrical Environmental Conditions

  NOTICE

RCD COMPATIBILITY

The servo system contains components that can cause a DC current in the protective earthing conductor, which may result in

malfunction in any devices connected to the system.

l Where a residual current-operated protective device (RCD) is used for protection against electric shock, only an RCD of Type B

is allowed on the supply side of this product. All upstream RCD, up to the supply transformer, shall be of Type B.

l Recommended RCD sensitivity is 300 mA. For complex systems with more than 10 drives, it is recommended to consider RCD

with lower sensitivity (>300 mA, for example, 500 mA).

  NOTICE

l Mount all modules in a control cabinet.

5.3 DVC Classification

  NOTICE

l The DVC As and DVC C classification of the circuits is according to EN 61800-5-1.

l The DVC As circuit is not for use in salt water-wet locations.

Table 20: Connector Classification

Connector description Classification

11.5.2 Backlink Connector (DC+, DC-) DVC

11.5.2 Backlink Connector (FE) FE

11.5.2 Backlink Connector (24/48V, GND) DVC As

11.5.3.2 Brake Resistor Connector on PSM 520 DVC C

11.5.3.3 Brake, Motor Temperature Sensor and HIPERFACE® DSL or EnDat 3® Connector on SDM 521/SDM 522 DVC As

11.5.4.2 Ethernet Connectors on PSM 520 and DAM Option DVC As

11.5.4.3 Ethernet Connectors on SDM 521/SDM 522 DVC As

11.5.5.1 I/O Connector on PSM 520 DVC As

11.5.5.2 I/O Connector on SDM 521/SDM 522 DVC As

11.5.6.1 UAUX Connector on PSM 520 DVC As

11.5.7 LCP Connector DVC As

11.5.8.1 AC Mains Connector on PSM 520 DVC C

11.5.9.1 Overview of Motor Connector DVC C
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Table 20: Connector Classification - (continued)

Connector description Classification

11.5.10.2 Relay Connector on PSM 520 DVC C

11.5.11.1 STO Connectors on PSM 520 DVC As

11.5.11.2 STO Connector on the Bottom of PSM 520 with DAM Option DVC As

11.5.11.3 STO Connectors on SDM 521 and SDM 522 DVC As

11.5.12 UDC Connector DVC C

11.5.13 AUX Connector DVC As

11.5.14 Motor Feedback Connectors DVC As

11.5.15.1 Expansion Module Connector on EXM 520 (DC+, DC-) DVC C

11.5.15.1 Expansion Module Connector on EXM 520 (PE) FE

11.5.15.1 Expansion Module Connector on EXM 520 (24/48V, GND) DVC As

5.4 Grounding

5.4.1 Grounding for Electrical Safety
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Figure 29: Grounding for Electrical Safety

  NOTICE

l Spacing must consider cables diameter and direction of run.
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Do not ground the system modules in daisy-chain format. Use the grounding method shown in Figure 29.

l To comply with CE requirements, ensure a minimum ground wire cross-section of at least 16 mm2 (minimum 70 °C (158 °F), Cu). To

comply with UL requirements, ensure a minimum ground wire cross-section of 6 AWG (minimum 60 °C (140 °F), Cu).

¢ If a PSM 520 module with 10 kW is used, the cable cross-section can be reduced to 10 mm2 (minimum 70 °C (158 °F), Cu) to

comply with CE requirements, and 8 AWG (minimum 60 °C (140 °F), Cu) to comply with UL requirements.

l Keep the ground wire connections as short as possible.

l Follow the wiring requirements in this operating guide.

  NOTICE

l If 2 separate backlinks are used (connected via 1 or 2 pairs of EXM 520 modules), the 2 grounding bars must also be

connected together with a 16 mm2 (6 AWG) cable cross-section.

l If a feed-in cable is used:

¢ Connect the yellow/green PE wire of the feed in cable as shown in 5.9.3.2 Connecting the Cables on the Bottom of the Power

Supply Module PSM 520.

5.4.2 Grounding for EMC-Compliant Installation

l Establish an electrical connection between the cable shield and the enclosure using the I/O shielding plate on each module.
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Figure 30: Cable Shielding on the Top of the System Modules

1 Cable 2 Cable relief and shielding

3 Spring-loaded shield clamp
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Figure 31: Cable Shielding on the Bottom of the System Modules

1 Connector 2 Cable clamp

3 Cable relief and shielding

l Use a cable with a shielding that has high coverage to reduce electrical interference.

l Do not use pigtails to connect the shielding. A 360° wire connection is recommended.

  NOTICE

l If 2 separate backlinks are used (connected via 1 or 2 pairs of EXM 520 modules), the 2 grounding bars must be also

connected together with a 16 mm2 (6 AWG) cable cross-section.

l For cable cross-sections, see 11.5.15.2 Cable Cross-sections for EXM 520.

  NOTICE

POTENTIAL EQUALIZATION

l There is a risk of electrical interference when the ground potential between the servo system and the machine is different.

Install equalizing cables between them. The recommended cable cross-section is 16 mm2 (6 AWG).

  NOTICE

EMC INTERFERENCE

l Use shielded cables for control wiring and separate cables for power and control wiring. Failure to isolate power and control

wiring can result in unintended behavior or reduced performance.

l Ensure a minimum clearance of 200 mm (7.87 in) between signal and power cables.

l Only cross cables at 90°.

5.5 Mains Supply

5.5.1 Mains Supply Requirements

Ensure that the supply has the following properties:

l TN-S, TN-C, TN-CS, TT (not corner-grounded) supply grounding system

l Minimum required prospective short circuit current (Icp, mr): 5 kA
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l Conditional short circuit current (Icc): 5 kA

l Protective class I

l Grounded 3-phase mains network, 208–480 V AC ±10%

l 3-phase lines and PE line

l 3-phase frequency: 44–66 Hz

l Maximum input current for 1 PSM 520 at 30 kW: 55 A_AVG

l AC choke (see 5.9.1 AC Line Choke)

5.5.2 Fuses

  NOTICE

l Use fuses on the supply side of the Power Supply Module (PSM 520) that comply with CE and UL requirements (see Table 21).

l When 2 PSM 520 modules are used, each module must have its own dedicated set of fuses.

Table 21: Fuses

Model and power rating CE compliance (IEC 60364)
maximum fuse type

UL compliance (NEC 2014)
maximum fuse type

PSM 520 (10 kW) gG 25 A 30 A (class T or J only)

PSM 520 (20 kW) gG 50 A 50 A (class T or J only)

PSM 520 (30 kW) gG 63 A 80 A (class T or J only)

5.5.3 Circuit Breakers

Use a type B or type C circuit breaker with a capacity of 1.5 times the rated current of PSM 520 to fulfill CE requirements.

  NOTICE

l Circuit breakers are not allowed in installations where C-UL is required. Only UL-recommended fuses are allowed.

5.6 Auxiliary Supply

5.6.1 Auxiliary Supply Requirements

Supply the Power Supply Module (PSM 520) with a power supply unit with an output of 24/48 V DC ±10%. The output ripple of the

power supply unit must be <250 mVpp.

  NOTICE

l Only use supply units that conform to the PELV specification.

l Use a supply that is CE-marked according to the standards EN 61000-6-2 and EN 61000-6-4 or similar for industrial use.

l Ensure that the secondary circuit is supplied from an external isolated source.

The auxiliary power supply unit must be dedicated to the system components, meaning that the supply is used exclusively for powering

the PSM 520. The maximum allowed cable length between the supply unit and the PSM 520 is 3 m (9.8 ft).

  NOTICE

l For cable lengths <10 m (32.8 ft), use 24 V auxiliary voltage. For cable lengths ≥10 m (32.8 ft), use 48 V auxiliary voltage.

l If a mechanical brake is connected, always supply the servo system with 48 V auxiliary voltage.

VLT® Multiaxis Servo Drive MSD 520 > Operating Guide > Electrical Installation



5.6.2 Fuses

UL listed fuses are recommended to protect the wiring on 24/48 V DC.

Table 22: Fuses

CE compliance (IEC 60364)
maximum fuse type

UL compliance (NEC 2014)
maximum fuse type

50 A(1) 63 A(2)

1) If the maximum current is lower, a fuse with a lower current rating can be used. Rating of IEC fuses: according to 100% of maximum current. Use a time delay fuse rated according to

the DC voltage used.

2) If the maximum current is lower, a fuse with a lower current rating can be used. Rating of UL fuses: according to 125% of maximum current. Use a time delay fuse rated according to

the DC voltage used.

5.7 Safety Supply Requirements
Supply the STO line with a 24 V DC supply with the following properties:

l Output range: 24 V DC ±10%

l Maximum current: 1 A

The maximum current is the maximum allowed current throughout the system. The typical current depends on the system topology and

dimensioning.

Use a 24 V supply unit that is CE-marked for industrial use. Ensure that the supply fulfills the PELV specification and is only used for the

system safety input.

  WARNING

RISK OF SAFETY FUNCTION IMPAIRMENT

A common supply for auxiliary and safety supply can be used, but multiple connection points between the 2 circuits may short-

circuit emergency stop switches, impair the safety function, and result in death or serious injury.

l If a common supply for auxiliary and safety supply is used, ensure that there is only 1 connection point between the 2 circuits

to avoid any safety risk.

The maximum cable length between the 24 V supply unit and the servo system is 3 m (9.8 ft).

The safety supply can be looped from PSM 520 to the other system components. The cable for this is not provided.

  NOTICE

l Ensure that there is reinforced isolation between safety signals and other signals, supplies (mains supply), and exposed

conductive parts.

5.8 UL Requirements

  NOTICE

l Integral solid-state short-circuit protection does not provide branch circuit protection. Branch circuit protection must

be provided in accordance with the National Electrical Code/Canadian Electrical Code, and any additional local codes or

equivalent.

l Suitable for use on a circuit capable of delivering not more than 5000 rms symmetrical amperes, 480 V maximum when

protected by maximum 80 A class J or T fuses.

l To meet the UL (Underwriters Laboratories) regulations, use a UL-approved copper cable with a minimum heat resistance of

60 °C (140 °F). Use Class 1 wire only. For PSM 520 rated 30 kW and EXM 520, use a minimum heat resistance of 75 °C (167 °F).

l Control circuit overcurrent protection is required.

60  < AQ448939736224en-010101 < 130R1343                                                                                                                                                                    Danfoss A/S © 2026.05

VLT® Multiaxis Servo Drive MSD 520 > Operating Guide > Electrical Installation



Danfoss A/S © 2026.05                                                                                                                                                                    AQ448939736224en-010101 > 130R1343 >  61

5.9 Connecting the Power Supply Module PSM 520

5.9.1 AC Line Choke

The AC line choke is optional for power sizes of 10 kW and 20 kW. This depends on the electrical grid stiffness, which is expressed as

Prospective Short-Circuit Current (PSCC), as indicated in Table 23. For the 30 kW model, the use of an AC line choke is mandatory,

regardless of the electrical grid characteristics.

Table 23: AC Line Choke Requirements for PSM520 Modules Based on PSCC

PSM modules PSCC < 5 kA PSCC > 5 kA PSCC > 10 kA

30kW/60A AC Choke mandatory AC Choke mandatory AC Choke mandatory

20kW/40A AC Choke optional AC Choke mandatory AC Choke mandatory

10kW/20A AC Choke optional AC Choke optional AC Choke mandatory

Table 23 outlines the limits and requirements for the PSM 520. It does not consider any regional or national normative requirements

related to the reduction of Total Harmonic Distortion (THD). Danfoss recommends the optional AC choke as it significantly reduces THD,

minimizes peak inrush currents, lowers system losses, and extends product lifetime.

For more information regarding 3-phase AC line choke, see:

l 5.9.2.1 Connecting 1 PSM 520 Module to the AC Choke

l 5.9.2.2 Connecting 2 PSM 520 Modules to the AC Choke

Table 24: Line Choke Characteristics for 1 PSM 520

Model Minimum Irms [A] Urms [V] Inductance [mH]

PSM 520 (10 kW) 20 500 Minimum: 0.47

Maximum: 1.47

PSM 520 (20 kW) 40 500 Minimum: 0.47

Maximum: 1.47

PSM 520 (30 kW) 60 500 0.47 ±10%

If 2 PSM 520 modules are installed in parallel, use an AC choke as specified in Table 25. See 5.9.2.2 Connecting 2 PSM 520 Modules to the

AC Choke for further information.

Table 25: Line Choke Characteristics for 2 PSM 520 Installed in Parallel

Model Minimum Irms [A] Urms [V] Inductance [mH]

PSM 520 (2 x 30 kW) 125 500 0.24 ±10%

Danfoss recommends mounting the AC line choke close to the PSM 520.

The maximum cable length depends on the cross-section, and the required voltage and current at the DC link.

If the AC line chokes are mounted away from the PSM 520, the maximum cable distance is 5 m (16.4 ft).

5.9.2 Connecting the Power Supply Module PSM 520 to the AC Choke

5.9.2.1 Connecting 1 PSM 520 Module to the AC Choke

Connect the PSM 520 to the electric grid with the correct AC choke for the power size of the PSM 520.
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Figure 32: Connecting 1 PSM 520 to the AC Choke

5.9.2.2 Connecting 2 PSM 520 Modules to the AC Choke

Connect the PSM 520 modules to the same AC choke as shown in Figure 33.

Ensure that the choke used is the correct size based on the combined power of the PSM 520 modules.

When 2 PSM 520 modules are used, the wiring between the AC line choke and each PSM 520 must be the same length, within a

tolerance of 0.5 m (1.6 ft).

Connect each PSM 520 to the AC choke directly. Parallel wiring is not allowed.
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Figure 33: Connecting 2 PSM 520 Modules to the AC Choke

5.9.2.3 Connecting 2 PSM 520 Modules to the AC Choke with System Splitting

Connect the PSM 520 modules to the same AC choke regardless of the load position (for example, before or after the system splitting) as

shown in Figure 34.

Ensure the choke used is the correct size based on the combined power of the PSM 520 modules.

When 2 PSM 520 modules are used, the wiring between the AC line choke and each PSM 520 must be the same length, within a

tolerance of 0.5 m (1.6 ft).

Connect each PSM 520 to the AC choke directly. Parallel wiring is not allowed.
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Figure 34: Connecting 2 PSM 520 Modules to the AC Choke with System Splitting

l If 2 AC chokes are used (1 per PSM 520), and both PSM 520 modules are mounted at the same side of the system splitting:

¢ The setup is allowed with derating equal to the AC chokes tolerance referred to 60 kW. For example, 10% derating is 54 kW.

l If 2 AC chokes are used (1 per PSM 520) where 1 PSM 520 module is mounted before the splitting and 1 after the splitting:

¢ Balance the loads equally otherwise, the derating of both PSM 520 modules is equal to the AC chokes tolerance. For example,

tolerance 10% + 10% means is 20% derating.

l If 2 AC chokes are used (1 per PSM 520), and 1 PSM 520 module is mounted before the splitting and 1 after the splitting. Half of the

loads are set before the system splitting and half are set after the system splitting:

¢ The setup is allowed with derating equal to the tolerance of the AC choke referred to 60 kW. For example, 10% derating is 54 kW.

  NOTICE

l See 11.5.15.1 Expansion Module Connector on EXM 520 for further information of the EXM 520 module and wiring.

5.9.3 Connecting the Cables on the Power Supply Module PSM 520

5.9.3.1 Connecting the Cables on the Top of the Power Supply Module PSM 520
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Figure 35: Connectors on the Top of PSM 520

1 Relay connector 2 Ethernet connector IN

3 Ethernet connector OUT 4 Digital input

5 STO connector OUT 6 STO connector IN

7 24/48 V IN connector

Procedure

1. Plug the 24/48 V input connector (INPUT 24/48 V) [7].

2. Plug the STO connector IN (STO PSM) [6].

3. Plug the STO connector OUT (STO PSM) [5].

4. Plug the DIG IN connector (DIG IN PSM) [4].

Only if digital input is required.

5. Plug the relay connector (REL PSM) [1].

Only if a relay is required.

6. Connect the Ethernet cable from the Ethernet output connector (X2 OUT) [3] of the previous module to the Ethernet input

connector (X1 IN) [2].

5.9.3.2 Connecting the Cables on the Bottom of the Power Supply Module PSM 520

Figure 36 is an overview of the PSM 520 connectors that each supports distinct operational functions.
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Figure 36: Connectors on the Bottom of PSM 520
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1 AC mains supply connector 2 External brake resistor connector

3 UDC connector 4 STO connector

5 AUX connector 6 Ethernet connector

Dimensions in Figure 37 and Figure 38 are in mm [in].
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Figure 37: DAM Option Feed-in Cable

1 Shielded area 2 Black/UDC+ (Ferrules with plastic sleeve 2.5 mm2)

3 Grey/UDC- (Ferrules with plastic sleeve 2.5 mm2) 4 Red/AUX+ (Ferrules with plastic sleeve 2.5 mm2)

5 Blue/AUX- (Ferrules with plastic sleeve 2.5 mm2) 6 Wire pink/STO+ (Ferrules with plastic sleeve 0.5 mm2)

7 Wire grey/STO- (Ferrules with plastic sleeve 0.5 mm2) 8 Green

9 Yellow/green PE 10 Bus connector RJ45

11 Ring terminal M5
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Figure 38: PSM AC Main Cable
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1 Yellow/green PE 2 Phase

  NOTICE

l Cable length based on the distance of the PE bar.

Procedure

The following procedure refers to Figure 39 and Figure 40.

1. Connect the PSM 520 to PE, connecting the PSM AC PE cable to the PE screw (T25) [4].

Torque 3.0 Nm (26.6 in-lb).

2. Insert the phase wires into the AC main supply connector and the brake wires (if available) into the brake resistor connector.

3. Insert the wires into the UDC, STO, and AUX connectors.

Only with DAM option.

4. Secure the AC mains cable [5] with the right cable clamp [6].

5. Secure and shield the DAM option feed-in cable [7] with the left cable clamp [6].

Ensure that the shielded area on the cable is positioned exactly under the cable clamp.

6. Fasten the EMC plate [1] on the PSM 520 module with 2 screws [1A].

Torque 3.0 Nm (26.6 in-lb)

7. Plug the brake resistor and AC main supply connector.

Start from back.

8. Plug the UDC, STO, and AUX connectors.

Start from back.

9. Plug the RJ45 bus connector.

10. Shield the STO cable by activating the spring loaded slider [8].

Ensure that the shielded area is positioned exactly under the spring-loaded slider.
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Figure 39: Assembly of EMC Plate and Cable Clamps on the PSM 520 Module

1 EMC plate 1A Screws for EMC plate

2 Cable clamp 20–24 mm 3 Cable clamp 12–16 mm
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Figure 40: PSM/DAM Cable Connection

4 Screw for PE cable (T20) 5 PSM AC main cable

6 Cable clamp 7 DAM option feed-in cable

8 EMC shield bracket with compression spring

5.9.4 Connecting the Brake Resistor on the Power Supply Module PSM 520

5.9.4.1 Connection of External Brake Resistor on 1 PSM 520 Module

The PSM 520 module can be connected to an external brake resistor. In this case, the proper selection must be applied in the drive

configuration, to inhibit the use of the internal brake resistor on the PSM 520 module.

Paralleling or series of brake resistors is not allowed.

5.9.4.2 Connection of Brake Resistor on 2 PSM 520 Modules in Parallel

When using 2 PSM 520 modules, each PSM 520 module is connected to its own internal brake resistor (factory setting).
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Alternative allowed configurations for 2 PSM 520 modules:

l 1 PSM 520 module is connected to the internal brake resistor and the other PSM 520 module is connected to an external brake

resistor.

l Both PSM 520 modules are connected to an external brake resistor. In this case, the internal brake resistor on each PSM 520 module

must be deactivated in the drive configuration.

Paralleling or series of brake resistors is not allowed.

5.10 Connecting the Servo Drive Module SDM 521/SDM 522

5.10.1 Connecting the Cables on the Top of the Servo Drive Modules SDM 521/SDM 522
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Figure 41: Connectors on the Top of SDM 521/SDM 522 (Example)

1 I/O connector 2 Ethernet connector IN

3 Ethernet connector OUT 4 STO connector OUT

5 STO connector IN 6 Safe I/O connector

The following procedure refers to Figure 41.

Procedure

1. Connect the STO output [4] of the previous module into the STO input (STO IN) connector [5].

2. Plug the I/O connectors [1].

Only if I/Os are required.

3. Plug the safe I/O connector [6].

Only if safe I/Os are required.

4. Connect the Ethernet cable from the Ethernet output connector (X2 OUT) [3] of the previous module to the Ethernet input

connector (X1 IN) [2].

5.10.2 Connecting the Cables on the Bottom of the Servo Drive Modules SDM 521/SDM 522

Figure 42 is an overview of the SDM 521/SDM 522 connectors that each supports distinct operational functions.
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Figure 42: Connectors in the Bottom of SDM 521

1 Motor feedback connector 2 Motor brake and thermistor connector

3 Motor connector

Dimensions in Figure 43 are in mm [in].

Dimensions A-B-C, see Table 26.
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Figure 43: Motor Cable for 50/100 mm (2.0/3.9 in) Wide Servo Drive Modules

1 Shield area 2 PE (Ring terminal M5)

3 Brake + 4 Brake -

5 Temp + 6 Temp -

7 U 8 V

9 W
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Table 26: Cable Length A-B-C 

SDM module A (Phase cable) [mm (in)] B (Temperature/brake cable)
[mm (in)]

C (PE cable) [mm (in)]

SDM 521 (FS2) 150 (5.91) 190 (7.48) 80 (3.15)

SDM 521 (FS1) 150 (5.91) 190 (7.48) 70 (2.76)

Axis 1 180 (7.09) 200 (7.87) 50 (1.97)SDM 522 (FS1)

Axis 2 130 (5.12) 160 (6.30) 50 (1.97)
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Figure 44: Connecting the Motor Cable on 50 mm (2.0 in) Wide Servo Drive Modules

1 Motor connector 2 Brake/thermistor connector

3 Cable clamp 4 Screw (T20) for PE cable

5 Shield with spring-loaded slider 6 Screw (T20) for EMC plate

7 Motor cable 8 EMC plate
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Figure 45: Connecting the Motor Cable on 100 mm (3.9 in) Wide Servo Drive Modules

1 Motor connector 2 Brake/thermistor connector

3 Cable clamp 4 Screw (T20) for PE cable

5 Shield with spring-loaded slider 6 Screw (T20) for EMC plate

7 Motor cable 8 EMC plate

The following procedure refers to Figure 44 and Figure 45.

Procedure

1. Connect the SDM 521/SDM 522 to PE using the PE screw (T25).

Torque 3.0 Nm (26.6 in-lb)

2. Insert the wire into the motor connector [1]

3. Insert the wire into the brake/thermistor connector [2].

4. Secure and shield the motor cable [7] with the cable clamp [3].

5. Fasten the motor PE cable with screw (T20) [4].

Torque 3.0 Nm (26.6 in-lb)

6. Shield the brake/ thermistor cable by activating the spring loaded slider [5].

Ensure that the shielded area is positioned exactly under the spring-loaded slider.

7. Fasten the EMC plate [8] with 2 screws (T20) [6]

Torque 3.0 Nm (26.6 in-lb)

8. Plug the motor and brake/thermistor connectors.
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5.11 Connecting the Expansion Module EXM 520

Dimensions in Figure 46 are in mm [in].
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Figure 46: Expansion Module Cable

1 24/48 V 2 GND

3 Functional ground 4 DC–

5 DC– 6 DC+

7 DC+ 8 Shielded area

e3
0b

h3
92

.1
1

1

23

4

5

6

7

Figure 47: Connecting the Expansion Module EXM 520

1 EMC shielding plate screw 2 PE screw

3 DC cables 4 Functional ground cable

5 GND cable 6 24/48 V cable

7 Cable ties

1. Insert wires [3], [4], [5], and [6] into the expansion connector.

2. Secure the DC cables [3] using the cable ties [7], ensuring that the shielded area is positioned exactly under the cable tie.

3. Secure the cables [4], [5], and [6] using the cable ties [7].

4. Plug the connectors into the backplate.

5. Tighten the screw on the EMC shielding plate [1].
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Torque 3 Nm.

6. Connect the EXM 520 to PE using the PE screw [2] and a PE wire.

Torque 3 Nm.
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6 Commissioning

6.1 Warnings for Commissioning

  WARNING

UNINTENDED START

The servo system is connected to the electrical supply network and can start running at any time. This may be caused by a

fieldbus command, a reference signal, or clearing a fault condition. Servo drives and all connected devices must be in good

operating condition. A deficient operating condition may lead to death, serious injury, damage to equipment, or other material

damage when the unit is connected to the electrical supply network.

l Take suitable measures to prevent unintended starts.

6.2 Pre-Commissioning Checklist

Always complete these checks before initial commissioning and before commencing operation after extended downtime or storage.

Procedure

1. Check that all the threaded connectors of mechanical and electrical components are firmly tightened.

2. Check that the free circulation of cooling air (inlet and outlet) is assured.

3. Check that the electrical connections are correct.

4. Ensure that contact protection is in place for rotating parts and surfaces that can become hot.

5. If using the STO functionality, conduct the functional safety concept commissioning test (see 8.9 Commissioning Test).

6.3 SDM 521/SDM 522 Configuration Parameter and Drive Commissioning

6.3.1 Configuration Parameter Subtool

The Configuration Parameter subtool is the VLT ® Servo Toolbox subtool for configuring:

l Motor data

l Application data

l Control data

l Input/output configurations

l External encoder
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Figure 48: Configuration Parameter Subtool

1 Save/Save as 2 Save to motor database

3 Open motor database 4 Read configuration from device

5 Write configuration to the device 6 Calculate PID values

7 Set default values 8 Permanently store device configuration

9 Reset device configuration 10 Write the parameter group to the device

The configuration parameters are part of the object dictionary of the device. At power-up they assume default values, unless the

parameters are permanently stored.

  NOTICE

l Refer to the subtool for a detailed description of each parameter.

The following procedure refer to Figure 48.

1. Select Read configuration from device button [4] to read the current values of the configurable parameters from the device.

2. Select the Save/Save as  button [1] to save the file locally.

3. Select Write configuration to device button [5] to write the modified parameter values to the device. The new values are lost if

the values not are permanently stored with the Permanently store device configuration button [8].

4. Select the Save to motor database button [2] to save the current motor configuration as customized "user defined" motor in the

local catalog of motors.

5. Select the Open motor database button [3] to open and browse the local catalog of motors. Find and select the specific motor

and import the corresponding parameters.

6. Select the PID values button [6] to compute the values of control gains for the given value of inertia.

7. Select the Set default values button [7] to reset the user interface values to the default values.

8. Select the Permanently store device configuration button [8] to save the storable parameter at device side. When completed the

device must keep the parameter values after a power cycle.

9. Select the Reset device configuration button [9] to reset the parameters at device side to the factory setting.

10. Select the Write the parameter group to device button [10] to write the modified parameter values of the shown group to the

device.
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6.3.2 Drive Commissioning Subtool

The Drive Commissioning subtool is the VLT® Servo Toolbox subtool for carrying out commissioning tasks, such as:

l Automatic motor adaption

l Motor feedback adjustment

l Resolver amplitude calibration

l Inertia measurement

l Control loop tuning

Figure 49 and Figure 50 is an example from the Drive Commissioning subtool.
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Figure 49: Motor Feedback Adjustment (Example)
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Figure 50: Inertia Measurement (Example)

6.4 EtherCAT® ID Assignment
EtherCAT® needs no special ID assignment (IP address). Special ID assignment is only required when using indirect communication via

the VLT® Servo Toolbox software.

6.5 Ethernet POWERLINK® ID Assignment

6.5.1 Overview

Ethernet POWERLINK® master communication must not be active when using the VLT® Servo Toolbox to assign IDs to the devices.

ID assignment via the VLT® Servo Toolbox is only possible when acyclic Ethernet POWERLINK® communication is used. If Ethernet

POWERLINK® cyclic communication is already started, perform a power cycle to stop it.

Detach the PLC and carry out a power cycle before setting IDs. Alternatively, in the POWERLINK® interface, restart the PLC in service mode

while parameter Basic Ethernet in service mode is set to Basic Ethernet enabled.

6.5.2 Single Device ID Assignment

When assigning an ID to a single device, use the Device Information window in the VLT®Servo Toolbox (see the VLT® Servo Drive System

ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Programming Guide for further information).

Setting an ID to a device can also be done via the LCP.

6.5.3 Setting Node ID for Single Device

6.5.3.1 Setting the Node ID Directly on a Servo Drive or on the System Modules

All IP-related parameters are in parameter group 12-0* IP Settings. According to the Ethernet POWERLINK® standard, the IP address is

fixed to 192.168.100.xxx. The last number is the value in parameter 12-60 Node ID. For parameter 12-02 Subnet Mask, the IP address is

fixed to 255.255.255.0 and cannot be changed.
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Procedure

1. Attach the LCP to the servo drive or system module for which the node ID should be changed.

2. Press [Hand On] for >1 s to make the LCP the controlling interface.

3. Press [Main Menu], scroll down to parameter group 12-** Ethernet, and press [OK].

4. Scroll down to parameter group 12-6* Ethernet POWERLINK and press [OK].

5. Change the PSM 520 node ID to the desired value (1–239).

6. Press [OK] to confirm the selection and wait for the ID assignment procedure to complete.

7. Carry out a power cycle to ensure that all ID changes are in effect and operational on the fieldbus.

6.5.3.2 Setting the Node ID for a Single Servo Drive via the Power Supply Module (PSM) using the LCP

It is also possible to change the node ID of a servo drive when the LCP is connected to the PSM 520. This functionality is contained in

parameter group 54-1* Manual.

Procedure

1. Attach the LCP to the PSM 520 that is connected to the servo drives and system modules for which the node ID should be

changed.

2. Press [Hand On] for >1 s to make the LCP the controlling interface for the PSM 520.

3. Press Main Menu, scroll down to parameter group 12-** Ethernet, and press [OK].

4. Scroll down to parameter group 12-6* Ethernet POWERLINK and press [OK].

5. Change the PSM 520 node ID to the desired value (1–239) by pressing [OK].

6. Return to the [Main Menu] and select parameter group 54-** ID Assignment.

7. Select parameter group 54-1* Manual.

8. PSM 520 only: In parameter 54-01 Epl id assignment line, select either Ethernet port X1 or X2. The PSM 520 assigns IDs to the

selected device via the selected port and the fieldbus network.

9. Select parameter 54-12 Epl ID assignment start id, and select a valid value (1–239). The value is assigned to the device at the

specified position index. The PSM 520 connected to the LCP is at position 0 and the 1st reachable device on the selected port is

position index 1, and so forth.

10. Select parameter 54-14 Manual Epl ID assignment start and change the status from [0] ready to [1] start.

11. Press [OK] to confirm the selection then wait for the ID assignment procedure to complete.

12. Check that the ID assignment was completed successfully using parameters:

a. Parameter 54-15 Epl ID assignment state

b. Parameter 54-16 Epl ID assignment error code

c. Parameter 54-17 Epl ID assignment device count

13. Carry out a power cycle to ensure that all ID changes are in effect and operational on the fieldbus.

Ü If an error occurs during ID assignment, the detected error is shown on the LCP. The following errors may be reported:

l Invalid NMT state

l Invalid comment

l Invalid Ethernet port

l Invalid node ID

l ID assignment failed

l Duplicate MAC address
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l Invalid SW version

l Incomplete assignment

l No device found

l Internal error

6.5.4 Multiple Device ID Assignment

When assigning IDs to several devices (for example, when setting up a new network), use the VLT® Servo Toolbox subtool DAM ID

assignment. For further information, see the programming guide VLT® Servo Drive System ISD 520, DSD 520, MSD 520 FlexMotion™.

6.5.5 Setting Node ID for Multiple Devices

6.5.5.1 Setting the Node IDs of all Servo Drives and System Modules on a Power Supply Module (PSM 520) Line

The automatic PSM 520 ID assignment is used for automatically setting the node IDs on all servo drives and system modules for a

specified PSM 520 line (with or without DAM option). This functionality is contained in parameter group 54-0* Automatic.

Procedure

1. Attach the LCP to the PSM 520 that is connected to the servo drives and system modules for which the node ID should be

changed.

2. Press [Hand On] for >1 s to make the LCP the controlling interface for the PSM 520.

3. Press Main Menu, scroll down to parameter group 12-** Ethernet, and press [OK].

4. Scroll down to parameter group 12-6* Ethernet POWERLINK and press [OK].

5. Change the PSM 520 node ID to the desired value (1–239) by pressing [OK].

6. Return to the [Main Menu] and select parameter group 54-** ID Assignment.

7. Select parameter group 54-0* Automatic.

8. PSM 520 only: In parameter 54-01 Epl id assignment line, select either Ethernet port X1 or X2. The PSM 520 assigns IDs to the

selected device via the selected port and the fieldbus network.

9. Select parameter 54-02 Epl ID assignment start id then select a valid value (1–239). The value is assigned to the device at the

specified position index. The PSM 520 connected to the LCP is at position 0 and the 1st reachable device on the selected port is

position index 1 and so on.

10. Select parameter 54-03 Automatic Epl ID assignment start and change the status from [0] ready to [1] start.

11. Press [OK] to confirm the selection then wait for the ID assignment procedure to complete.

12. Check that the ID assignment was completed successfully using parameters:

a. Parameter 54-04 Epl ID assignment state

b. Parameter 54-05 Epl ID assignment error code

c. Parameter 54-06 Epl ID assignment device count

13. Carry out a power cycle to ensure that all ID changes are in effect and operational on the fieldbus.

Ü If an error occurs during ID assignment, the detected error is shown on the LCP. The following errors may be reported:

l Invalid NMT state

l Invalid comment

l Invalid Ethernet port

l Invalid node ID

l ID assignment failed
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l Duplicate MAC address

l Invalid SW version

l Incomplete assignment

l No device found

l Internal error

6.6 PROFINET® ID Assignment
Each PROFINET® device needs a device name and an IP address. The IP address and the device name are assigned by the I/O controller,

when the connection to the I/O device is established.

The IP address assignment is also required when using indirect communication via the VLT® Servo Toolbox software. For further

information, see the programming guide VLT® Servo Drive System ISD 520, DSD 520, MSD 520 FlexMotion™.

The IP address and the device name can also be assigned using PRONETA®, a free tool that supports in the analysis and configuration of

PROFINET® networks.

6.7 Power-up Time
The maximum power-up time for the system components is 15 s. This means the time from supplying the system with auxiliary voltage

to the module being initialized completely.

The power-up time stated is an indicative time. The exact status of the module can be seen via the status word.

  NOTICE

l Do not operate any of the system modules until they are all powered up correctly.

l If 2 PSM 520 modules are mounted in parallel, power up both PSM 520 modules simultaneously (within a maximum delay of

1 s).

6.8 System Module Charging Time
The charging time of the system is determined by the longest charging time of each individual system module.

The exact status of each module can be seen via the status word.

  NOTICE

l Do not operate any of the system modules until they are charged up completely and are in state Operation enabled.

Table 27: DC link (UDC) Charging Time for PSM 520

Specification Unit PSM 520

UDC charging time s 2.0

Table 28: DC Link (UDC) Charging Time for SDM 521

Specification Unit SDM 521
2.5 A

SDM 521
5 A

SDM 521
10 A

SDM 521
20 A

UDC charging time s 2.0
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Table 29: DC Link (UDC) Charging Time for SDM 522

Specification Unit SDM 522
2 x 2.5 A

SDM 522
2 x 5 A

SDM 522
2 x 10 A

SDM 522
2 x 20 A

UDC charging time s 2.0

6.9 System Power-up Requirements

6.9.1 Switching on the MSD 520 System

Complete the cabling of the MSD 520 system before applying power to the Servo Drive Modules (SDM 521/SDM 522). This cabling

provides the supply voltage and the communication signals for the system. This is a basic requirement for the operation of the servo

drives.

The MSD 520 system is switched on by supplying the Power Supply Module (PSM 520) with UAUX. This supply is then automatically

passed on to all connected system modules and only the control units of the connected modules are running. The system is ready for

operation when mains and STO are supplied.

6.9.2 Procedure for Switching on the MSD 520 System

Procedure

1. Switch on UAUX power to enable communication to the PSM 520, and SDM modules to be established.

2. Switch on the mains.

3. Set the PSM 520 to state Operation enabled.

The system modules are now ready for operation.

6.10 Libraries
The libraries provided for the MSD 520 system can be used in:

l TwinCAT® V2 and V3

l SIMOTION SCOUT® V5.2:

¢ C240 from V4.4

¢ D410-2 from V4.4

¢ D425-2 from V4.4

¢ D435-2 from V4.4

¢ D445-2 from V4.4

¢ D455-2 from V4.4

¢ P320 from V4.4

l Automation Studio™ environment (version 3.0.90 and 4.x, supported platform SG4) to easily integrate the functionality without the

need for special motion run-time on the controller.

l Totally Integrated Automation® (TIA Portal® from V15)

The provided function blocks conform to the PLCopen® standard. Knowledge of the underlying fieldbus communication and/or the

CANopen® CiA DS 402 profile is not necessary.

The library contains:

l Function blocks for controlling and monitoring the system components.

l Function blocks for all available motion commands of the servo drives.

l Function blocks for controlling and monitoring the power supply module PSM 520.
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l Function blocks and structures for creating Basic CAM profiles.

l Function blocks and structures for creating Labeling CAM profiles.

6.11 Programming with Automation Studio™

6.11.1 Requirements for Programming with Automation Studio™

The following files are required to integrate the system components into an Automation Studio™ project:

l Package of libraries for the system components: Danfoss_VLT_ServoMotion_V_x_y_z.zip

l XDD file (XML Device Description) for the ISD 520 servo drive: 0x0200008D_VLT_ISD_520_XXX_CTXX.xdd

l XDD file (XML Device Description) for the ISD 520 servo drive with Standard IO Option board:

0x0200008D_VLT_ISD_520_XXX_CTIO.xdd

l XDD file (XML Device Description) for the DSD 520 servo drive: 0x0200008D_VLT_DSD_520_XXX_CTXX.xdd

l XDD file (XML Device Description) for the DSD 520 servo drive with Standard IO Option board:

0x0200008D_VLT_ISD_520_XXX_CTIO.xdd

l XDD file (XML Device Description) for the SDM 521/SDM 522 servo drive module: 0x0200008D_VLT_SDM_520_XXX_CTXX.xdd

l XDD file (XML Device Description) for the Power Supply Module (PSM 520): 0x0200008D_VLT_PSM_520_AKXX.xdd

l XDD file (XML Device Description) for the Power Supply Module (PSM 520) with DAM option board:

0x0200008D_VLT_PSM_520_AKDX.xdd

6.11.2 Creating an Automation Studio™ Project

The procedures described in this chapter apply to Automation Studio™ Version V4.x unless otherwise specified.

Information on how to install Automation Studio™can be found in detail in the Automation Studio™ help. Open the B&R Help Explorer

and go to [Automation software → Software Installation → Automation Studio].

Information on how to create a project in Automation Studio™ can be found in detail in the Automation Studio™ help.

Creating a project:

Open the B&R Help Explorer and go to [Automation Software → Getting Started → Creating programs with Automation Studio → Example

project for a target system with CompactFlash].

6.11.3 Including the Servo Motion Libraries into an Automation Studio™ Project

1. In the Logical View, open the menu entry [File] and [Import...].

2. In the next window, select the Danfoss_VLT_ServoMotion_V_x_y_z.zip file (according to the location on the hard drive).

3. Click Open.

4. Assign the libraries to the CPU in the next window.

5. Click Finish. Now the libraries are integrated into the Automation Studio™ project.

Ü 
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Table 30: Servo Motion Libraries

Library Description

DDS_Drive l Contains program organization units (POUs) defined by PLCopen® (name
starting with MC_) and POUs defined by Danfoss (name starting with DD_). The
Danfoss POUs provide additional functionality for the axis.

l It is possible to combine POUs defined by PLCopen® with POUs defined by
Danfoss.

l The names of the POUs that target the servo drive all end with _DDS.

l When integrating the DDS_Drive package, some standard libraries are
integrated automatically, unless they are already part of the project.

DDS_PSM l Contains POUs defined by Danfoss (name starting with DD_) and provides the
functionality for the Power Supply Module (PSM 520).

l The names of the POUs that target the PSM 520 all end with _PSM.

DDS_BasCam l Contains POUs for the creation of basic CAMs.

DDS_LabCam l Contains POUs for the creation of labeling CAMs.

DDS_Intern l Contains POUs that are needed internally for the libraries.

l Do not use these POUs in an application.

  NOTICE

l Do not remove these libraries, otherwise the Danfoss servo motion libraries will malfunction.

6.11.4 Constants within the DDS_Drive Library

The constants are defined inside the DDS_Drive library (see Table 31).

Table 31: List of Constants

Constant Description

Danfoss_VLT_ServoMotion l Contains the version information of the library.

DDS_AxisErrorCodes l Constants for error codes of the axis.

l Error codes can be read using the function block MC_ReadAxisError_DDSand/or
DD_ReadAxisWarning_DDS.

DDS_AxisTraceSignals l Constants for the trace signals of the axis.

l Intended to be used with the function block DD_Trace_DDS.

DDS_BasCam l Constants for the creation of basic CAMs.

DDS_CamParsingErrors l Constants for parsing problems of a CAM.

l Error reason is returned by function block MC_CamTableSelect_DDS.

DDS_FB_ErrorConstants l Constants for errors inside POUs.

l The reason is given in an output ErrorInfo.ErrorID that is available in all POUs.

DDS_Intern l Constants which are needed internally for the library.

l They are not intended to be used in an application.

DDS_LabCam l Constants for the creation of labeling CAMs.

DDS_SdoAbortCodes l Constants for errors concerning reading and writing of parameters.

l The reason is given in an output AbortCode that is available in several POUs.
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Table 31: List of Constants - (continued)

Constant Description

PSM_ErrorCodes l Constants for error codes of the Power Supply Module (PSM 520).

l Error codes can be read using the function block DD_ReadPsmError_PSMand/or
DD_ReadPsmWarning_PSM.

PSM_TraceSignals l Constants for the trace signals of the Power Supply Module (PSM 520).

l Intended to be used with the function block DD_Trace_PSM.

6.11.5 Instantiating AXIS_REF_DDS in Automation Studio™

1. Create 1 instance of function block AXIS_REF_DDS (located in folder DDS_Drive) for every SDM 521/SDM 522 drive module and

servo drive that has to be controlled or monitored.

2. To create a link to the physical servo drive, link each instance of AXIS_REF_DDS to 1 physical servo drive. This makes it the logical

representation of 1 physical servo drive.

a. Open the Logical View.

b. Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

c. Initialize each instance of a drive with its DriveType.

6.11.6 Instantiating PSM_REF in Automation Studio™

1. Create 1 instance of function block PSM_REF (located in folder DDS_PSM) for every Power Supply Module (PSM 520) that has to

be controlled or monitored.

2. To create a link to the physical PSM 520, link each instance of PSM_REF to 1 physical PSM 520. This makes it the logical

representation of 1 physical PSM 520.

a. Open the Logical View.

b. Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

6.11.7 Importing a Servo Drive into Automation Studio™

  NOTICE

l For each physical servo drive, add 1 entry to the Physical View of Automation Studio™.

6.11.7.1 Project Version

6.11.7.1.1 Version V4.x

1. Select the menu entry [Tools] → [Import Fieldbus Device...].

2. Select the XDD file (for example, 0x0200008D_VLT_ISD_520_XXX_CTIO.xdd) from its location on the hard drive. The device is

then known to Automation Studio™.

3. Now add the SDM 521/SDM 522 drive module or servo drive to the Ethernet POWERLINK® interface of the controller in the

Physical View:

a. Select the menu entry [Open] → [System Designer] to show the System Designer.

b. To add a hardware module to the Physical View or System Designer, select the servo drive in the group POWERLINK in the

Hardware Catalog toolbox.

c. Drag the selected module to the desired position to connect it to the selected hardware module, network interface, or slot.

d. To change the node number, right-click on the device and select [Node Number] → [Change Node Number].
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Figure 51: Adding a Servo Drive to the Project

6.11.8 Importing PSM 520 into Automation Studio™

  NOTICE

l For each physical PSM 520 line (with or without DAM option), add 1 entry to the Physical View of Automation Studio™.

6.11.8.1 Project Version

6.11.8.1.1 Version V4.x

Procedure

1. Select the menu entry [Tools] → [Import Fieldbus Device...].

2. Select the XDD file for the PSM 520 from its location on the hard drive. The device is then known to Automation Studio™.

– Power Supply Module (PSM 520): 0x0200008D_PSM.xdd

3. Now add the PSM 520 to the Ethernet POWERLINK® interface of the controller in the Physical View:

a. Select the menu entry [Open] → [System Designer] to show the System Designer.

b. To add a hardware module to the Physical View or System Designer, select the PSM 520 in the group POWERLINK in the

Hardware Catalog toolbox.

c. Drag the selected module to the desired position to connect it to the selected hardware module, network interface, or slot.

d. To change the node number, right-click on the device and select [Node] → [Change Node Number].

Ü 
n PSM: Danfoss_VLT_R_PSM

n DAM: Danfoss_VLT_R_DAM
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Figure 52: 1 PSM 520, and 2 ISD 520 Servo Drives Added to the Ethernet POWERLINK® Interface in V4.x
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6.11.9 I/O Configuration and I/O Mapping

Procedure

1. Parameterize the I/O configuration of the SDM 521/SDM 522 drive modules or servo drives so that the library has access to all

necessary objects.

a. Right-click the entry of the SDM 521/SDM 522 drive module or servo drive and select Configuration in V4.x.

b. In the Channels section, change the Cyclic transmission of the following objects:

Ü 
n All sub-indexes of object 0x5050 (Lib pdo rx_I5050 ARRAY[]) to Write.

n All sub-indexes of object 0x5051 (Lib pdo tx_I5051 ARRAY[]) to Read.

2. Parameterize the I/O configuration of the (PSM 520), so that the library has access to all necessary objects.

a. Right-click the entry of the PSM 520 and select Configuration.

b. In the Channels section, change the Cyclic transmission of the following objects:

Ü 
n All sub-indexes of object 0x5050 (Lib pdo rx_I5050 ARRAY[]) to Write.

n All sub-indexes of object 0x5051 (Lib pdo tx_I5051 ARRAY[]) to Read.

  NOTICE

l These settings configure the cyclic communication with the device. These parameters are required for the library to work.

l It is possible to use copy and paste to apply the same I/O configuration to multiple devices of the same type.

3. Set Module supervised to off for the servo drives and the PSM 520. The parameter is found in the I/O configuration of the device.

Ü 

88  < AQ448939736224en-010101 < 130R1343                                                                                                                                                                    Danfoss A/S © 2026.05

VLT® Multiaxis Servo Drive MSD 520 > Operating Guide > Commissioning



Danfoss A/S © 2026.05                                                                                                                                                                    AQ448939736224en-010101 > 130R1343 >  89

e3
0b

g3
41

.1
0

Figure 53: I/O Configuration of an ISD 520 Device
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Figure 54: I/O Mapping after Successful Configuration

4. Map the inputs and outputs of the instance of the AXIS_REF_DDS function block and the physical data points of the ISD 520/

DSD 520 servo drive (here myAxis is an instance of AXIS_REF_DDS):

Ü 
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Figure 55: I/O Mapping of an ISD 520 Servo Drive

5. Map the inputs and outputs of the instance of the PSM_REF, function blocks, and the physical data points of the PSM 520

accordingly.

6.11.10 Setting the PLC Cycle Time

The minimum cycle time is 400 μs. The servo system devices can run Ethernet POWERLINK® cycle times in multiples of 400 μs and

multiples of 500 μs. The devices are automatically parameterized by the PLC on start-up, depending on the Ethernet POWERLINK®

configuration of the physical interface.

The Ethernet POWERLINK® configuration can be accessed by right-clicking [PLK] → [Configuration] in the Physical View.

  NOTICE

l Ensure that the task cycle times of the PLC program and Ethernet POWERLINK® are the same. Otherwise, data could be lost

and performance reduced.
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Figure 56: Ethernet POWERLINK® Configuration Window to Parameterize Ethernet POWERLINK® Cycle Time

Procedure

1. Right-click [CPU] → [Configuration] → [Timing] in the Physical View.

2. Ensure that the PLC cycle time is the same as the Ethernet POWERLINK® cycle time.

6.11.11 Connecting to the PLC

Information on how to connect to the PLC can be found in detail in the Automation Studio™ Help.

Version V4.x

Open the B&R Help Explorer and go to [Automation Software] → [Getting Started] → [Creating programs in Automation Studio] → [Example

project for a target system with CompactFlash].
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6.12 Programming with TwinCAT®

6.12.1 Requirements for Programming with TwinCAT®

To integrate a system component into a TwinCAT® project, the following files are required:

l Library for the system components: Danfoss_VLT_ServoMotion_V_x_y_z.compiled-library

l Common ESI file (EtherCAT® Slave Information) Danfoss_Drives.xml with a separate linked file for each configuration:

¢ VLT® Integrated Servo Drive ISD 520

¢ VLT® Integrated Servo Drive ISD 520 with VLT® FlexSafety™ option

¢ VLT® Integrated Servo Drive ISD 520 with VLT® FlexSafety™ option and Safe I/O option board

¢ VLT® Integrated Servo Drive ISD 520 with VLT® FlexSafety™ option and Standard I/O option board

¢ VLT® Integrated Servo Drive ISD 520 with Standard I/O option board

¢ VLT® Decentral Servo Drive DSD 520

¢ VLT® Decentral Servo Drive DSD 520 with VLT® FlexSafety™ option

¢ VLT® Decentral Servo Drive DSD 520 with VLT® FlexSafety™ option and Safe I/O option board

¢ VLT® Decentral Servo Drive DSD 520 with VLT® FlexSafety™ option and Standard I/O option board

¢ VLT® Decentral Servo Drive DSD 520 with Standard I/O option board

¢ VLT® Power Supply Module PSM 520

¢ VLT® Power Supply Module PSM 520 with Decentral Access Module Option

6.12.2 Creating a TwinCAT® Project

Information on how to install TwinCAT® can be found in detail in Beckhoff Information System (beckhoff.com).

Open the information system and select [TwinCAT 3] → [Installation].

Information on how to create a project in TwinCAT® can be found by opening the information system and selecting [TwinCAT 3] →
[TE1000 XAE] → [PLC].

6.12.3 Including the TwinCAT® Library into a TwinCAT® Project

Before a library can be used in a project, it has to be first installed on the system via the Library Repository:

1. Right-click the References in the PLC project tree and select Library Repository.

2. Click Install and select the Danfoss_VLT_ServoMotion_V_x_y_z library file (according to the location on the hard drive). Now the

library can be integrated into the TwinCAT project.

3. Close the Library Repository dialog by clicking the Close button.

4. Right-click the References in the PLC project tree and select Add Library.

5. Use the search field in the upper area of the Add Library dialog to filter available library references by name and select the

Danfoss_VLT_ServoMotion library.

6. Click OK to complete the procedure and integrate the library reference into the TwinCAT® PLC project.

Ü Library references are also shown in the Library Manager, which offers a good overview of the installed PLC libraries. It can be

used to integrate and manage libraries in a project, similar to the preceding procedure.
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Figure 57: Library Manager after Including the ServoMotion Library

Inside the library, the POUs are organized into folders:

l DDS_Drive

¢ Contains program organization units (POUs) defined by PLCopen® (name starting with MC_) and POUs defined by

Danfoss (name starting with DD_). The Danfoss POUs provide additional functionality for the axis.

¢ It is possible to combine POUs defined by PLCopen® with POUs defined by Danfoss.

¢ The names of the POUs that target the servo drives all end with _DDS.

l DDS_PSM

¢ Contains POUs defined by Danfoss (name starting with DD_) and provides the functionality for the Power Supply

Module (PSM 520).

¢ The names of the POUs that target the PSM 520 all end with _PSM.

l DDS_BasCam

¢ Contains POUs for the creation of basic CAMs.

l DDS_LabCam

¢ Contains POUs for the creation of labeling CAMs.

l DDS_Intern

¢ Contains POUs that are needed internally for the libraries.

¢ Do not use these POUs in an application.

When integrating the VLT® Integrated Servo Drive library, some standard libraries are integrated automatically, unless they are already

part of the project.
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  NOTICE

l Do not remove these libraries, otherwise the DDS libraries will malfunction.

6.12.4 Constants within the DDS_Drive Library

The constants are defined inside the DDS_Drive library (see Table 32).

Table 32: List of Constants

Constant Description

Danfoss_VLT_ServoMotion l Contains the version information of the library.

DDS_AxisErrorCodes l Constants for error codes of the axis.

l Error codes can be read using the function block MC_ReadAxisError_DDSand/or
DD_ReadAxisWarning_DDS.

DDS_AxisTraceSignals l Constants for the trace signals of the axis.

l Intended to be used with the function block DD_Trace_DDS.

DDS_BasCam l Constants for the creation of basic CAMs.

DDS_CamParsingErrors l Constants for parsing problems of a CAM.

l Error reason is returned by function block MC_CamTableSelect_DDS.

DDS_FB_ErrorConstants l Constants for errors inside POUs.

l The reason is given in an output ErrorInfo.ErrorID that is available in all POUs.

DDS_Intern l Constants which are needed internally for the library.

l They are not intended to be used in an application.

DDS_LabCam l Constants for the creation of labeling CAMs.

DDS_SdoAbortCodes l Constants for errors concerning reading and writing of parameters.

l The reason is given in an output AbortCode that is available in several POUs.

PSM_ErrorCodes l Constants for error codes of the Power Supply Module (PSM 520).

l Error codes can be read using the function block DD_ReadPsmError_PSMand/or
DD_ReadPsmWarning_PSM.

PSM_TraceSignals l Constants for the trace signals of the Power Supply Module (PSM 520).

l Intended to be used with the function block DD_Trace_PSM.

6.12.5 Instantiating AXIS_REF_DDS in TwinCAT®

Procedure:

1. Create 1 instance of function block AXIS_REF_DDS (located in folder DDS_Drive) for the SDM 521/SDM 522 drive module or

servo drive that must be controlled or monitored.

2. Repeat step 1 for additional SDM 521/SDM 522 drive modules or servo drives.

Ü 

VLT® Multiaxis Servo Drive MSD 520 > Operating Guide > Commissioning



e3
0b

l7
91

.1
0

Figure 58: Instantiation of AXIS_REF_DDS

6.12.6 Instantiating PSM_REF in TwinCAT®

Procedure:

1. Create 1 instance of function block PSM_REF (located in folder DDS_PSM) for each Power Supply Module that has to be

controlled or monitored.

2. Repeat step 1 for each additional PSM 520.

6.12.7 Adding a PLC Project to TwinCAT® System Manager

A PLC project contains the objects required to create a controller program:

l Pure programming blocks, for example, programs, function blocks, functions, GVLs.
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l Objects that are also required to run the program on a PLC, for example, referenced tasks, library managers, and visualizations.

A standard PLC project can be created as follows:

1. Select the command [New] → [Project] in the menu File.

2. Select the template [TwinCAT Projects] → [TwinCAT XAE Project], then enter a name (for example, TwinCAT project ) and a storage

location in the file system.

3. Click OK to confirm.

4. A new solution opens in the Solution Explorer with an empty PLC project.

5. Mark the PLC object in the project tree and select the command [Add New Item] in the menu Projector in the context menu. The

dialog Add New Item <TwinCAT project name> opens.

6. Select the [Standard PLC Project] in the category Plc Templates and enter a name (for example, PLC project).

7. Quit the dialog with Add. The following structure is created in the view Solution Explorer.
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Figure 59: Structure of a Standard PLC Project

With the selected template the following basic objects appear automatically under the node PLC Project:

¢ A PLC project (PLC project Project) and a project instance (PLC project Instance).

¢ The PLC project contains:

n A library manager (References).

n The standard program block MAIN and a task reference (PlcTask). The task referenced there (PlcTask) defines the

execution of the program block MAIN.

n In addition, the structure folders External Types, DUTs, GVLs, POUs, and VISUs appear automatically.

The library manager already contains the standard libraries with basic blocks such as counters, timers, and string functions that

can then be used for programming.

Filling MAIN with error-free code enables it to be loaded to the controller and run without the need for further programming

objects.

6.12.8 Importing Devices to TwinCAT®

The TwinCAT® System Manager and the TwinCAT® EtherCAT Master require the device description files of all EtherCAT® devices for

configuration in online and offline mode.
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The device descriptions are contained in the so-called ESI files (EtherCAT Slave Information) in XML format. They must be made available

to TwinCAT® before a device can be imported into the project. Only then can new I/O modules be imported into the TwinCAT® project.

The whole procedure can be summarized as follows.

1. Copy the Danfoss_Drives.xml ESI file into TwinCAT® installation directory C:\TwinCAT\3.1\Config\Io\EtherCAT on the hard drive*.

2. Right-click [I/O] → [Devices] and select [Add New Item].

3. In the following window, select [EtherCAT] → [EtherCAT Master] and click OK.
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Figure 60: Add an EtherCAT®Master to the Project

4. A new entry Device 1 is now available in the tree view of the I/O configuration, with its own input and output modules (boxes)

added below the devices node. Before it can be used, the correct network adapter should be selected in the Device Found At

window.

5. Right-click the configured I/O device Device1 (EtherCAT) to open the context menu for adding 1 of the supported I/O modules.

Select menu item [Add New Item] to open the Insert EtherCAT Device window and select from the available modules.

6. To add a VLT® Power Supply Module, select [Danfoss GmbH] → [VLT® FlexMotion] → [][VLT® Power Supply Module PSM 520 ] and

click OK to confirm I/O device selection and close the window.

7. Answer the question if the servo drive is used as an NC axis with Cancel. If the servo drive is to be used as an NC axis,

see 6.12.13.1 Configuration as a TwinCAT® NC Axis.

Ü This is the result after appending a new PLC Project and adding some Danfoss devices:

¢ 1 x Power Supply Module 520 with DAM option

¢ 2 x VLT® Integrated Servo Drive ISD® 520
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Figure 61: VLT® Power Supply Module PSM 520 with Decentral Access Module Option

8. In the Add EtherCAT® Device  window, select [Danfoss Drives A/S] → [VLT® FlexMotion] → [VLT® Integrated Servo Drive ISD 520] and

click OK to confirm I/O device selection and close the window.
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Figure 62: Insert EtherCAT®Device

Perform this step once per project because the TwinCAT® System Manager automatically searches for ESI files at this location on the hard

drive during start-up.

6.12.9 I/O Configuration and I/O Mapping

For each EtherCAT device, the TwinCAT® System Manager indicates at which Previous Port it is connected, that is, the name of the

connected port (B to D) of the previous slave. This assignment is required to map an EtherCAT® network in TwinCAT® "offline"

configuration.
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Figure 63: Setting the Previous Port of an EtherCAT®Device

When connecting >1 SDM 521/SDM 522 drive module or servo drive, ensure that port B of the previous servo drive is connected to port

C of the next servo drive. Port assignment is also required for VLT® Decentral Access Modules.
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If the hardware setup is already present, the Scan command of the TwinCAT® System Manager can be used to automatically add the

connected devices to the configuration in the correct order.

It is also important that the SDM 521/SDM 522 drive module or servo drive configuration is optimized so that the process data output

(PDO) mapping matches the requirements of the library.

1. Click the VLT® ISD 520 drive entry to show the general and terminal-specific dialogs.

2. Select the Slots tab on the right side of the window.

3. Make sure that Library PDO is selected as the PDO mapping module in the Slot box. If not, replace the current module (for

example, CSP PDO configuration) with Library PDO using the available buttons.
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Figure 64: ISD 520 Servo Drive with Correct I/O Configuration

6.12.10 Attaching the Input and Output Variables to the Physical Data Points

Use the TwinCAT® System Manager to attach the input and output variables of the PLC program to the physical inputs and outputs of the

device. This ensures that the library has access to all necessary objects.

  NOTICE

l Repeat steps 2–22 for Box 1 (VLT® Power Supply Module) and the instance myPSM.

1. In the tree view of the I/O configuration, select Library TxPDO via menu [I/O] → [Devices] → [Device 1 (EtherCAT)] → [][Box 1 (VLT®

PSM 520 with DAM option)] → [Drive 1 (VLT ISD 520 XXX_CTXX)] → [Module 1 (Library PDO)] → [Library TxPDO].

2. Select entries from Lib pdo tx 1 to Lib pdo tx 9  that form the transmit PDO (TxPDO).

3. Right-click and select Change Multi Link.

4. In the Attach Variable 36.0 Byte(s) (Input) window, select the variable referencing the servo drive [MAIN.] → [myAxis1.] → [TPDO].

Ensure that the Matching Size option is selected in the Attach Variable window.
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Figure 65: Attaching Inputs and Outputs to the Physical Data Points

5. Click OK.

6. In the tree view of the I/O configuration, select Library RxPDO via menu [I/O] → [Devices] → [Device 1 (EtherCAT)] → [][Box 1 (VLT®

PSM 520 with DAM option)] → [Drive 1 (VLT ISD 520 XXX_CTXX)] → [Module 1 (Library PDO)] → [Library RxPDO].

7. Select all entries from Lib pdo rx 1 to Lib pdo rx 9 that form the receive PDO (RxPDO).

8. Right-click and select Change Multi Link.

9. In the Attach Variable 36.0 Byte(s) (Output) window, select the variable referencing the servo drive MAIN. → myAxis1. → RPDO.

Ensure that the Matching Size option is selected in the Attach Variable window.

10. Click OK.

11. Right-click on the WcState item [I/O] → [Devices] → [Device 1 (EtherCAT)] → [][Box 1 (VLT® PSM 520 with DAM option)] → [Drive 1

(VLT ISD 520 XXX_CTXX)] → [WcState] → [WcState] and select Change Link.

12. In the Attach Variable State (Input) window, select [MAIN.] → [myAxis1.] → [WcState].

13. Click OK.

14. Right-click on the State item [I/O] → [Devices] → [Device 1 (EtherCAT)] → [][Box 1 (VLT® PSM 520 with DAM option)] → [Drive 1 (VLT

ISD 520 XXX_CTXX)] → [InfoData] → [State] and select Change Link.

15. In the Attach Variable State (Input) window, select [MAIN.] → [myAxis1.] → [State].

16. Click OK.

17. Right-click on the netId item [I/O] → [Devices] → [Device 1 (EtherCAT)] → [][Box 1 (VLT® PSM 520 with DAM option)] → [Drive 1 (VLT

ISD 520 XXX_CTXX)] → [InfoData] → [AdsAddr] → [netId] and select Change Link.

18. In the Attach Variable netId (Input) window, select [MAIN.] → [myAxis1.] → [AmsNetId].

19. Click OK.

20. Right-click on the port item [I/O] → [Devices] → [Device 1 (EtherCAT)] → [][Box 1 (VLT® PSM 520 with DAM option)] → [Drive 1 (VLT

ISD 520 XXX_CTXX)] → [InfoData] → [AdsAddr] → [port] and select Change Link.

21. In the Attach Variable port (Input) window, select [MAIN.] → [myAxis1.] → [NodeNumber].

22. Click OK.
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6.12.11 Transferring the Mappings back to the PLC Program

To transfer the mappings back to the PLC program, select Activate Configuration... in menu item Actions.

After a rebuild in TwinCAT® PLC Control, the TwinCAT® configuration is according to Figure 66 (here myAxis and mySecondAxis are

instances of AXIS_REF_DDS, myPSM is an instance of PSM_REF). The concrete addresses can be different.
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Figure 66: TwinCAT® Configuration: I/O Mapping of 2 Servo Drives, 1 PSM 520

  NOTICE

l Connect the PSM 520, and SDM 521/SDM 522 to 1 SYNC unit and the ISD 520/DSD 520 servo drives to another. This protects

against interruptions in communication to the PSM 520 if the UAUX supply to the decentral servo drives is switched off due to

an error.

6.12.12 Setting the PLC Cycle Time in TwinCAT® PLC Control

The minimum cycle time is 400 µs. The MSD 520 devices can run EtherCAT® cycle times in multiples of 400 µs or 500 µs. The devices are

automatically parameterized by the PLC on start-up, depending on the EtherCAT® configuration of the physical interface. To access the

system base time, select [SYSTEM-Configuration] → [Real-Time Settings] in the TwinCAT® System Manager. Multiples of this base time can

then be used as EtherCAT® cycle times.

  NOTICE

l Set the task cycle time of the PLC program to be the same as the EtherCAT® cycle time. Otherwise data may be lost and

performance reduced.

Procedure

1. Double-click Task configuration in the Resources tab.

2. Ensure that the PLC cycle time is the same as the EtherCAT® cycle time.

Ü 
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Figure 67: Task Configuration to Parameterize the PLC Cycle Time

  NOTICE

l After changing the task cycle time in TwinCAT® PLC Control, carry out a ReScan of the PLC configuration inside the TwinCAT®

System Manager to update the settings. Afterwards, activate the configuration in the PLC.

6.12.13 TwinCAT® NC Axis

6.12.13.1 Configuration as a TwinCAT® NC Axis

The servo drives can be used with the built-in NC functionality of TwinCAT®.

Everything that is related to the PSM 520 line (with or without DAM option) must be done as described in 6.12.2 Creating a TwinCAT®

Project.

1. In addition to the Danfoss_VLT_ServoMotion_V_x_y_z.lib file, include the Tc2_MC2 library.

2. Create 1 instance of AXIS_REF (instead of AXIS_REF_DDS) for each ISD 520/DSD 520 servo drive that is used as an NC axis.

3. Append the PLC project into the TwinCAT® System Manager, import the devices, and add them to TwinCAT®. In the last step,

answer the question if the servo drive is used as an NC axis with Yes, then an NC task is created automatically.

6.12.13.2 I/O Configuration for Servo Drives used as NC Axes

In the TwinCAT® System Manager, select a different I/O Configuration for the servo drives used as NC axes.

1. Depending on the mode of operation to be used, select either the slot CSP PDO or CSV PDO (see 6.12.9 I/O Configuration and I/O

Mapping for process data output (PDO) mapping details). Per default, CSV PDO is mapped and pre-selected.

2. Map the following variables if the VLT® Integrated Servo Drive servo drive is required to work with CSP PDO:

a. In the Settings tab of the NC Axis, select [MOTION] → [NC-Task 1 SAF] → [Axes] → [Axis 1]. Click on the Link To I/O button and

select the servo drive under I/O to be linked with the NC axis.

b. Click on the Link To PLC button and select the PLC instance of the axis to be linked with the NC axis.

3. In the same tab, select the preferred Unit for the position of the axis.

4. Depending on the selected unit, adjust the Scaling Factor for the axis encoder via menu [MOTION] → [NC-Task 1 SAF] → [Axes] →
[Axis 1] → [Enc] in the Parameter tab.

When the unit Degrees is selected, the scaling factor is 360°/220 = 0.00034332275390625.

5. Set the Reference Velocity in the Parameter tab via menu [MOTION] → [NC-Task 1 SAF] → [Axes] → [Axis 1].

6. Set the Output Scaling Factor (Velocity) to 125.

7. Test the functionality and the configuration in the Online  tab of the axis.
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6.12.14 Loading the Program Code and Starting the PLC

Information on how to transfer the PLC project to the controller can be found in the Back-end Information System.

Open the information system and go to [TwinCAT 3] → [TE1000 XAE] → [PLC] → [Transfer PLC project to the PLC].

6.13 Programming Guidelines for Automation Studio™ and TwinCAT®
Recommendations for implementation:

l Initialize parameters that usually do not change only once at the beginning of the program. In Automation Studio™, use the _INIT

section.

l Call up function blocks that provide status or error information with Enable input at the beginning of the program.

l Use 1 instance of the function block MC_Power_DDS for every axis to control its power stage. Call up this function block in every PLC

cycle.

l Use 1 instance of the function block DD_Power_PSM for every PSM 520 to control the DC-link voltage on the output. Call up this

function block in every PLC cycle.

l Call up function blocks that execute (motion) commands at the end of the program.

l Do not use any POUs from the library (folder) DDS_Intern.

l Do not change the reference to the axis on a function block while it is busy.

6.14 Programming with SIMOTION SCOUT®

6.14.1 Requirements for Programming with SIMOTION SCOUT®

The following files are required to integrate the system components into a SIMOTION SCOUT® project. In the filename, 2.xx shows the

version number and yyyymmdd shows the date.

Table 33: Required Files

System module File required

Package of libraries for MSD 520 the servo system:
Danfoss_VLT_ServoMotion_V_x_y_z.zip

Whole servo system

Online Help file(.chm): Programming with SIMOTION SCOUT®

Servo Drive Module SDM 521/SDM 522 GSDML file (General station description):

GSDML-V2.xx-Danfoss-DDS-yyyymmdd.xml

Integrated Servo Drive ISD 520 GSDML file (General station description):

GSDML-V2.xx-Danfoss-DDS-yyyymmdd.xml

Decentral Servo Drive DSD 520 GSDML file (General station description):

GSDML-V2.xx-Danfoss-DDS-yyyymmdd.xml

Power Supply Module PSM 520 GSDML file (General station description):

GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

6.14.2 Connecting to the PLC with SIMOTION SCOUT®

Information on how to connect to the PLC can be found in detail in the SIMOTION SCOUT® Help.

Open SIMOTION SCOUT and go to [Help → Help Topics → Getting Started with SIMOTION SCOUT → Download the project to the target system

→ Connect to selected target devices → Go online].
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6.14.3 Creating a SIMOTION SCOUT® Project

Information on how to install SIMOTION SCOUT® refer to the SIMOTION SCOUT® Configuration Manual.

  NOTICE

l SIMATIC STEP 7 V5.5 or higher with HF11 must be installed to create a project.

Information on how to create a project in SIMOTION SCOUT® can be found in detail in the SIMOTION SCOUT® online help.

Open SIMOTION SCOUT® and go to [Help] → [Help Topics] → [Getting started with SIMOTION SCOUT] → [Create SIMOTION device and

configure PG/PC communication connection].

6.14.4 Including the Servo Motion Libraries into a SIMOTION SCOUT® Project

The folder LIBRARIES in the Project tab contains these libraries:

l DDS_Drive

¢ Contains program organization units (POUs) defined by PLCopen® (name starting with MC_) and POUs defined by Danfoss

(name starting with DD_). The Danfoss POUs provide additional functionality for the servo drive.

¢ It is possible to combine POUs defined by PLCopen® with POUs defined by Danfoss.

¢ The names of the POUs that target the SDM 521/SDM 522 drive modules and servo drives all end with _DDS.

l DDS_PSM

¢ Contains POUs defined by Danfoss (name starting with DD_) and provides the functionality for the Power Supply Module (PSM

520).

¢ The names of the POUs that target the PSM 520 all end with _PSM.

l DDS_BasCam

¢ Contains POUs for the creation of basic CAMs.

l DDS_LabCam

¢ Contains POUs for the creation of labeling CAMs.

l DDS_Intern

¢ Contains POUs that are needed internally for the libraries.

¢ Do not use these POUs in an application.

When integrating the DDS_Drive package, some standard libraries are integrated automatically, unless they are already part of the

project.
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Figure 68: Project Tree after Including Danfoss Servo Motion Libraries

  NOTICE

l Do not remove or rename these libraries.

Procedure

1. Extract the files from the Danfoss_VLT_ServoMotion_V_x_y_z.zip file (according to the location on the hard drive).

The DDS_Xxxx.xml file and XML_DDS_Xxxx folder must be located together in the same folder to import the library.

2. In the Project tab, right-click on LIBRARIES and select [Export/import] → [Import folders/objects].

Ü 
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Figure 69: Import Library

3. Select file DDS_Intern.xml according to the location on the hard drive.

4. Click OK.

Now the library is integrated into the SIMOTION SCOUT® project.

5. Repeat steps 2–4 for DDS_BasCam.xml, DDS_Drive.xml, DDS_LabCam.xml, DDS_PSM.xml, DDS_DAM.xml.

6.14.5 Importing Devices into SIMOTION SCOUT®

  NOTICE

l For each physical servo drive, PSM 520, add 1 entry to the PROFINET® Ethernet network in the HW Config tool.

Procedure

1. Open the HW Config tool.

2. Select [Options → Install GSD File...].

3. To add an SDM 521/SDM 522 drive module or servo drive, select the xml file (according to the location on the hard drive) and

click Install. In the filename, 2.xx shows the version number and yyyymmdd shows the date.

– GSDML-V2.xx-Danfoss-DDS-yyyymmdd.xml

4. Repeat steps 2 and 3 for:

– Power Supply Module (PSM 520): GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

5. Drag the device Danfoss Drive Servo IRT to an existing PROFINET® Ethernet network.

Ü Find the servo drive device named Danfoss Drive Servo IRT by expanding the PROFINET IO entry in the hardware catalog

on the right side of the screen and select [Additional Field Devices] → [Drives] → [VLT® FlexMotion]. If the device is not

visible, update the hardware catalog by selecting [Options] → [Update catalog].

6. Expand Drive Object 1 and folder Profile in the hardware catalog on the right side of the screen and drag the Danfoss Telegram to

the free slot of Drive Object 1 at the bottom of the screen.
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Figure 70: Dragging the Danfoss Telegram to a Free Slot

7. To set the communication parameters, double-click the icon depicting the servo drive in the main window showing the

Ethernet network.

8. In the General tab, enter a name in field Device name.

9. In the General tab, click Ethernet... button to set the IP address of the servo drive, and click OK.

10. Repeat steps 6–9 for:

– Power Supply Module (PSM 520): VLT PSM IRT

6.14.6 Assigning IP Configuration and Device Name

  NOTICE

l If more than 1 servo drive is used in the same PROFINET® network, each servo drive must have a different

name and IP address.

l The IP address assignment is also required when using indirect communication via the VLT® Toolbox

software. See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Programming Guide

for further information.

Procedure

1. Open menu [PLC → Ethernet → Edit Ethernet Node].

2. In the next window, click Browse.

Ü 
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Figure 71: Edit Ethernet Node

All accessible Ethernet nodes are shown in this window.

The ISD 520 servo drives are listed under device type VLT® ISD 520.

The DSD 520 servo drives are listed under device type VLT® DSD 520.

The SDM 521/SDM 522 servo drive modules are listed under device type VLT® SDM 520.

3. Select the desired servo drive and click OK.

Use the Flash button to identify the specific servo drive.

Ü 
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Figure 72: Selecting the Servo Drive

4. In the Edit Ethernet Node window, select the option Use IP parameters.

5. Enter the IP address and Subnet mask and click Assign IP configuration.

Ü 
e3

0b
h5

24
.1

0

Figure 73: Entering the IP Address and Assigning the IP Configuration

6. Enter the device name that was previously selected and click Assign Name click Close.

Ü 
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Figure 74: Assigning the Device Name

6.14.7 Creating a Sync Domain

A sync domain is a group of PROFINET® devices synchronized to a common cycle clock. One device has the role of the sync master (clock

generator). All other devices are sync slaves.

  NOTICE

l All devices that exchange data via Isochronous Real-Time (IRT) must belong to the same sync domain.

Procedure

1. Open the HW Config tool.

2. Select the station with the PROFINET® devices to be involved in IRT communication.

3. Select the PROFINET® I/O interface in the section Station/IO system.

4. Select the menu [Edit → PROFINET IO → Domain management].

Ü 

110  < AQ448939736224en-010101 < 130R1343                                                                                                                                                                 Danfoss A/S © 2026.05

VLT® Multiaxis Servo Drive MSD 520 > Operating Guide > Commissioning



Danfoss A/S © 2026.05                                                                                                                                                                 AQ448939736224en-010101 > 130R1343 >  111

e3
0b

h5
26

.1
0

Figure 75: Domain Management

5. In the Sync Domain tab, select the station in the upper field of the Nodes section.

6. In the lower field of the Nodes section, double-click the device that must be configured as the sync master.

7. When the Device properties window opens, select Sync master as Synchronization role and click OK.
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Figure 76: Device Properties: Sync Master

8. In the Domain management window, select all devices to be configured as sync slaves in the Nodes section

Keep the CTRL button depressed to select >1 device.

9. Click Device Properties button.

10. In the Device Properties window, select Sync slave as Synchronization role and click OK.

Ü 
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Figure 77: Device Properties: Sync Slave

11. In the Domain management window, click OK.

12. Select the station with the PROFINET® devices.

13. Select the menu [Edit → Object Properties].

14. In the next window, open the Isochronous Tasks tab, select the isochronous mode for I/O data change, and click OK.
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Figure 78: Use I/O Data Isochronously to the Servo

15. Click VLT® ISD 520 IRT device.

16. Double-click the PN-IRT-Inteface in the Module.

17. In the next window, open the IO Cycle tab and set field Assign IO device in isochronous mode to Servo.

Ü 
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Figure 79: Assign I/O Device in Isochronous Mode

6.14.8 Configuring a Topology

The topology must be configured and parameterized.

Procedure

1. Open the HW Config tool.

2. Select the path for the PROFINET® I/O system or PROFINET®module, for example a Danfoss MSD 520 series.

3. Select the menu [Edit → PROFINET IO → Topology].

4. In the next window, select the Graphic view tab.

Ü 

e3
0b

h5
29

.1
0

Figure 80: Graphic View Tab in Topology Editor

5. Connect the PROFINET® device with the station. Establish connections between ports by holding down the left mouse button

and drawing a line between the 2 ports.

6. Once all connections are made, click OK.
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6.14.9 Defining Send Clock and Update Time

6.14.9.1 Configuring the Send Clock Time

Procedure

1. Open the HW Config tool.

2. Select the station with the PROFINET® devices to be involved in IRT communication, for example PNxIO.

3. Select the menu [Edit → PROFINET IO → Domain management].

4. In the next window, open the Sync Domain tab and in the Send clock time [ms] field, select an appropriate time for the process,

for example, 1.000 ms, and click OK.
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Figure 81: Configuring a Send Clock for PROFINET® IRT

6.14.9.2 Configuring the Update Time

  NOTICE

l The system cycle clocks of the PLC program must be the same as the PROFINET® send clock, otherwise data can be lost and

performance reduced.

Procedure

1. Open the HW Config tool.

2. Select the path for the PROFINET® I/O system.

3. Select the menu [Edit → Object properties].

4. In the next window, open the Update Time tab, highlight the I/O device, and click Edit button.

5. In the next window Edit Update Time/Mode, select the Update Time and click OK.
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Figure 82: Set Update Time

6.14.10 Accessing Inputs and Outputs

SIMOTION SCOUT® provides access to the device inputs and outputs of the SIMOTION device through the process image of cyclic tasks

using I/O variables.

Procedure

1. Open the Project tab and double-click ADDRESS LIST element in the device subtree.

For example C240 [C240 PN].
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Figure 83: Address List in the Project Navigator

2. In the next window Figure 84 , create 1 variable for incoming and outgoing PPO data for each device.
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Figure 84: Address List Detailed View

3. Set the following properties for each variable:

– Name (of the I/O variable)

– I/O address

– Data type: ARRAY OF BYTE

– Array length: 36

– Process image: IPOsynchronousTask
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  NOTICE

l The I/O address must fit the configuration of the device in the HW Config tool.

l I/O variables can only be created in offline mode.

6.14.11 Programming using the Danfoss VLT® Servo Motion Library

Before using data types, functions, or function blocks from libraries, the following construct must be used in the interface section:

USELIB DDS_BasCam, DDS_Drive, DDS_LabCam, DDS_PSM;

More information on how to use data types, functions, and function blocks from libraries can be found in detail in the online help for

SIMOTION SCOUT®.

Open the SIMOTION SCOUT® and go to [Help → Help Topics → Programming → Integration of ST in SIMOTION → Using libraries → Using

data types, functions and function blocks from libraries].

  NOTICE

l Do not use the POUs, Constants, and User-Defined Data Types (UDT) that start with iDD_ in an application.

6.14.12 Instantiating AXIS_REF_DDS in SIMOTION SCOUT®

Create 1 instance of AXIS_REF_DDS (located in folder DDS_Drive) for every servo drive that has to be controlled or monitored. Each

instance of AXIS_REF_DDS is the logical representation of 1 physical servo drive.

  NOTICE

l The instance of the AXIS_REF_DDS structure must be created as a global variable (variable in the interface section of a unit

declared with VAR_GLOBAL).

In the AXIS_REF_DDS structure, only assign the variable InputLogAddress once at the beginning of the application program for each axis.

This is to specify the input logical base address of the I/O module from the HW Config. For this initialization, use the system function

_getLogicalAddressOfIoVariable(). Only assign the variable InputLogAddress once in the 1st PLC cycle for initialization.

In the AXIS_REF_DDS structure, assign the variable Quality at the beginning of the application program for each axis in every cycle. Use

the system function _quality.<I/Ovariable>, whereby <I/Ovariable> is the variable containing the cyclic data that was assigned in the

ADDRESS LIST. Carry out this assignment in every PLC cycle.

Call the function DD_UpdateProcessInput_DDS at the beginning of the application program for each device in every cycle. Call the

function DD_UpdateProcessOutput_DDS at the end of the application program for each device in every cycle.

  NOTICE

l Only create instructions and other program parts between the calls of DD_UpdateProcessInput and DD_UpdateProcessOutput.

6.14.13 Instantiating PSM_REF in SIMOTION SCOUT®

Create 1 instance of PSM_REF (located in folder DDS_PSM) for every Power Supply Module (PSM 520) that has to be controlled or

monitored. Each instance of PSM_REF is the logical representation of 1 physical PSM.

  NOTICE

l The instance of the PSM_REF structure must be created as a global variable (variable in the interface section of a unit declared

with VAR_GLOBAL).
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In the PSM_REF structure, assign the variable Quality at the beginning of the application program for each Power Supply Module in every

cycle. Use the system function _quality.<I/Ovariable>, whereby <I/Ovariable> is the variable containing the cyclic data that was assigned

in the ADDRESS LIST. Carry out this assignment in every PLC cycle.

Call the function DD_UpdateProcessInput_PSM at the beginning of the application program for each device in every cycle. Call the

function DD_UpdateProcessOutput_PSM at the end of the application program for each device in every cycle.

  NOTICE

l Only create instructions and other program parts between the calls of DD_UpdateProcessInput and DD_UpdateProcessOutput.

6.14.14 Global Compiler Settings

Activate the global compiler settings Permit language extensions.

Procedure

1. Open the menu [Options → Settings].

2. In the next window, select the Compiler tab.

3. Activate the checkbox Permit language extensions and click OK.
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Figure 85: Global Compiler Settings

6.14.15 Assigning Tasks

To guarantee synchronous operation, the application must use a Synchronous Task and a Peripheral Fault Task to evaluate the alarms.

Procedure

1. Open the Project tab.

2. Double-click EXECUTION SYSTEM in the device subtree.

Ü 
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Figure 86: Execution System in the Project Navigator

3. In the next window, expand entry Execution levels and select OperationLevels and SynchronousTask in the tree structure.

4. In the SynchronousTask window, activate checkbox Use task in execution system.

5. Click the new entry IPOsynchronousTask in the tree structure.

6. In the Program assignment area at the left side of the Synchronous Task window, assign the program by selecting it and click [>>]

button. The program is moved to the Programs used section on the right side.
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Figure 87: IPOsynchronousTask in Execution System

7. In the Task configuration tab, set the Number of level overflows in the IPO cycle clock to [1] and the IPOsynchronousTask / IPO cycle

clock to [50%].

Ü 
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Figure 88: IPOsynchronousTasks Configuration

8. Expand entry SystemInterruptTasks in the tree structure and select the new entry PeripheralFaultTask.

9. In the PeripheralFaultTask window, activate checkbox Use task in execution system.

10. In the Program assignment area at the left side of the PeripheralFaultTask window, assign the program by selecting it and click

[>>] button. The program is moved to the Programs used section on the right side.

11. To save and compile the settings, click Close.

6.15 Programming Guidelines for SIMOTION SCOUT®
Recommendations for implementation:

l Only assign the variable InputLogAddress in the AXIS_REF_DDS structure once for each axis at the beginning of the program. Use the

system function _getLogicalAddressOfIoVariable to get this address from the I/O variable of the address list. Use the input address of

the module as the I/O variable. Only assign this variable in the 1st PLC cycle for initialization.

l Initialize parameters that usually do not change only once at the beginning of the program.

l Only assign the variable Quality in the AXIS_REF_DDS structure once for each axis at the beginning of the program. Use the system

function _quality.var-name. Carry out this check for every PLC cycle.

l Call up the function blocks DD_UpdateProcessInput_DDS and DD_UpdateProcessOutput_DDS for every axis to update the process

image partition of inputs and outputs. Call up these function blocks in every PLC cycle.

l Only create instructions and other program parts between calling up function blocks DD_UpdateProcessInput_DDS and

DD_UpdateProcessOutput_DDS.

l Call up function blocks that provide status or error information with Enable input at the beginning of the program.

l Use 1 instance of function block MC_Power_DDS for every axis to control its power stage. Call up this function block in every PLC

cycle.

l Use 1 instance of function block DD_Power_PSM for every PSM 520 to control the DC-link voltage on the output lines. Call up this

function block in every PLC cycle.

l Call up function blocks that execute (motion) commands at the end of the program.

l Do not use any UDTs, POUs, enumerations, or constants starting with the prefix iDD_.

l Do not change the reference to the axis on a function block while it is busy.
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6.16 VLT® Servo Toolbox Software

6.16.1 Overview

The VLT® Servo Toolbox is a standalone PC software designed by Danfoss. It is used for parameterization and diagnostics of the system

components. It is also possible to operate the devices in a non-productive environment.

  NOTICE

l The VLT® Servo Toolbox software must be allowed for every firewall profile (private/public/domain).

The VLT® Servo Toolbox contains several subtools that provide various functionalities.

Table 34: Important Subtools

Subtool Description

Scope For visualization of the tracing functionality of the servo drives, the Power Supply Module (PSM 520).

Parameter list For reading/writing parameters.

Firmware update For updating the firmware on the devices.

Drive control For operating the servo drives, for testing purposes.

PSM control For operating the Power Supply Module (PSM 520), for testing purposes.

CAM editor For designing CAM profiles for the servo drives.

Configuration parameter For setting up the motor and feedback parameters, and PID settings.

Drive commissioning For motor feedback adjustment, and inertia measurement.

Safety subtool For setting up safety parameters, for the servo drives with VLT®FlexSafety™ option.

For a detailed description of the VLT® Servo Toolbox functionality and the full parameter lists. See the VLT® Servo Drive System ISD 520,

DSD 520, MSD 520 (VLT® FlexMotion™) Programming Guide.

6.16.2 System Requirements

To install the VLT® Servo Toolbox software, the PC must meet the following requirements:

l Supported hardware platforms: 32 bit, 64 bit

l Supported operating systems: Windows 10, Windows 11

l .NET framework version: 4.7

l Minimum hardware requirements: 512 MB RAM, Intel Pentium 4 with 2.6 GHz or equivalent, 20 MB hard disk space

l Recommended hardware requirements: Minimum 1 GB RAM, Intel Core i5/i7 or compatible

6.16.3 Installing the VLT® Servo Toolbox Software

Administrator rights are required to install the software with the Windows operating system. If necessary, contact a system administrator.

Procedure

1. Check that the system meets the system requirements specified in 6.16.2 System Requirements.

2. Download the VLT® Servo Toolbox installation file from the Danfoss website (http://drives.danfoss.com).

3. Right-click the .exe file and select Run as administrator.

4. Follow the on-screen instructions to complete the installation process.
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6.16.4 VLT® Servo Toolbox Communication

6.16.4.1 Overview

This section describes the Ethernet-specific network interface settings needed by the VLT® Servo Toolbox. There are 2 basic

communication methods: direct communication and indirect communication. Their particular network settings are described in the

respective subchapters.

Read and perform the steps with care. Incorrect network configurations can lead to loss of connectivity of a network interface.

6.16.4.2 Firewall

Depending on the firewall settings and the fieldbus used, the messages sent and received by the VLT® Servo Toolbox may be blocked by

the firewall on the VLT® Servo Toolbox host system. This may lead to a loss of communication and the inability to communicate with the

devices on the fieldbus. Therefore, ensure that the VLT® Servo Toolbox is allowed to communicate through the firewall on the VLT® Servo

Toolbox host system. Inappropriate changes to firewall settings may lead to security issues.

  NOTICE

l When using a dedicated network interface, the VLT® Servo Toolbox must be allowed to communicate specifically through this

network interface.

6.16.4.3 Indirect Communication

6.16.4.3.1 Overview

Communication between MSD 520 devices and the VLT® Servo Toolbox through a PLC is called indirect communication.

Ethernet-based fieldbus communication (marked A in Figure 89) takes place between the PLC and the MSD 520 devices.

However, there is non-fieldbus communication between the PLC and the VLT® Servo Toolbox host system (marked B in Figure 89).

In the scenario shown, the PLC has the master function and uses cyclic communication with the devices. Therefore, not all functionalities

of the VLT® Servo Toolbox, for example, the drive control, can be used.

The restrictions when using indirect communication are detailed in the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®

FlexMotion™) Programming Guide.
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Figure 89: Logical View of Indirect Ethernet-based Fieldbus Communication (Communication via PLC)

A Fieldbus B VLT® Servo Toolbox host system
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  NOTICE

l The logical view only shows the connectivity from a high-level software perspective and does not reflect the actual physical

topology of the network.

6.16.4.3.2 Network Settings for Indirect Communication

Any network interface can be used to communicate through a PLC. A dedicated network interface is not required.

When establishing the communication through a PLC, the VLT® Servo Toolbox configures a routing table using the selected Network

Address Translation (NAT). Adding a route to the Windows routing table requires administrator privileges. Therefore, administrator

credentials may be requested when initializing the connection.

6.16.4.3.3 Enabling Indirect Communication

Carry out the following steps to enable indirect communication.

  NOTICE

When observing the network packets via Wireshark®, checksum offloading often causes confusion as the network packets to

be transmitted are handed over to Wireshark® before the checksums have been calculated. Wireshark® shows these empty

checksums as invalid, even though the packets contain valid checksums when they leave the network hardware later. Use 1 of

these 2 methods to avoid this checksum offloading problem:

l Turn off the checksum offloading in the network driver if possible.

l Turn off the checksum validation of the specific protocol in the Wireshark® preferences.

Disable IPv6 on the network interfaces used for communication on the PC:

1. Open the Network and Sharing Center.

2. Select Change adapter settings.

3. Right-click the network interface used for fieldbus communication and select Properties.

4. If the TCP/IPv6 is available for the network interface, disable it.

6.16.4.3.4 Additional Settings for Indirect Communication with EtherCAT®

Set the IP address of the EtherCAT® Master:

Procedure

1. Open the TwinCAT® System Manager.

2. Select [I/O-Configuration] → [I/O Devices] → [Device1 (EtherCAT®)] and check the IP-address in the Adapter tab. The IP address of

the PLCs network adapter may not be a link-local address (so not in the range of 169.254.0.1 to 169.254.255.254).

3. If necessary, change the IP address inside the IPv4 Protocol properties according to the given operating system. This can be

done on the controller locally or via Remote Desktop.

6.16.4.3.5 Activating the IP Routing in the EtherCAT® Master

The procedure described here may vary depending on the type of PLC and operating system installed.

Procedure

1. Open the TwinCAT® System Manager.

2. Click on Advanced Settings... via menu [I/O-Configuration] → [I/O Devices] → [Device1 (EtherCAT)] in the EtherCAT tab.

3. Select EoE Support in the Advanced Settings window.

4. Enable Connect to TCP/IP Stack in the Windows Network section.
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5. Enable IP Enable Router in the Windows IP Routing section.

6. Reboot the PLC for the changes to take effect.

6.16.4.3.6 Setting the IP Address of the EtherCAT® Slave

The procedure for setting the IP Address of the EtherCAT® slave is valid for:

l ISD 520/DSD 520 servo drives

l Power Supply Module (PSM 520)

l Servo Drive Module SDM 521/SDM 522

  NOTICE

l The last number of the IP address is the ID that is used in the VLT® Servo Toolbox to identify the device.

Procedure

1. Open the TwinCAT® System Manager.

2. Click Advanced Settings...  under [I/O-Configuration] → [I/O Devices] → [Device1 (EtherCAT)] → [[]Box 1 (VLT® Power Supply Module)

→ Drive 2 (VLT® Integrated Servo Drive ISD 520)] in the EtherCAT® tab.

3. Select [Mailbox] → [EoE] in the Advanced Settings window.

4. Enable Virtual Ethernet Port and enter a valid IP-address.

5. Each slave in the configuration requires an IP-address. This address is reassigned with every transition from INIT to Pre-

Operational state of the slave state machine. The IP communication of the slaves is deactivated per default.

6.16.4.3.7 Additional Settings for Indirect Communication with PROFINET®

Overview

Each PROFINET® device needs a device name and an IP address. The IP address and the device name are assigned by the I/O controller,

when the connection to the I/O device is established.

For the automatic detection of accessible nodes via a PG/PC interface with TCP/IP, connect the nodes to the same physical Ethernet

subnet as the PG/PC. If a node is located in a different physical Ethernet subnet, the IP address of the sought node can be specified.

To reach further nodes, accessible nodes provide the capability of adding IP addresses and subnets to the PG/PC interface. The new IP

addresses and subnets are then added to the Ethernet interface of the PG/PC.

  NOTICE

l If >1 Danfoss servo drive is used in the same PROFINET® network, each servo drive must have a different name and IP address.

l The last number of the IP address is the ID that is used in the VLT® Servo Toolbox software to identify the device.

  NOTICE

l IP addresses and subnets can also be added using PRONETA®.

Adding IP Addresses and Subnets

Procedure

1. Open SIMOTION SCOUT®.

2. Select the menu [Project] → [Accessible nodes].

3. If accessible nodes are found in another subnet, the Add IP addresses/subnet masks window is shown, listing those nodes.
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Figure 90: Accessible Nodes

4. To accept the addresses, click Yes.

5. The IP address/subnet mask is now added.

Ü 

  NOTICE

l When the Accessible nodes tab is closed, the addresses are retained. The newly added addresses are only discarded when

SIMOTION SCOUT® is closed.

6.16.4.4 Direct Communication

6.16.4.4.1 Overview

For Ethernet-based fieldbus communication (direct communication), the VLT® Servo Toolbox must use a dedicated network interface on

the VLT® Servo Toolbox host system. Do not use this network interface simultaneously for any other communication.
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Figure 91: Logical View of Direct Ethernet-based Fieldbus Communication
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A Ethernet-based fieldbus communication B VLT® Servo Toolbox host system

  NOTICE

l The logical view only shows the connectivity from a high-level software perspective and does not reflect the actual physical

topology of the network.

6.16.4.4.2 Network Settings for Direct Communication with Ethernet POWERLINK®

Disable all network protocols except TCP/IPv4 on the network interface used for direct Ethernet POWERLINK® communication. This

prevents other PC software or the operating system using this network interface for other tasks, such as file and printer sharing and

network discovery. Disabling these protocols reduces the number of non-relevant packets sent over the network interface and thus

reduces the overall network load.

6.16.4.4.3 Disabling Unused Protocols on the Network Interface on the PC

Procedure

1. Open the Network and Sharing Center.

2. On the left, click on Change adapter settings.

3. Right-click the network interface used for fieldbus communication and select Properties.

4. Uncheck all checkboxes except the one for Internet Protocol Version 4 (TCP/IPv4).

5. Disable the IPv4 Checksum offload on the network interfaces as described in 6.16.4.3.3 Enabling Indirect Communication.
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Figure 92: Disabling Unused Protocols on the Network Interface

6.16.4.4.4 Setting the Correct Ethernet POWERLINK® Master IP Address

Procedure

1. Open the Network and Sharing Center.

2. On the left, click on Change adapter settings.
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3. Right-click the network interface used for fieldbus communication and select Properties.

4. Click Internet Protocol Version 4 (TCP/IPv4) (the checkbox must be checked) and then click Properties.

5. Select Use the following IP address and use 192.168.100.240 as the IP address and 255.255.255.0 as the subnet mask. Leave all

other fields empty.
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Figure 93: Internet Protocol Version 4 (TCP/IPv4) Properties

6.16.4.4.5 Network Settings for Direct Communication with EtherCAT®

Disable all network protocols except TCP/IPv4 on the network interface used for direct EtherCAT® communication. This prevents other

PC software or the operating system using this network interface for other tasks, such as file and printer sharing and network discovery.

Disabling these protocols reduces the number of non-relevant packets sent over the network interface and thus reduces the overall

network load.

6.16.5 VLT® Servo Toolbox Commissioning

6.16.5.1 Step 1: Opening the Main Window

The Main Window is the basis for all VLT® Servo Toolbox functionalities. It consists of the following components:
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Figure 94: Main Window

Table 35: Main Window Description

Legend number Name Description

1 Menu bar Contains the general functionalities for saving and loading projects, managing connections,
showing and changing settings, managing open subtools, and showing help contents.

2 Tool bar Contains shortcuts for saving and loading projects, connecting to and disconnecting from net-
works, automatic searching for online devices, and manually adding devices.

Online status and
state information

Online devices are indicated by a glowing light bulb next to the device ID.

l An online device is a logical device for which a physical device exists that the VLT® Servo
Toolbox is connected to.

l The color indicates the state of the device and is device-specific.

3

Offline status and
state information

Offline devices are indicated by a gray light bulb next to the device ID.

l An offline device is a logical device without a corresponding physical device. An offline
device can represent a saved device configuration or state, for example for offline analysis
or troubleshooting. It also contains pre-configured parameter values to be written to a
physical device.

4 Subtools A subtool is opened by double-clicking its name in the Device Environment, or by selecting the
entry and pressing the Enter key on the keyboard.
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Table 35: Main Window Description - (continued)

Legend number Name Description

5 Device environ-
ment

The Device Environment section of the Main Window lists all logical devices managed by the
VLT® Servo Toolbox, visualizes their states, and serves as the user interface for accessing the de-
vice functionalities.

The Device Environment window lists all available subtools for each added device.

See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®FlexMotion™) Programming Guide
for further information on the subtools.

6 Workspace This is the space for hosting the subtools and its size depends on the Main Window size. The
subtools can be maximized, minimized, horizontally or vertically aligned, or cascaded.

7 Watchlist win-
dow

Evaluates the parameter values of 1 or more devices by cyclically reading them from the de-
vices. Allows parameter values to be logged and saved to a text file. It is also possible to modify/
write values in the watchlist.

8 Output window Shows operating information, warnings, and errors. Depending on the user settings, shows
messages of up to 3 different logging levels (high, medium, and low). Used for showing ad-
vanced error and warning information.

9 Status strip Shows the communication state of the VLT® Servo Toolbox. If connected to a network, it shows
the used hardware interface (for example, network adapter) and the network name.

6.16.5.2 Step 2: Connecting to Network

Pre-configure the appropriate communication settings to connect to a network (see 6.16.4.1 Overview).

Procedure

1. In the Main Window toolbar, click on the Connect to bus icon to open the Connect to Network window.

2. Select the fieldbus type and the network interface to connect to.

3. Click on OK to connect.

4. Verify that the connection is successful by checking the status strip at the bottom of the Main Window.
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Figure 95: Connect to Network Window (Ethernet POWERLINK®)

6.16.5.3 Step 3: Scanning for Devices

Procedure

1. After verifying that the VLT®Servo Toolbox is connected to the selected network, click the Scan for Devices icon in the toolbar to

trigger the device scan procedure.
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  NOTICE

l If connected to an Ethernet POWERLINK® network in cyclic mode, select the scan range (minimum and maximum IDs) in the

next window to reduce the time needed for scanning. In all other cases, the complete ID range is scanned.

2. When the scan is complete, a list of available devices is shown in the Select Devices window. Select the devices to be added to

the Device Environment and click on OK.

3. All selected devices appear in the Device Environment window and automatically go online (indicated by a glowing light bulb

next to each device name).

6.17 Motion Library

6.17.1 Simple Programming Template

TwinCAT®

A basic sample PLC application for starting up the servo system with 1 Power Supply Module (PSM 520), and 2 axes is provided. The

project DDS_ServoMotion_SampleProject can be downloaded from the Danfoss website (http://drives.danfoss.com).

Automation Studio™

Detailed information on how to open the sample project within the ISD package in Automation Studio™ can be found in the Automation

Studio™ Help. Open the B&R Help Explorer and go to [Programming] → [Examples] → [Adding sample programs] and follow the

instructions for library samples.

PROFINET®

The project DDS_ServoMotion_SampleProject is a basic sample PLC (C240PN) application for starting up the servo system with 1 Power

Supply Module (PSM 520), and 2 axes.

6.17.2 Function Blocks

The PLC library provides function blocks that support the functionality of the servo system and comply with this standard: PLCopen®

Technical Specification Function blocks for motion control (Formerly Part 1 and Part 2) Version 2.0 March 17, 2011.

In addition to the PLCopen® functionality, Danfoss offers further functions for the servo system.

The following PLCopen® characteristics apply to all function blocks:

l Commanding (using the inputs)

l Signaling (behavior of the outputs)

l General calling conventions

  NOTICE

l See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®FlexMotion™) Programming Guide for

further information on the available function blocks and their behavior.
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7 Operation

7.1 Operating Modes

7.1.1 Supported Operating Modes

The servo drive implements several modes of operation. The behavior of the servo drive depends on the activated mode of operation. It

is possible to switch between the modes while the servo drive is enabled.

The supported modes of operation are according to CANopen® CiA DS 402 and there are also ISD-specific modes of operation.

All supported modes of operation are available for:

l EtherCAT®

l Ethernet POWERLINK®

l PROFINET®

The various modes of operation are described in detail in the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™)

Programming Guide.

Table 36: Operating Modes

Mode Description

Inertia measurement mode This mode measures the inertia of an axis. It is used to measure the inertia of the servo
drive and the external load, and to optimize the control loop settings. The friction effects
are eliminated automatically.

Profile velocity mode In profile velocity mode, the servo drive is operated under velocity control and executes
a movement with constant speed. Additional parameters, such as acceleration and decel-
eration, can be parameterized.

Profile position mode In profile position mode, the servo drive is operated under position control and executes
absolute and relative movements. Additional parameters, such as velocity, acceleration,
and deceleration, can be parameterized.

Profile torque mode In profile torque mode, the servo drive is operated under torque control and executes a
movement with constant torque. Linear ramps are used. Additional parameters, such as
torque ramp and maximum velocity, can be parameterized.

Homing mode In homing mode, the application reference position of the servo drive can be set. Several
homing methods, such as homing on actual position, homing on block, limit switch, or
home switch are available.

CAM mode In CAM mode, the servo drive executes a synchronized movement based on a master
axis. The synchronization is done by a CAM profile that contains slave positions corre-
sponding to master positions. CAMs can be designed graphically with the Servo Toolbox
software, or can be parameterized via the PLC. An external encoder, virtual axis, or the po-
sition of another axis can provide the guide value. The different CAM profile types are de-
scribed in the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Pro-
gramming Guide.

Gear mode In gear mode, the servo drive executes a synchronized movement based on a master axis
by using a gear ratio between the master and the slave position. An external encoder, vir-
tual axis, or the position of another axis can provide the guide value.

Cyclic synchronous position mode In cyclic synchronous position mode, the trajectory generator of the position is located in
the control device, not in the servo drive.

Cyclic synchronous velocity mode In cyclic synchronous velocity mode, the trajectory generator of the velocity is located in
the control device, not in the servo drive.
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7.1.2 Motion Functions
Table 37: Motion Functions

Function Description

Digital CAM switch This functionality controls whether the digital output is enabled or disabled, depending
on the axis position. It performs a function comparable to switches on a motor shaft. For-
ward and backward movements of the axis position are allowed. On and off compensa-
tion and hysteresis can be parameterized.

Touch probe This functionality stores the position actual value after a rising or falling edge at the con-
figured digital input.

7.2 Status Indicators

7.2.1 Operating Status Indicators

The operating status of the system modules is indicated via the indicator lights (LEDs) on each module.

  NOTICE

l Status indicators are not reliable for safety functions. Only use them for general diagnostics during commissioning and

troubleshooting.

7.2.2 Operating Indicator Lights (LEDs) on PSM 520

e3
0b

n0
42

.1
0STATUS PSM

DEV
SVS ST
NET ST
AUX

LINK/ACT
X1
X2
X3

Figure 96: Operating Indicator Lights (LEDs) on PSM 520
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Table 38: Operating Indicator Lights (LEDs) on PSM 520

LED Color Flash status Description

On Device is in state Operation en-
abled.

Green

Flashing Device is in state Standby or
Power-up.

On Device is in state Fault or Fault
reaction active.

DEV

Red

Flashing Input mains is not applied.

On 24 V safety supply is applied.SVS ST Green

Off 24 V safety supply is not ap-
plied.

NET ST Green/red Fieldbus dependent Network status of the device
(see the corresponding fieldbus
standard).(1)

On Auxiliary voltage is present on
the output connector (on back-
link).

For PSM with DAM option: Aux-
iliary voltage is present on DAM
output.

Green

Off Auxiliary voltage is not present
on the output connector (on
backlink).

For PSM with DAM option: Aux-
iliary voltage is not present on
DAM output.

AUX (distinguish between with
and without DAM option)

Red On Auxiliary voltage is out of limits
due to an HW error (UAUX sup-
ply fault (HW) on DAM option
board).

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X1

(Link/activity status of In)

Green

Off No link.

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X2

(Link/activity status of Out)

Green

Off No link.

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X3

(Link/activity status of Out)

Green

Off No link.

1) POWERLINK® and EtherCAT®: Refer to the corresponding fieldbus standard. For PROFINET®: Green = communication with master established; Orange = device is online and can be

reached via the network; Blinking red = communication initialization is completed; Solid red = communication error.
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7.2.3 Operating Indicator Lights (LEDs) on SDM 521 and SDM 522
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Figure 97: Operating Indicator Lights (LEDs) on SDM 521 and SDM 522

Table 39: Operating Indicator Lights (LEDs) on SDM 521 and SDM 522

LED Color Flash status Description

On Device is in state Operation en-
abled.

Green

Flashing Auxiliary voltage is applied.

On Device is in state Fault or Fault
reaction active.

DEV

Red

Flashing DC link is not applied.

On 24 V safety supply is applied.SVS ST Green

Off 24 V safety supply is not ap-
plied.

NET ST Green/red Fieldbus dependent Network status of the device
(see corresponding fieldbus
standard).(1)

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X1

(Link/activity status of In)

Green

Off No link.

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X2

(Link/activity status of Out)

Green

Off No link.

1) POWERLINK® and EtherCAT®: Refer to the corresponding fieldbus standard. For PROFINET®: Green = communication with master established; Orange = device is online and can be

reached via the network; Blinking red = communication initialization is completed; Solid red = communication error.
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8 Functional Safety Concept

8.1 Functional Description
The servo system integrates the safety function Safe Torque Off (STO). The safety function is available in daisy-chain format, which is

possible between all system components (cables are not included). The hybrid cable passes the STO signal from the Power Supply

Module (PSM 520) with integrated DAM option to all ISD 520/DSD 520 servo drives in the chain. Once STO is activated (safe state), no

torque is generated on the ISD 520 servo drives, or on any motors connected to DSD 520 or SDM 521/SDM 522. Reset of the safety

function and diagnostics can be carried out via the PLC.

  NOTICE

l Use STO shielded wiring.

l Use the STO function when performing mechanical work on the servo system or affected area of a machine to avoid a

mechanical hazard. However, the STO function does not provide electrical safety.

  NOTICE

l SDM 521/SDM 522 and ISD 520/DSD 520 can also be ordered with the VLT® FlexSafety™option,

implementing advanced functional safety. See the Advanced Functional Safety for VLT® FlexMotion™

Operating Guide for the available safety functions and related safety capability.

l For VLT® FlexSafety™, the HMI of the device requires a password to inhibit unauthorized access.

8.2 Safety Precautions

  WARNING

UNCONTROLLED MOVEMENT

External forces on the motor could cause an uncontrolled and hazardous movement that could result in death or serious injury.

l Equip the motor with additional measures to prevent uncontrolled and hazardous movement, for example, mechanical

brakes.

  WARNING

RISK OF ELECTRIC SHOCK

The STO function does not isolate mains voltage to the servo system or auxiliary circuits. Failure to isolate the

mains voltage supply and wait for the specified discharge time to elapse could result in death or serious injury.

l Only perform work on electrical parts of the system components, after isolating the mains voltage supply

and waiting for the discharge time to elapse.

  WARNING

RISK OF RESIDUAL ROTATION

Due to failures in the power semiconductor of the drive, a residual rotation can result from a fault that could result in death or

serious injury. The rotation can be calculated to angle = 360°/(number of poles).

l Take this residual rotation into consideration and ensure that it does not pose a safety risk.
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  WARNING

INDICATOR LIGHT (LED) STATUS RELIABILITY

Status indicator lights (LEDs) are not reliable for safety functions.

l Only use status indicator lights for general diagnostics during commissioning and troubleshooting.

  NOTICE

l After installing the STO function, perform a commissioning test. A passed commissioning test is

mandatory after initial installation and after each change to the safety installation (see 8.9 Commissioning

Test).

l For advanced functional safety, perform a commissioning test to validate the safety functions and their

safety properties for the whole system. See the Advanced Functional Safety for VLT® FlexMotion™ Operating

Guide.

  NOTICE

l If required, implement a manual reset function according to EN ISO 13849-1. For automatic restart without manual reset,

observe the requirements detailed in paragraph 6.3.3.2.5 of EN ISO 12100:2010 or equivalent standard.

  NOTICE

l Carry out a risk assessment to select the correct stop category for each stop function in accordance with EN 60204-1.

l When designing the machine application, consider the timing and distance for the coast to stop (Stop Category 0 or STO). See

EN 60204-1 for further information.

l All signals connected to the STO must be supplied by a PELV supply.

8.3 Qualified Personnel for Working with Functional Safety
The STO function can only be installed, programmed, commissioned, maintained, and decommissioned by qualified personnel. Qualified

personnel for the functional safety concept are qualified electrical engineers, or persons who have received training from qualified

electrical engineers and are suitably experienced to operate devices, systems, plant, and machinery in accordance with the general

standards and guidelines for safety technology.

Furthermore, they must:

l Be familiar with the basic regulations concerning health and safety/accident prevention.

l Have read and understood the safety guidelines given in this guide.

l Have a good knowledge of the generic and specialist standards applicable to the specific application.

Users of power drive systems (safety-related) (PDS(SR)) are responsible for:

l Hazard and risk analysis of the application.

l The overall safety of the application.

l Identifying safety functions required and allocating SIL or PL to each of the functions, other subsystems, and the validity of signals

and commands from them.

l Designing appropriate safety-related control systems, such as hardware, software, and parameterization.

8.4 Applied Standards and Compliance
Use of the STO function requires that all provisions for safety, including relevant laws, regulations, and guidelines, are satisfied.
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The integrated STO function complies with the following standards:

l IEC 61508-1 to 2: 2010 SIL 2

l EN 61508-1 to 2: 2010 SIL 2

l IEC 61800-5-2: 2016 SIL 2

l EN 61800-5-2: 2017 SIL 2

l EN ISO 13849-1: 2023, PL d, Cat. 3

l EN ISO 13849-2: 2012, PL d, Cat. 3

The SDM 521/SDM 522 can be used in the application area of EN IEC 62061:2021 and where Stop Category 0 (uncontrolled stop),

according to IEC 60204-1:2016 or EN 60204-1:2018, is needed.

8.5 Abbreviations and Conventions
Table 40: Safety-related Abbreviations and Conventions

Abbreviation Reference Description

Cat. EN ISO 13849-1 Category B, 1–4

DC – Diagnostic coverage

FIT – Failure in time

Failure rate: 1E-9/hour

HFT EN IEC 61508 Hardware fault tolerance

HFT = n means that n + 1 faults may lead to
a loss of the safety function.

MTTFD EN ISO 13849-1 Mean time to failure – dangerous

Unit: years

PFH EN IEC 61508 Probability of dangerous failures per hour

Take this value into account if the safety de-
vice is operated in high demand mode or in
continuous operating mode, where the fre-
quency of demands for operation made on
a safety-related system occurs more than
once per year.

PL EN ISO 13849-1 Performance level

A discrete level, used to specify the capa-
bility of safety-related parts of a system to
perform safety-oriented functions under
foreseeable conditions. Levels: a–e.

SFF EN IEC 61508 Safe failure fraction [%]

Proportion of safe failures and detected
dangerous failures of a safety function or a
subsystem as a percentage of all possible
failures.

SIL EN IEC 61508 Safety integrity level

STO EN IEC 61800-5-2 Safe torque off
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8.6 Installation
Only Danfoss cables can be used for the installation of the servo system, however, cables from other suppliers can be used for the user

connection to the STO terminal.

Safety relays that have a plus and minus switching output signal can be directly connected to the servo system to activate STO.

The example in Figure 98 shows the basic connection to be made for the STO function. A suitable safety device to switch it off is not

supplied by Danfoss. The STO is activated by opening STO+ and STO-.

A suitable safety device to switch it off is not supplied by Danfoss. The STO is activated by opening STO+ and STO–.

Table 41: Activation of STO Function

STO+ STO– STO function

24 V GND STO deactivated

Open Open STO activated

  CAUTION

STO VOLTAGE/TIME LIMITS

Failure to comply with the voltage limits specified for the STO input or with the specified transition time, could lead to permanent

damage to the drive, due to the direct control over the power stage.

l Ensure that no voltage outside the following limits is provided to the STO input.

STO active: within -3 V to 3 V

STO not active: 24 V ± 10%

l Ensure that the transition from STO deactivated to STO activated (and conversely) is executed within 1 ms in either direction.

  NOTICE

l STO is activated if the plus input is between –3 V and +3 V.

l STO is deactivated if the plus input is between +21.6 V and +26.4 V.

Signals with test pulses must not have test pulses of >2 ms. Longer pulses may lead to reduced availability of the servo system.

8.7 Protective Measures

  NOTICE

l Install the system modules in a cabinet that is rated at least IP54 as per IEC 60529 or in an equivalent environment. A higher IP

protection may be necessary for certain applications.

l If external influences can affect the motor axis, for example, suspended loads, use additional measures, such as a safety

holding brake, to eliminate hazards.

8.8 Application Example
An example of an application that can be put in safe torque off (STO) mode by a safety circuit is shown in Figure 98.

Select the safety switch devices in accordance with the requirements of the application.
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Figure 98: Application Example: Safe Torque Off Function

1 24 V DC supply 2 Safety device

3 Emergency stop button 4 Safety device contacts

5 PSM 520 with integrated DAM option 6 Feed-in cable

7 Loop cable 8 Servo drive

8.9 Commissioning Test

  NOTICE

l Perform a commissioning test according to standard EN/ISO 13849-1 for the whole servo system. Perform the test after

installation of the STO function, after every change to the installed function, or after a safety fault.

There are 2 ways to implement the commissioning test depending on the method used to program the PLC, however, the steps of the

test are the same:

l Using the Danfoss Library or the TwinCAT® Library.

l Bit-wise readout of the status.

8.9.1 Commissioning Test Methods

8.9.1.1 Commissioning Test using Libraries

Depending on the application, 1 or both of the following libraries are required to program the commissioning test:

l Danfoss Library

¢ MC_ReadAxisInfo_DDS

¢ MC_ReadStatus_DDS

¢ MC_ReadAxisError_DDS

¢ MC_Reset_DDS

l TwinCAT® Library

¢ MC_ReadStatus

¢ MC_ReadAxisError

¢ MC_Reset
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Table 42: Commissioning Test using Libraries

Test steps Reason for the test step Expected result for Danfoss
library

Expected result for TwinCAT®
library

1 Run the application (all the
servo drives are enabled).

Check that the application can
run.

Application runs as expected. Application runs as expected.

2 Stop the application. – All servo drives are at speed 0
RPM.

All servo drives are at speed 0
RPM.

3 Disable all the servo drives. – All servo drives are disabled. All servo drives are disabled.

4 Enable STO. Check that STO can be acti-
vated without error.

MC_ReadAxisInfo_DDS out-
put SafeTorqueOff = True for
all servo drives on the corre-
sponding line.

–

5 Disable STO. Check that STO can be deacti-
vated without error. No reset
is required.

MC_ReadAxisInfo_DDS out-
put SafeTorqueOff = False for
all servo drives on the corre-
sponding line.

–

6 Run the application (all the
servo drives are enabled).

– Application runs as expected. Application runs as expected.

7 Enable STO. Check that errors are gener-
ated correctly when STO is ac-
tivated while the servo drives
are running.

Motors are torque free. Mo-
tors coast and stop after some
time.

MC_ReadAxisInfo_DDS output
SafeTorqueOff = True

and

MC_ReadStatus_DDS output
ErrorStop = True

and

MC_ReadAxisError_DDS out-
put AxisErrorID = 0xFF80 on all
enabled servo drives.

Motors are torque free. Mo-
tors coast and stop after some
time.

For enabled motors:

MC_ReadAxisInfo_DDS output
SafeTorqueOff = True

and

MC_ReadStatus output ErrorS-
top = True

and

MC_ReadAxisError output Axis-
ErrorID = 0xFF80 on all en-
abled servo drives.

8 Try to run the application (en-
able 1 or more servo drives).

Checks that the STO function
is working correctly.

Application does not run. Application does not run.

9 Disable STO. Check that the STO start is still
inhibited by the error signal.

MC_ReadAxisInfo_DDS output
SafeTorqueOff = False

and

MC_ReadStatus_DDS output
ErrorStop = True

MC_ReadStatus output ErrorS-
top = True

10 Try to run the application (en-
able 1 or more servo drives).

Check whether reset is re-
quired.

Application does not run. Application does not run.
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Table 42: Commissioning Test using Libraries - (continued)

Test steps Reason for the test step Expected result for Danfoss
library

Expected result for TwinCAT®
library

11 Send a reset signal via
MC_Reset(_DDS).

– MC_ReadAxisInfo_DDS output
SafeTorqueOff = False

and

MC_ReadStatus_DDS output
ErrorStop = False

MC_ReadStatus output ErrorS-
top = False

12 Try to run the application (all
servo drives are enabled).

– Application runs as expected. Application runs as expected.

8.9.1.2 Commissioning Test using PROFINET® Devices

Table 43: Commissioning Test using PROFINET® Devices

Test steps Reason for the test step Expected result

1 Run the application (all the servo drives
are enabled).

Check that the application can run. Application runs as expected.

2 Stop the application. – All servo drives are at speed 0 RPM.

3 Disable all the servo drives. – All servo drives are disabled.

4 Enable STO. Check that STO can be activated without
error.

No errors are present. The successful
STO activation can be checked on the in-
dicator lights (LEDs) on the devices.

5 Disable STO. Check that STO can be deactivated with-
out error. No reset is required.

No errors are present. The STO status can
be checked on the indicator lights (LEDs)
on the devices.

6 Run the application (all the servo drives
are enabled).

– Application runs as expected.

7 Enable STO. Check that errors are generated cor-
rectly when STO is activated while the
servo drives are running.

Motors are torque free. Motors coast and
stop after some time.

Error 0x11E is shown in object 0x603F on
all servo drives.

8 Try to run the application (enable 1 or
more servo drives).

Checks that the STO function is working
correctly.

Application does not run.

9 Disable STO. Check that the STO start is still inhibited
by the error signal.

Error 0x11E is shown in object 0x603F on
all servo drives.

10 Try to run the application (enable 1 or
more servo drives).

Check whether a reset is required. Application does not run.

11 Send a reset signal via the PLC. – STO error 0x11E is cleared in all servo
drives.

12 Try to run the application (all servo dri-
ves are enabled).

– Application runs as expected.
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8.10 STO Function

8.10.1 Operation of the STO Function

The STO function does not require any parameterization and is always enabled.

The servo drive modules (SDM 521/SDM 522) provide STO status signals via the fieldbus.

All signals transmitted via the fieldbus are not part of the safety function and can only be used for operational purposes.

See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Programming Guide for:

l General information on how to access and map data objects.

l Information on a library provided to simplify the use of the fieldbus functions.

If the servo drive is enabled and STO is activated, an error code is issued.

If the drive is not enabled and STO is activated, it is not necessary to reset any STO error. It is sufficient to reapply the supply voltage to

the STO terminals, before enabling the drive.

8.10.2 Error Codes

If bit 3 of the status word is set, this indicates any faults that occur on the servo drive. If the fault occurred because of the STO circuit, the

cause of the fault can be found in object 0x603F.

Table 44: Error Codes

Error code PROFINET® error code Classification Description Reset

0xFF80 0x11E Fault STO activated while the servo
drive was enabled, or an at-
tempt to enable the servo drive
was made while STO was acti-
vated.

Reset via the PLC.

0xFF81 0x11F Safety fault Servo drive internal diagnostic
fault.

Carry out a power cycle.

0xFF85 0x120 Safety fault The internal STO supply on the
power card is not within limits.

Carry out a power cycle.

Error code 0xFF80/0x11E can be a normal status of the application. In this case, the servo drive requires a reset signal from the PLC. To

use the STO function in an application that requires a control guard (see ISO 12100 for details), the PLC can automatically provide this

reset information. All servo drives on the same line show this fault at the same time. Carry out a check on the PLC to compare the fault of

all servo drives on 1 line.

Error code 0xFF81/0x11F means that there is a fault on the servo drive that can only be reset by carrying out a power cycle. Complete

the commissioning test after the power cycle. Operation of the servo system can only be resumed if the test is completed successfully. If

error code 0xFF81/0x11F or 0xFF85/0x120 is issued again, contact Danfoss Service.

8.10.3 Fault Reset

To reset faults, change bit 7 of the control word from 0 to 1. See the VLT®Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™)

Programming Guide for further information.
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8.11 Functional Safety Characteristic Data
Table 45: Functional Safety Characteristic Data

Data PSM 520 SDM 521 SDM 522

General information

Response time (1) <100 ms

Lifetime 20 years

Data for EN/ISO 13849-1

Performance level (PL) – d d

Category – 3 3

Mean time to dangerous failure (MTTFD) – >100 years >100 years(2)

Diagnostic coverage (DC) – Low Low

Data for EN/ISO 61508

Safety integrity level (SIL) – 2 2

Probability of failure per hour (PFH) 0 /h <4 x 10-9/h <4 x 10-9/h

Subsystem classification Type A

Diagnostic test interval 1 year

1) From switching on the input, until torque generation is disabled.

2) For each axis.

  NOTICE

l The PSM 520 does not contribute to the dangerous failure rate of the system and can therefore be excluded from safety-

related calculations.

l Compliance to the claimed SIL and PL is only possible if the diagnostic test is executed once per year.

8.12 Diagnostic Test
Test the STO safety function at least once per year as follows:

1. Check that the motor shaft is not blocked by the application and can run freely.

2. Start the motor.

3. Activate STO by removing the STO input voltage, see 8.6 Installation.

4. Verify that the motor stops running.

5. Verify that the STO error is logged. See the toolbox history for details.
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9 Diagnostics

9.1 Faults
If faults occur during operation, check:

l The indicator lights (LEDs) on the servo drives, servo drive modules SDM 521/SDM 522 for general problems relating to

communication or device status.

l The indicator lights (LEDs) on the PSM 520 for general problems with communication, auxiliary supply, or STO voltage.

l The error codes.

The error codes can be read using the VLT® Servo Toolbox software, the LCP, or the PLC. The LCP only shows faults relating to the device it

is connected to.

  NOTICE

l If the fault cannot be eliminated by 1 of the measures listed in the troubleshooting tables, notify Danfoss Service.

Have the following information available to enable Danfoss to provide help quickly and effectively:

l Type number

l Error code

l Firmware version

l System setup (for example, number and type of system components).

l System status when the fault occurred.

l Ambient conditions.

9.2 Troubleshooting

9.2.1 Troubleshooting for the Servo Drive Modules SDM 521/SDM 522

9.2.1.1 Drive not Running/Starting Slowly

Possible cause

l Bearing wear.

l Incorrect parameter settings.

l Incorrect control loop parameters.

l Incorrect torque settings.

Troubleshooting

l Check the bearings and the shaft.

l Check the parameter settings.

9.2.1.2 Drive Hums and Draws High Current

Possible cause

l Drive defective.

Troubleshooting

l Contact Danfoss.
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9.2.1.3 Drive Stops Suddenly and Restart is not Possible

Possible cause

l No drive communication.

l Drive in error mode.

Troubleshooting

l Check the fieldbus connection and the indicator lights (LEDs) on the drive.

9.2.1.4 Motor Rotating in Wrong Direction

Possible cause

l Mirror mode activated.

Troubleshooting

l Check the parameter settings.

9.2.1.5 Motor not Generating Expected Torque

Possible cause

l Drive defective.

l Parameter error.

Troubleshooting

l Check the parameter settings.

l Contact Danfoss.

9.2.1.6 Drive Screaming

Possible cause

l Incorrect calibration.

l Faulty current measurement.

l Incorrect control loop parameters.

Troubleshooting

l Check the parameter settings.

l Contact Danfoss.

9.2.1.7 Uneven Running

Possible cause

l Defective bearing.

Troubleshooting

l Check the shaft.

9.2.1.8 Vibration

Possible cause

l Defective bearing.

l Incorrect control loop parameters.

Troubleshooting

l Check the shaft.

144  < AQ448939736224en-010101 < 130R1343                                                                                                                                                                 Danfoss A/S © 2026.05

VLT® Multiaxis Servo Drive MSD 520 > Operating Guide > Diagnostics



Danfoss A/S © 2026.05                                                                                                                                                                 AQ448939736224en-010101 > 130R1343 >  145

l Check the parameter settings.

9.2.1.9 Unusual Running Noises

Possible cause

l Defective bearing.

l Defects on connected mechanics.

l Incorrect control loop parameters.

Troubleshooting

l Check the shaft.

l Check for loose mechanical components on the connected mechanics.

l Check the parameter settings.

9.2.1.10 Drive Speed Drops Sharply under Load

Possible cause

l Drive is running at current limit.

l Drive is running with incorrect parameters.

l Speed control loop bandwidth is too low.

Troubleshooting

l Check the application.

l Check the parameter settings.

l Modify the speed control loop parameters.

9.2.1.11 Brake not Releasing

Possible cause

l Defective brake control.

l Incorrect mechanical brake parameters.

Troubleshooting

l Check the parameter settings.

l Contact Danfoss.

9.2.1.12 Holding Brake not Holding the Servo Drive

Possible cause

l Mechanical brake defective.

l Shaft load exceeds the holding torque of the brake.

Troubleshooting

l Contact Danfoss.

9.2.1.13 Delayed Brake Engagement

Possible cause

l Software error.

Troubleshooting

l Contact Danfoss.
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9.2.1.14 Noises when Power-Off Brake is Engaged

Possible cause

l Mechanical brake damaged.

Troubleshooting

l Contact Danfoss.

9.2.1.15 Indicator Lights (LEDs) not Lighting Up

Possible cause

l No power supply.

Troubleshooting

l Check the power supply.

9.2.1.16 Drive Protection Trips Immediately

Possible cause

l Short circuit.

l Incorrect control loop parameters.

Troubleshooting

l Check the parameter settings.

l Check the wiring.

l Contact Danfoss.

9.2.2 Troubleshooting for the Servo System

9.2.2.1 LCP Display is Dark/Not Functioning

This fault applies to the ISD 520/DSD 520 servo drives, PSM 520.

Possible causes and troubleshooting

Table 46: Possible Causes and Troubleshooting

Possible cause Possible solution

Missing input power. Check the input power source.

Missing or open fuses, or circuit breaker tripped. Check the fuses and circuit breaker.

No power to the LCP. l Check the LCP cable for proper connection or damage.

l Replace any faulty LCP or connection cables.

Incorrect contrast setting. Press [Status] + [▲]/[▼] to adjust the contrast.

Display is defective. Replace the faulty LCP or connection cable.

9.2.2.2 Open Power Fuses or Circuit Breaker Trip

This fault applies to the PSM 520.

Possible causes

l Phase-to-phase short.

l Short on backlink.

l Short on SDM 521/SDM 522 output.
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l Short on hybrid cable.

l Short on EXM 520 connector or cable.

Troubleshooting

l Check the cabling.

l Check for loose connections.

9.2.2.3 DC-link Voltage Too High (Error 0x3210/0x103)

This fault applies to PSM 520.

Table 47: Possible Causes and Troubleshooting

Possible cause Possible solution Applies to:

Brake resistor not connected. Check the brake resistor cabling. PSM 520.

Brake resistor too high resistance. Check if the lowest resistance value has
been entered.

PSM 520.

Brake resistor functionality not activated. Activate the brake function. PSM 520.

Several servo drives are decelerating with
insufficient ramp time.

Avoid simultaneous deceleration of several
servo drives.

Change the deceleration speed.

PSM 520, ISD 520/DSD 520 servo drives,
SDM 521/SDM 522 servo drive modules.

Mains voltage out of range. Check the mains voltage and wiring. –

9.2.2.4 DC-link Voltage Too Low (Error 0x3220/0x104)

This fault applies to the PSM 520.

Possible cause

l Incorrect mains input supply.

Troubleshooting

l Check that the supply voltage matches the allowed specification.

9.2.2.5 Current Overload Trip (Error 0x2396/0x15C)

This fault applies to the PSM 520.

Possible causes

l The sum of the system modules' current exceeds the maximum rating of the PSM 520.

l Short on backlink.

Troubleshooting

l Check the servo drive current consumption.

l Avoid simultaneous acceleration of all servo drives.

l Decrease the acceleration value.

9.2.2.6 AUX Overcurrent (Error 0x2391/0x125)

This fault applies to the PSM 520.

Possible causes

l The servo drives are consuming more power on the UAUX line than allowed.
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Troubleshooting

l Check the number of attached servo drives with the shell diagrams in the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®

FlexMotion™) Design Guide.

l Avoid simultaneous lifting of the servo drive brakes.

9.2.2.7 AUX Overcurrent on DAM Option (Error 0x2392/0x17D)

This fault applies to the PSM 520.

Possible causes

l The servo drives are consuming more power on the UAUX line than allowed.

Troubleshooting

l Check the number of attached servo drives with the shell diagrams. Refer to the VLT® Servo Drive System ISD 520, DSD 520 Design

Guide.

l Avoid simultaneous lifting of the servo drive brakes.

9.2.2.8 AUX Overvoltage (Error 0x3292/0x133)

This fault applies to the PSM 520.

Possible causes

l Incorrect UAUX supply.

Troubleshooting

l Check that the supply matches the auxiliary supply requirements.

9.2.2.9 AUX Undervoltage (Error 0x3290/0x17C)

This fault applies to the PSM 520.

Possible causes

l Incorrect UAUX supply.

l Incorrect current dimensioning of the supply equipment.

Troubleshooting

l Check that the supply matches the auxiliary supply requirements.

l Check that the output power of the supply is sufficient.

9.2.2.10 Mains Phase Loss (Error 0x3130/0x12F)

This fault applies to the PSM 520.

Possible causes

l A phase is missing on the supply side.

l The voltage imbalance is too high.

Troubleshooting

l Check the supply voltages and supply currents to the device.

9.2.2.11 Mechanical Brake Failure (Error 0xFF01/0x112)

This fault applies to all servo drives.

Possible causes

l Faulty brake resistor.
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l Internal/external brake resistor not connected.

Troubleshooting

l Remove the power to the device, wait for the discharge time to elapse, then replace the brake resistor.

9.2.2.12 Brake Chopper Overcurrent (Error 0x7112/0x167)

This fault applies to the PSM 520.

Possible causes

l Faulty brake chopper.

l Brake chopper power exceeds the power cycle limit.

l Incorrect parameterization.

Troubleshooting

l Check the parameterization of the brake chopper.

l Check the brake chopper connection.

l Measure the resistance of the brake chopper and compare it with the parameter settings.

9.2.2.13 Grounding Fault (Error 0x2330/0x151)

This fault applies to all system components.

Possible causes

l Grounding fault.

l When 2 PSM 520 modules are mounted in parallel and the maximum delay time for power-up is exceeded (see 6.7 Power-up Time).

Troubleshooting

l Check for proper grounding and loose connections.

l Check the hybrid cables for short circuits or leakage currents.

l Check the EXM 520 connection and cable.

9.2.3 Error Codes

9.2.3.1 No error (0x0000 / 0x0)

This error code is valid for PSM 520, and SDM 521/SDM 522.

Table 48: No Error (0x0000 / 0x0)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x0000 0x0 No error Error No error. –

9.2.3.2 Generic application error (0x1000 / 0x100)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 49: Generic Err (0x1000 / 0x100)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x1000 0x100 Generic application
error

Error Generic application
error.

generic err
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9.2.3.3 Overcurrent Trip (0x2310 / 0x101)

This error is valid for SDM 521/SDM 522.

Table 50: Overcurr Out (0x2310 / 0x101)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2310 0x101 Overcurrent trip Error Overcurrent trip on
output.

overcurr trip

9.2.3.4 High cont. current overload (0x2311 / 0x15F)

This error is valid for PSM 520 and SDM 521/SDM 522.

Table 51: High Cont. Current Overload (0x2311 / 0x15F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2311 0x15F High cont. current
overload

Error High continuous
current overload er-
ror.

high curr ovld

9.2.3.5 Continuous current overload (0x2312 / 0x160)

This error is valid for PSM 520 and SDM 521/SDM 522.

Table 52: Continuous Current Overload (0x2312 / 0x160)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2312 0x160 Continuous current
overload

Error Continuous current
overload error.

cont curr ovld

9.2.3.6 Fuses and hybrid cable overload (0x2316 / 0x161)

This error is valid for PSM 520.

Table 53: Fuses and Hybrid Cable Overload

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2316 0x161 Fuse and hybrid ca-
ble overload

Warning Overload on fuses
and hybrid cable, re-
lated to DAM option
board.

fuses hybrid cable
ovld

9.2.3.7 Overcurrent short circuit (0x2320 / 0x163)

This error is valid for PSM 520.

Table 54: Overcurrent Short Circuit (0x2320 / 0x163)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2320 0x163 Overcurrent short
circuit

Trip lock Overcurrent short
circuit error.

over short
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9.2.3.8 Ground fault (0x2330 / 0x151)

This error is valid for all system components.

Table 55: Ground Fault (0x2330 / 0x151)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2330 0x151 Ground fault Warning, error Discharge from
output phases to
ground.

ground fault

9.2.3.9 Motor Overload Fault (0x2350 / 0x179)

This error is valid for SDM 521/SDM 522.

Table 56: Motor Overload Fault (0x2350 / 0x179)

Code PROFINET®code Name Severity (warning/
error/trip lock)

Description LCP name

0x2350 0x179 Motor Overload
Fault

Error Motor Overload
Fault (I2T thermal
state).

Motor Overload
Fault

9.2.3.10 Motor Overload Warning (0x2351 / 0x17A)

This error is valid for SDM 521/SDM 522.

Table 57: Motor Overload Warning (0x2351 / 0x17A)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2351 0x17A Motor Overload
Warning

Warning Motor Overload
Warning (I2T ther-
mal state).

Motor Overload
Warning

9.2.3.11 AUX overcurrent (0x2391 / 0x125)

This error is valid for PSM 520.

Table 58: AUX Overcurr (0x2391 / 0x125)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2391 0x125 AUX overcurrent Error Current on the AUX
line has reached the
overcurrent limit.

AUX overcurr

9.2.3.12 AUX overcurrent on DAM (0x2392/0x17D)

This error is valid for PSM 520.
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Table 59: AUX Overcurr (0x2392 / 0x17D)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2392 0x17D AUX overcurrent
DAM

Error Current on the AUX
line has reached the
overcurrent limit.

AUX overcurr DAM

9.2.3.13 AUX user limit current (0x2393 / 0x127)

This error is valid for PSM 520.

Table 60: AUX User Limit Current (0x2393 / 0x127)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2393 0x127 AUX user limit cur-
rent

Error Current on the AUX
line has reached the
user-defined limit
for fault.

AUX curr limit

9.2.3.14 AUX user limit current warning (0x2394 / 0x128)

This error is valid for PSM 520.

Table 61: AUX User Limit Current Warning (0x2394 / 0x128)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2394 0x128 AUX user limit cur-
rent warning

Warning Current on the AUX
line has reached the
user-defined limit
for warning.

AUX curr warn

9.2.3.15 AUX supply failure (0x2395 / 0x129)

This error is valid for PSM 520.

Table 62: AUX Supply Failure (0x2395 / 0x129)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2395 0x129 AUX supply failure Error AUX supply failure
indicated by hard-
ware circuit

AUX supply fail

9.2.3.16 Current overload trip (0x2396 / 0x15C)

This error is valid for PSM 520 and SDM 521/SDM 522.

Table 63: Current Overload Trip (0x2396 / 0x15C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2396 0x15C Current overload
trip

Error Current overload
trip error.

curr ovld trip
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9.2.3.17 Thermal overload motor (0x239B / 0x102)

This error is valid for SDM 521/SDM 522

Table 64: Thermal Overload Motor (0x239B / 0x102)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x239B 0x102 Thermal overload
motor

Warning, error Thermal overload
motor error.

therm ovld motor

9.2.3.18 DC short circuit (0x239C/0x16F)

This error is valid for SDM 521/522

Table 65: DC Short Circuit (0x239C/0x0x16F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x239C 0x16F Short circuit on DC-
link

Error Short circuit on DC-
link

DC short

9.2.3.19 Overcurrent motor (0x239D/0x170)

This error is valid for SDM 521/522

Table 66: Overcurrent Motor (0x239D/0x170)

Code PROFINET®code Name Severity (warning/
error/trip lock)

Description LCP name

0x239D 0x170 Overcurrent motor Error Motor overcurrent
fault with respect to
the threshold value
defined by object
0x2395.

overcurr motor

9.2.3.20 Mains phase loss (0x3130 / 0x12F)

This error is valid for PSM 520.

Table 67: Mains Phase Loss (0x3130 / 0x12F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3130 0x12F Mains phase loss Error Mains phase loss de-
tected.

This occurs when a
phase on mains is
missing, or when the
mains is imbalanced.

phase loss

9.2.3.21 Mains voltage outside limits (0x3131/0x17F)

This error is valid for PSM 520.
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Table 68: Mains Voltage Outside Limits (0x3131/0x17F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3131 0x17F Mains voltage out-
side limits

Error Mains voltage out-
side limits. This fault
is triggered if the
mains voltage devi-
ates too much from
the configured value
in object 0x203E.

Mains out limit

9.2.3.22 DC link overvoltage (0x3210 / 0x103)

This error is valid for PSM 520.

Table 69: DC Link Overvoltage (0x3210 / 0x103)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3210 0x103 DC link overvoltage Error DC-link voltage ex-
ceeds limit.

UDC overvolt

9.2.3.23 DC link undervoltage (0x3220 / 0x104)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 70: DC Link Undervoltage (0x3220 / 0x104)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3220 0x104 DC link undervolt-
age

Error DC-link voltage be-
low limit in Opera-
tion enabled state.

UDC undervolt

9.2.3.24 DC link charging error (0x3230 / 0x152)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 71: DC Link Charging Error (0x3230 / 0x152)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3230 0x152 DC link charging er-
ror

Error The maximum time
limit to charge the
DC link has been ex-
ceeded.

UDC charging

9.2.3.25 DC Link unbalanced (0x3280 / 0x153)

This error is valid for PSM 520, and SDM 521/SDM 522.
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Table 72: DC Link Unbalanced (0x3280 / 0x153)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3280 0x153 DC Link unbalanced Trip lock DC-link voltage is
unbalanced. This
fault indicates an in-
ternal malfunction
of the DC link.

UDC unbalance

9.2.3.26 UAUX undervoltage DAM Option (0x3290 / 0x17C)

This error is valid for PSM 520 with DAM option.

Table 73: UAUX Undervoltage DAM Option (0x3290 / 0x17C)

Code PROFINET®code Name Severity (warning/
error/trip lock)

Description LCP name

0x3290 0x17C UAUXundervoltage Error UAUX below under-
voltage limit.

UAUX undervolt
DAM

9.2.3.27 UAUX high voltage (0x3291 / 0x132)

This error is valid for PSM 520.

Table 74: UAUX High Voltage (0x3291 / 0x132)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3291 0x132 UAUX high voltage Warning UAUX above warning
limit.

UAUX high volt

9.2.3.28 UAUX overvoltage (0x3292 / 0x133)

This error is valid for PSM 520.

Table 75: UAUX Overvoltage (0x3292 / 0x133)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3292 0x133 UAUX overvoltage Error UAUX above overvolt-
age limit.

UAUX overvolt

9.2.3.29 UAUX low voltage (0x3293 / 0x134)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 76: UAUX Low Voltage (0x3293 / 0x134)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3293 0x134 UAUX low voltage Warning UAUX below warning
limit.

UAUX low volt

9.2.3.30 DC link high voltage (0x3295 / 0x136)

This error is valid for PSM 520.
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Table 77: DC Link High Voltage (0x3295 / 0x136)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3295 0x136 DC link high voltage Warning The DC-link voltage
is higher than the
high-voltage warn-
ing limit.

UDC high volt

9.2.3.31 DC link low voltage (0x3296 / 0x137)

This error is valid for PSM 520.

Table 78: DC Link Low Voltage (0x3296 / 0x137)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3296 0x137 DC link low voltage Warning The DC-link voltage
is lower than the
low voltage warning
limit.

UDC low volt

9.2.3.32 UAUX charging error (0x3297 / 0x154)

This error is valid for PSM 520 with DAM option.

Table 79: UAUX Charging Error (0x3297 / 0x154)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3297 0x154 UAUX charging error Error Load error when
UAUX is charging. The
maximum time limit
to charge the AUX
line has been ex-
ceeded.

UAUX charg err

9.2.3.33 DC link shutdown error (0x3298 / 0x165)

This error is valid for PSM 520.

Table 80: DC Link Shutdown Error (0x3298 / 0x165)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3298 0x165 DC link shutdown
error

Error Error when UDC is in
shutdown phase.

UDC shutdwn err

9.2.3.34 UAUX undervoltage hardware (0x329A / 0x156)

This error is valid for PSM 520.
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Table 81: UAUX Undervoltage Hardware (0x329A / 0x156)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x329A 0x156 UAUX undervoltage
hardware

Error UAUX undervoltage
detected by hard-
ware circuit.

AUX undervol HW

9.2.3.35 Device overtemperature (0x4210 / 0x157)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 82: Device Overtemperature (0x4210 / 0x157)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4210 0x157 Device overtemper-
ature

Warning, error Triggered when the
maximum tempera-
ture of the main de-
vice component is
exceeded.

overtemp device

9.2.3.36 Device under temperature (0x4220 / 0x138)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 83: Device Under Temperature (0x4220 / 0x138)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4220 0x138 Device under tem-
perature

Error The device is too
cold to operate.

undertemp device

9.2.3.37 Overtemperature: Power module (0x4290 / 0x131)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 84: Overtemperature: Power Module (0x4290 / 0x105)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4290 0x131 Overtemperature:
Power module

Error Overtemperature on
power module.

overtemp PM

9.2.3.38 Overtemperature: Control card (0x4291 / 0x106)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 85: Overtemperature: Control Card (0x4291 / 0x106)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4291 0x106 Overtemperature:
Control card

Warning, error Maximum temper-
ature of the control
card exceeded.

overtemp CC
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9.2.3.39 Under temperature: Control card (0x4289 / 0x130)

This error is valid for PSM 520 and SDM 521/SDM 522.

Table 86: Under Temperature: Control Card (0x4289 / 0x130)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4289 0x130 Under temperature:
control card

Error Under temperature
on control card.

undertemp CC

9.2.3.40 Overtemperature: Power card (0x4292 / 0x107)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 87: Overtemperature: Power Card (0x4292 / 0x107)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4292 0x107 Overtemperature:
Power card

Warning, error Maximum tempera-
ture of power card
exceeded.

overtemp PC

9.2.3.41 Inrush overtemperature DC link (0x4293 / 013C)

This error is valid for PSM 520.

Table 88: Inrush Overtemperature DC Link (0x4293 / 0x13C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4293 0x13C Inrush overtempera-
ture: DC link

Error Inrush fault.

Too many transitions
into state Operation
enabled in a short
time period.

UDC inrush

9.2.3.42 Inrush overtemperature AUX line (0x4294 / 0x13D)

This error is valid for PSM 520.

Table 89: Inrush Overtemperature AUX Line (0x4294 / 0x13D)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4294 0x13D Inrush overtempera-
ture AUX line

Error Inrush fault.

Too many power-
ups of the AUX volt-
age have occurred
within a short time
period.

UAUX inrush

9.2.3.43 Overtemperature: Motor (0x4310 / 0x108)

This error is valid for SDM 521/SDM 522
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Table 90: Overtemperature: Motor (0x4310 / 0x108)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4310 0x108 Overtemperature:
Motor

Error Overtemperature on
motor.

overtemp motor

9.2.3.44 UAUX undervoltage (0x5112 / 0x109)

This error is valid for SDM 521/SDM 522.

Table 91: UAUX Undervoltage (0x5112 / 0x109)

Code PROFINET® code Name Severity (warning/
error/ trip lock)

Description LCP name

0x5112 0x109 UAUX undervoltage Error, trip lock Undervoltage on
auxiliary voltage.

undervolt UAUX

9.2.3.45 FlyBack overvoltage (0x5113 / 0x139)

This error is valid for SDM 521/SDM 522.

Table 92: FlyBack Overvoltage (0x5113 / 0x139)

Code PROFINET®code Name Severity (warning/
error/trip lock)

Description LCP name

0x5113 0x139 FlyBack Overvoltage Trip lock FLYBACK voltage
is higher than the
high-voltage limit

FLYBACK overvolt

9.2.3.46 Charge switch failure voltage (0x5121 /0x158)

This error is valid for PSM 520 and SDM 521/SDM 522.

Table 93: Charge Switch Failure Voltage (0x5121 / 0x158)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5121 0x158 Charge switch fail-
ure voltage

Trip lock Indicates a malfunc-
tion of the internal
charge circuit.

Chg switch fail

9.2.3.47 Failure on output phase U (0x5411 / 0x123)

This error is valid for SDM 521/SDM 522.

Table 94: Failure on Output Phase U (0x5411 / 0x123)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5411 0x123 Failure on output
phase U

Trip lock Current offset on
output phase U out-
side limit.

output phase U

9.2.3.48 Failure on output phase V (0x5412 / 0x124)

This error is valid for SDM 521/SDM 522.
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Table 95: Failure on Output Phase V (0x5412 / 0x124)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5412 0x124 Failure on output
phase V

Trip lock Current offset on
output phase V out-
side limit.

output phase V

9.2.3.49 Failure on output phase W (0x5413 / 0x125)

This error is valid for SDM 521/SDM 522.

Table 96: Failure on Output Phase W (0x5413 / 0x125)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5413 0x125 Failure on output
phase W

Trip lock Current offset on
output phase W out-
side limit.

output phase W

9.2.3.50 Fuse broken (0x5450 / 0x17E)

This error is valid for PSM 520.

Table 97: Fuse Broken (0x5450 / 0x17E)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5450 0x17E Fuse broken Error A broken DC-link
fuse has been de-
tected on the DAM
option board.

Fuse broken

9.2.3.51 EE Checksum Error (parameter missing) (0x5530 / 0x10A)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 98: EE Checksum Error (parameter missing) (0x5530 / 0x10A)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5530 0x10A EE Checksum Error
(parameter missing)

Trip lock EEPROM checksum
error or missing de-
vice parameter. Con-
tact Danfoss.

eeprom err

9.2.3.52 Parameter error (0x6320 / 0x10B)

This error is valid for PSM 520, and SDM 521/SDM 522.
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Table 99: Parameter Error (0x6320 / 0x10B)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6320 0x10B Invalid Parameter
Configuration

Trip lock Invalid configura-
tion. A restore of the
configuration is re-
quired then power
cycle or reset the de-
vice.

invalid conf

9.2.3.53 Parameter Configuration: Previous configuration restored (0x6321 / 0x171)

This error is valid for PSM 520, and SDM 521/SDM 522

Table 100: Parameter Configuration: Previous Configuration Restored (0x6321 / 0x171)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6321 0x171 Parameter Configu-
ration: Previous con-
figuration restored

Error The previous stored
configuration has
been reloaded be-
cause something
went wrong with
the latest configura-
tion.

prev config restored

9.2.3.54 Parameter configuration: Power cycle needed (0x6322 / 0x172)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 101: Parameter Configuration: Power Cycle Needed (0x6322 / 0x172)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6322 0x172 Parameter Configu-
ration: Power cycle
needed

Warning, error Power cycle or reset
is needed to apply
the new configura-
tion.

power cycle

9.2.3.55 Parameter Configuration: Wrong thermal sensor configuration (0x6323 / 0x173)

This error is valid for SDM 521/SDM 522.

Table 102: Parameter Configuration: Wrong Thermal Sensor Configuration (0x6323 / 0x173)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6323 0x173 Parameter Configu-
ration: Wrong ther-
mal sensor configu-
ration

Error Wrong configura-
tion of parameters
0x2350 and 0x2361.
At least 1 of them
must be set to no
sensor.

wrong thermal sens
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9.2.3.56 Conf par ver (0x6382 / 0x15D)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 103: Configuration Parameters Version Error (0x6382 / 0x15D)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6382 0x15D Configuration para-
meters version error

Trip lock Configuration pa-
rameter set version
mismatch: parame-
ter set is not valid for
this device.

Check the configura-
tion file sent to the
device and replace
it. If the error per-
sists, contact Dan-
foss.

conf par ver

9.2.3.57 Configuration parameters limits error (0x6383 / 0x164)

This error is valid for PSM 520.

Table 104: Configuration Parameters Limits Error (0x6383 / 0x164)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6383 0x164 Configuration para-
meters limits error

Trip lock ≥1 parameter in the
configuration para-
meter set is out of
limits.

conf par lim

9.2.3.58 Power EEprom configuration error (0x6384 / 0x166)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 105: Power EEprom Configuration Error (0x6384 / 0x166)

Code PROFINET®code Name Severity (warning/
error/trip lock)

Description LCP name

0x6384 0x166 Power EEprom con-
figuration error

Trip lock The power device
EEprom is corrupt or
incompatible with
this control board.
Contact Danfoss.

conf par EEPROM

9.2.3.59 Brake chopper failure (0x7111 / 0x141)

This error is valid for PSM 520.
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Table 106: Brake Chopper Failure (0x7111 / 0x141)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7111 0x141 Brake chopper fail-
ure

Warning, error The brake chopper
is monitored during
operation.

A brake failure has
been detected by
the brake check
function.

brake ch fail

9.2.3.60 Brake chopper overcurrent (0x7112 / 0x167)

This error is valid for PSM 520.

Table 107: Brake Chopper Overcurrent (0x7112 / 0x167)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7112 0x167 Brake chopper over-
current

Trip lock The brake chopper
current exceeds the
limit.

brake ch overcurr

9.2.3.61 Brake chopper module overload (0x7181 / 0x142)

This error is valid for PSM 520.

Table 108: Brake Resistor Maximum Power Limit (0x7181 / 0x142)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7181 0x142 Brake chopper mod-
ule overload

Warning, error The power load of
the brake chopper
is monitored during
operation. This error
appears when the
maximum power
limit of the brake
chopper module is
reached.

mod ovl

9.2.3.62 External brake chopper overload (0x7182 / 0x143)

This error is valid for PSM 520.
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Table 109: External Brake Chopper Overload (0x7182 / 0x143)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7182 0x143 External brake chop-
per overload

Warning, error The power load of
the brake chopper
is monitored during
operation.

Depending on the
configuration of ex-
ternal brake chop-
per power monitor-
ing this warning or
fault appears when
the configured nom-
inal external brake
chopper power is
reached.

ext brake ch ovl

9.2.3.63 Brake mains voltage too high (0x7183 / 0x159)

This error is valid for PSM 520.

Table 110: Brake Mains Voltage Too High (0x7183 / 0x159)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7183 0x159 Brake mains voltage
too high

Warning The mains voltage
is too high. Due to
this, the brake chop-
per could be acti-
vated continuously
depending on the
value entered in pa-
rameter brake chop-
per start level.

brake ch high volt

9.2.3.64 Internal position sensor error (0x7320 / 0x10C)

This error is valid for SDM 521/SDM 522.

Table 111: Internal Position Sensor Error (0x7320 / 0x10C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7320 0x10C Internal position
sensor error

Trip lock Absolute position
sensor error.

If the error persists,
contact Danfoss.

int sensor err

9.2.3.65 External position sensor error (0x7380 / 0x10D)

This error is valid for SDM 521/SDM 522.
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Table 112: External Position Sensor Error (0x7380 / 0x10D)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7380 0x10D External position
sensor error

Error External encoder
data could not be
read.

ext sensor err

9.2.3.66 Following error (0x8611 / 0x10E)

This error is valid for SDM 521/SDM 522.

Table 113: Following Error (0x8611 / 0x10E)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x8611 0x10E Following error Warning, error A following error has
occurred.

The error notifica-
tion feature can be
disabled via object
0x2055.

following err

9.2.3.67 Homing error on entering homing mode (0x8693 / 0x10F)

This error is valid for SDM 521/SDM 522.

Table 114: Homing Error on Entering Homing Mode (0x8693 / 0x10F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x8693 0x10F Homing error on en-
tering homing mode

Warning Could not enter
homing mode (for
example velocity
not 0).

Homing mode fail

9.2.3.68 Homing error on start homing method (0x8694 / 0x110)

This error is valid for SDM 521/SDM 522.

Table 115: Homing Error on Start Homing Method (0x8694 / 0x110)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x8694 0x110 Homing error
on start homing
method

Warning Could not start hom-
ing method (for ex-
ample, drive not in
standstill).

Homing method fail

9.2.3.69 Homing error distance (0x8695 / 0x111)

This error is valid for SDM 521/SDM 522.
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Table 116: Homing Error Distance (0x8695 / 0x111)

Code PROFINET®code Name Severity (warning/
error/trip lock)

Description LCP name

0x8695 0x111 Homing error dis-
tance

Warning Homing distance
reached.

Homing distance

9.2.3.70 Mechanical brake failure (0xFF01 / 0x112)

This error is valid for SDM 521/SDM 522.

Table 117: Mechanical Brake Failure (0xFF01 / 0x112)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF01 0x112 Mechanical brake
failure

Trip lock No brake or wire fail-
ure.

brake mech fail

9.2.3.71 Short circuit in mechanical brake control (0xFF02 / 0x113)

This error is valid for SDM 521/SDM 522.

Table 118: Short Circuit in Mechanical Brake Control (0xFF02 / 0x113)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF02 0x113 Short circuit in me-
chanical brake con-
trol

Trip lock Short circuit in brake
control.

brake mech short

9.2.3.72 External interface power failure (0xFF0A / 0x114)

This error is valid for SDM 521/SDM 522.

Table 119: External Interface Power Failure (0xFF0A / 0x114)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF0A 0x114 External interface
power failure

Error External interface
power supply fail-
ure.

ext IF pwr fail

9.2.3.73 Position limit exceeded (0xFF03 / 0x12D)

This error is valid for SDM 521/SDM 522.

Table 120: Position Limit Exceeded (0xFF03 / 0x12D)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF03 0x12D Position limit ex-
ceeded

Error SW position limit or
HW limit switch has
been reached or ex-
ceeded.

pos lim exceeded
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9.2.3.74 Initial angle detection has failed (0xFF04 / 0x109)

This error is valid for SDM 521/SDM 522.

Table 121: Initial Angle Detection has Failed (0xFF04 / 0x109)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF04 0x109 Initial angle detec-
tion has failed

Error The initial Angle de-
tection procedure
has failed, check the
alarm subcode.

Inital Angle detect.
fail

9.2.3.75 Communication interrupted (0xFF10 / 0x14F)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 122: Communication Interrupted (0xFF10 / 0x14F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF10 0x14F Communication in-
terrupted

Error The fieldbus com-
munication has
been interrupted
while the device was
enabled.

Comm interrupt

9.2.3.76 Fan feedback inconsistent (0xFF21 / 0x145)

This error is valid for PSM 520 and SDM 521/SDM 522.

Table 123: Fan Feedback Inconsistent (0xFF21 / 0x145)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF21 0x145 Fan feedback incon-
sistent

Warning Internal fan fault.

Internal fan not
running/mounted.

fan feedback

9.2.3.77 Fan lifetime critical (0xFF22 / 0x15A)

This error is valid for PSM 520 and SDM 521/SDM 522.

Table 124: Fan Lifetime Critical (0xFF22 / 0x15A)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF22 0x15A Fan lifetime critical Warning The theoretical life-
time of the fan has
been exceeded.

fan lifetime

9.2.3.78 Timing violation 1 (0xFF60 / 0x115)

This error is valid for PSM 520, and SDM 521/SDM 522.
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Table 125: Timing Violation 1 (0xFF60 / 0x115)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF60 0x115 Timing violation 1 Trip lock Contact Danfoss. timing err 1

9.2.3.79 Timing violation 2 (0xFF61 / 0x116)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 126: Timing Violation 2 (0xFF61 / 0x116)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF61 0x116 Timing violation 2 Trip lock Contact Danfoss. timing err 2

9.2.3.80 Timing violation 3 (0xFF62 / 0x117)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 127: Timing Violation 3 (0xFF62 / 0x117)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF62 0x117 Timing violation 3 Trip lock Contact Danfoss. timing err 3

9.2.3.81 Timing violation 4 (0xFF63 / 0x118)

This error is valid for SDM 521/SDM 522.

Table 128: Timing Violation 4 (0xFF63 / 0x118)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF63 0x118 Timing violation 4 Trip lock Contact Danfoss. timing err 4

9.2.3.82 Timing violation 5 (0xFF64 / 0x119)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 129: Timing Violation 5 (0xFF64 / 0x119)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF64 0x119 Timing violation 5 Trip lock Contact Danfoss. timing err 5

9.2.3.83 Timing violation 6 (0xFF65 / 0x11A)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 130: Timing Violation 6 (0xFF65 / 0x11A)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF65 0x11A Timing violation 6 Trip lock Contact Danfoss. timing err 6
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9.2.3.84 Timing violation 7 (0xFF66 / 0x168)

This error is valid for SDM 521/SDM 522.

Table 131: Timing Violation 7 (0xFF66 / 0x168)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF66 0x168 Timing violation 7 Trip lock Contact Danfoss. timing err 7

9.2.3.85 Timing violation 8 (0xFF67 / 0x16B)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 132: Timing Violation 8 (0xFF67 / 0x16B)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF67 0x16B Timing violation 8 Trip lock Contact Danfoss. timing err 8

9.2.3.86 Timing violation 9 (0xFF68 / 0x16C)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 133: Timing Violation 9 (0xFF68 / 0x16C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF68 0x16C Timing violation 9 Trip lock Contact Danfoss. timing err 9

9.2.3.87 CAM timing violation (0xFF69 / 0x16D)

This error is valid for SDM 521/SDM 522.

Table 134: CAM Timing Violation (0xFF69 / 0x16D)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF69 0x16D CAM timing viola-
tion

Trip lock Contact Danfoss. CAM timing

9.2.3.88 Firmware: Package description mismatch (0xFF70 / 0x11B)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 135: Firmware: Package Description Mismatch (0xFF70 / 0x11B)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF70 0x11B Firmware: Package
description mis-
match

Trip lock The firmware found
does not match the
package description.

FW pack err

9.2.3.89 Firmware: Power cycle needed (0xFF71 / 0x11C)

This error is valid for PSM 520, and SDM 521/SDM 522.
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Table 136: Firmware: Power Cycle Needed (0xFF71 / 0x11C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF71 0x11C Firmware: Power cy-
cle needed

Warning, error The firmware up-
date transfer is com-
pleted but a power
cycle is required
before the new
firmware is active.

need powercycle

9.2.3.90 Firmware: Update started (0xFF72 / 0x11D)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 137: Firmware: Update Started (0xFF72 / 0x11D)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF72 0x11D Firmware: Update
started

Warning, error Firmware update is
in progress.

Warning changes
to error when an at-
tempt is made to en-
able the device in
this state.

FW upd invalid

9.2.3.91 Firmware: Update invalid (0xFF73 / 0x15B)

This error is valid for PSM 520, and SDM 521/SDM 522.

Table 138: Firmware: Update Invalid (0xFF73 / 0x15B)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF73 0x15B Firmware: Update
invalid

Error Invalid or corrupted
firmware package
update.

Last valid firmware
package has been
loaded.

FW upd invalid

9.2.3.92 PWM switching frequency invalid (0xFF74 / 0x15E)

This error is valid for SDM 521/SDM 522.
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Table 139: PWM Switching Frequency Invalid (0xFF74 / 0x15E)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF74 0x15E PWM switching fre-
quency invalid

Warning Selected PWM
switching frequency
via object 0x2396
is not valid with
respect to the ac-
tual fieldbus cycle.
The closest switch-
ing frequency is
adopted. Check ob-
ject 0x201D.03 for
actual value.

PWM freq invalid

9.2.3.93 Interpolation time invalid (0xFF75 / 0x161)

This error is valid for SDM 521/SDM 522.

Table 140: Interpolation Time Invalid (0xFF75 / 0x161)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF75 0x161 Interpolation time
invalid

Error The interpolation
time set via object
0x60C2 is not an in-
teger multiple of
the actual fieldbus
cycle. Check object
0x201D.02 for the
actual value.

Interp time invalid

9.2.3.94 STO active while drive enabled (0xFF80 / 0x11E)

This error is valid for SDM 521/SDM 522.

Table 141: STO Active while Drive Enabled (0xFF80 / 0x11E)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF80 0x11E STO active while
drive enabled

Error STO activated while
drive was enabled or
tried to enable the
drive while STO ac-
tive.

STO active

9.2.3.95 STO mismatch (0xFF81 / 0x11F)

This error is valid for SDM 521/SDM 522.
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Table 142: STO Mismatch (0xFF81 / 0x11F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF81 0x11F STO mismatch Trip lock Dual diagnosis of
STO voltage not
plausible.

STO mismatch

9.2.3.96 P_STO error (0xFF85 / 0x120)

This error is valid for SDM 521/SDM 522.

Table 143: P_STO Error (0xFF85 / 0x120)

Code PROFINET®code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF85 0x120 P_STO error Trip lock P_STO voltage on
the power card ex-
ceeds the limits.

P_STO error

9.2.3.97 Guide value reversed (0xFF90 / 0x121)

This error is valid for SDM 521/SDM 522.

Table 144: Guide Value Reversed (0xFF90 / 0x121)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF90 0x121 Guide value re-
versed

Error Position guide value
went backwards
while the servo drive
was in CAM mode.

guide val rev

9.2.3.98 Guide value implausible (0xFF91 / 0x122)

This error is valid for SDM 521/SDM 522.

Table 145: Guide Value Implausible (0xFF91 / 0x122)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF91 0x122 Guide value implau-
sible

Error Increments between
succeeding values
too large.

guide val impl

9.2.3.99 UDU Guide Value out of range (0xFF92 / 0x126)

This error is valid for SDM 521/SDM 522.

Table 146: UDU Guide Value Out of Range (0xFF92 / 0x126)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF92 0x126 UDU Guide Value
out of range

Error UDU Position Guide
Value is outside the
allowable range
[Gmin, Gmax].

UDU GV out of
range
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9.2.3.100 UDU Guide Value Offset out of range (0xFF93 / 0x12A)

This error is valid for SDM 521/SDM 522.

Table 147: UDU Guide Value Offset Out of Range (0xFF93 / 0x12A)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF93 0x12A UDU Guide Value
Offset out of range

Error UDU Position Guide
Value offset is out-
side the allowable
range [Gmin, Gmax].

UDU GV offset out of
range

9.2.3.101 UDU Min Blending distance out of range (0xFF94 / 0x12C)

This error is valid for SDM 521/SDM 522.

Table 148: UDU Min Blending Distance Out of Range (0xFF94 / 0x12C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF94 0x12C UDU Min Blend-
ing distance out of
range

Error UDU Min Blending
distance is outside
the allowable range
[Gmin, Gmax].

UDU Min Blend-
ing distance out of
range

9.2.3.102 Sign of life error (0xFF95 / 0x14E)

This error is valid for SDM 521/SDM 522.

Table 149: Sign of Life Error (0xFF95 / 0x14E)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

PROFINET® sign of
life error.

PNIO SOL error0xFF95 0x14E Sign of life error Error

Sign of life error. SOL error

9.2.3.103 Safe Drive Internal Failure (0xFF96 / 0x150)

This error is valid for SDM 521/SDM 522.

Table 150: Safe Drive Internal Failure (0xFF96 / 0x150)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF96 0x150 Safe Drive Internal
Failure

Trip lock Safe drive internal
failure

Safe drv fail

9.2.3.104 SIM Internal Failure (0xFF97 / 0x16E)

This error is valid for SDM 521/SDM 522.

Table 151: Safe Drive Internal Failure (0xFF97 / 0x16E)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF97 0x16E SIM Internal Failure Trip lock SIM internal failure SIM fail
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9.2.3.105 SIM Internal Failure Resettable (0xFF98 / 0x174)

This error is valid for SDM 521/SDM 522.

Table 152: Safe Internal Failure Resettable (0xFF98 / 0x174)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF98 0x174 SIM Internal Failure
Resettable

Error SIM internal failure
resettable.

SIM fail res

9.2.3.106 Safe Position Procedure Failed (0xFF99 / 0x175)

This error is valid for SDM 521/SDM 522.

Table 153: Safe Position Procedure Failed (0xFF99 / 0x175)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF99 0x175 Safe Position Proce-
dure Failed

Warning, error Procedure for the
safe position refer-
encing failed.

Safe Proc Fail

9.2.3.107 Production firmware running (0xFF9A / 0x17B)

This error is valid for SDM 521/SDM 522.

Table 154: Production Firmware Running (0xFF9A / 0x17B)

Code PROFINET®code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF9A 0x17B Production firmware
running

Warning, error This FW is only for
Production Tester-
NOT USE IN FIELD

Prod FW
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10 Maintenance, Decommissioning, and Disposal

10.1 Warnings

  WARNING

HIGH VOLTAGE

Potentially lethal voltage is present on the connectors that may lead to death or serious injury.

l Before working on the power or signal connectors (disconnecting or connecting the cable), or performing

any maintenance work, disconnect the Power Supply Module (PSM 520) from the mains and wait for the

discharge time to elapse.

  WARNING

DISCHARGE TIME

The servo system contains DC-link capacitors that remain charged for some time after the mains supply is

switched off at the Power Supply Module (PSM 520). Failure to wait the specified time after power has been

removed before performing service or repair work could result in death or serious injury.

l To avoid electric shock, fully disconnect the Power Supply Module (PSM 520) from the mains and wait

for the capacitors to fully discharge before carrying out any maintenance work on the servo system or

replacing components.

Minimum waiting time (minutes)

15

10.2 Maintenance Tasks
The maintenance tasks for the MSD 520 system are detailed in Table 155. Qualified personnel must perform the maintenance tasks. No

other tasks are required.

Table 155: Overview of Maintenance Tasks

Component Maintenance task Maintenance interval Instruction

All Carry out a visual inspection. Every 6 months Check for any abnormalities on
the surface.

System modules Check the fan. Every 12 months Check that the fan can turn and
remove any dust or dirt.

Hybrid cable Check for damage and wear. Every 6 months If damaged or worn: Replace
the hybrid cable.

Functional safety Perform a system power cycle
and check the STO function.

Every 12 months Activate STO and check the sta-
tus with the PLC.

Screw terminals Check the terminal screws. Every 12 months Tighten the screws with the rec-
ommended tightening torque.

10.3 Inspection During Operation

10.3.1 System Modules

Carry out regular inspections during operation.
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Check:

l The cooling vents are not blocked.

l The fan is not making any unusual noises.

l The condition of electrical wiring and cables.

10.4 Repair
Do not attempt to repair the products. Return defective products to Danfoss. Contact the local Danfoss sales company for information

about returns.

10.5 System Component Replacement

10.5.1 Dismounting the System Modules

1. Disconnect the mains and all auxiliary supplies from the PSM 520 and wait for the discharge time to elapse.

2. Unplug the motor feedback connectors (only on SDM 521/SDM 522).

3. Disconnect the EMC plate on the bottom of the system modules. Do not dismount the connectors from the EMC plate.

a. Unplug the connectors.

b. Unfasten the screw [1] for the EMC plate.

c. Release the EMC plate.

d. Unfasten the PE screw [2].

e3
0b

m
96

9.
10

1
2

Figure 99: Disconnecting the EMC Plate

1 Screw for EMC plate 2 PE Screw

4. Disconnect the I/O shielding plate on the top of the system modules:

a. Unplug the top connectors [1].

b. Release the cable from the shielding clamp [2].
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Figure 100: Disconnecting the I/O Shielding Plate

1 Connector 2 Spring released shielding clamp

5. To release the module, pull up the holding clamp at the top of the backplate.
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Figure 101: Releasing the Module

1 Holding clamp

VLT® Multiaxis Servo Drive MSD 520 > Operating Guide > Maintenance, Decommissioning, and Disposal



6. Tilt the module forward and slide it out of the guiding groove.
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Figure 102: Guiding Groove

1 Guiding groove

7. Tilt the module forward and remove it from the backplate.
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Figure 103: Removing the Module

10.5.2 Fitting and Commissioning the System Modules

1. Check if preparation is required, see 4.6.1 Preparation for Installation of System Modules.

2. Fit the system modules, see 4.7.3 Fitting Instructions for System Modules.

3. Connect the electrical cables, see chapter Electrical Installation.

4. Switch on the system, see 6.9.2 Procedure for Switching on the MSD 520 System.

5. Configure the system modules parameters according to the fieldbus used, see chapter Commissioning EtherCAT® ID

Assignment, Ethernet POWERLINK® Assignment, and PROFINET® ID Assignment.

6. Conduct a test run.

10.6 Cable Replacement

10.6.1 Overview

Replace the cables when the rated number of bending cycles has been reached or the cable is damaged.

  NOTICE

l Do not forcefully connect or fit the connectors. Incorrect connection causes permanent damage to the connectors.

10.6.2 Feed-In Cable Replacement

10.6.2.1 Disconnecting the Feed-in Cable

Procedure:

1. Disconnect the Power Supply Module PSM 520 from its power source .
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Mains network and all auxiliary supplies.

2. Wait for the necessary discharge time to elapse.

3. Disconnect any cables connected to the X3, X4, or X5 ports on the ISD 520/DSD 520 servo drive for easier access to the feed-in

cable.

4. Disconnect the PE wire from the PE screw on the PSM 520 with DAM option.

5. Disconnect the Ethernet connector.

6. Open the cable clamp holding the STO cable.

7. Open the cable clamp holding the feed-in cable on the PSM 520 with DAM option.

8. Loosen the feed-in cable connectors on the PSM 520 with DAM option.

9. Disconnect the feed-in cable from the PSM 520 with DAM option.

10. Loosen the threaded ring of the connector on the servo drive.

11. Disconnect the feed-in cable from the servo drive.

10.6.2.2 Replacing the Feed-in Cable

Replace the feed-in cable with a cable of identical type and length. See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®

FlexMotion™) Design Guide for code numbers.

10.6.2.3 Connecting the Feed-in Cable

Procedure:

1. Connect the female connector of the feed-in cable to the male connector of the 1st servo drive.

2. Turn the threaded rings of the connectors hand tight.

3. Ensure that there is no mechanical tension on the cables.

4. Insert the feed-in cable wires into the correct connector on the EMC plate at the bottom of the PSM 520 with DAM option.

5. Secure the feed-in cable with a cable clamp.

6. Secure the STO cable with a cable clamp.

7. Connect the Ethernet connector to the PSM 520 with DAM option.

8. Connect the PE wire to the PE screw on the PSM 520 with DAM option.

9. Reconnect any cables that were connected to the X3, X4, or X5 ports.

10.6.3 Loop Cable Replacement

10.6.3.1 Disconnecting the Loop Cable

Procedure:

1. Disconnect the Power Supply Module (PSM 520) from its power source.

Mains network and all auxiliary supplies.

2. Wait for the necessary discharge time to elapse.

3. Disconnect any cables connected to the X3, X4, or X5 ports on both ISD 520/DSD 520 servo drives for easier access to the loop

cable.

4. Loosen the threaded rings of the loop cable connectors on both servo drives.

5. Disconnect the loop cable from the servo drives.
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10.6.3.2 Replacing the Loop Cable

Replace the loop cable with a cable of identical type and length. See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®

FlexMotion™) Design Guide for code numbers.

10.6.3.3 Connecting the Loop Cable

Procedure:

1. Connect the male connector of the loop cable to the female connector on the servo drive.

2. Connect the female connector of the loop cable to the male connector on the adjacent servo drive.

3. Turn the threaded rings hand tight on both servo drives.

4. Ensure that there is no mechanical tension on the cables.

5. Tighten the threaded rings of the connectors on both servo drives.

6. Reconnect any cables that were connected to the X3, X4, or X5 ports on both servo drives.

10.7 Fuse Replacement in PSM 520 with DAM Option

If a single fuse blows, replace all the fuses with fuses from the same batch.

Table 156: Fuse CAT Number DC Link

DC link Rated current (A) Code number Supplier

+AKD1 12.8 A 50 215 26. 16

+AKD2 20 A 50 120 06. 25

+AKD3 28 A 50 120 06. 32

SIBA®

Table 157: Fuse CAT Number AUX

AUX Rated current Code number Supplier

+AKD1

+AKD2

15 A 0314020.MXP

+AKD3 25 A 0314030.MXP

LITTELFUSE®

Procedure:

1. Remove the screw and remove the cover from the side of the DAM option.
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Figure 104: Opening the Cover on DAM Option

2. Use the built-in tool in the cover to remove the fuses from the DAM option. Place the built-in tool under the fuse and gently

rotate the cover clockwise until the fuse is released.

Replace the fuses with the same number of identical type fuses.
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Figure 105: Removing the Fuse

3. Reinstall the cover with 1 screw, and tighten the screw (see Figure 104).

Torque 2.0 Nm (17.7 in-lb).

10.8 Fan Replacement

  NOTICE

l See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Design Guide for further

information on fan types.

Procedure:

1. Use a screwdriver as a lever to release the fan holder.

Depending on the size of the module, refer to Figure 106 or Figure 107.

2. Remove the fan.

3. Replace the fan with an identical type fan.
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Figure 106: Fan Replacement on 50 mm (2.0 in) Modules
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Figure 107: Fan Replacement on 100 mm (3.9 in) Modules

10.9 Product Returns
Danfoss products can be returned for disposal at no charge. A prerequisite for this is that they are free of deposits, such as oil, grease, or

other types of contamination that hampers disposal. Furthermore, foreign materials or third-party components cannot be included with

the returned product.

Ship the products free on board to the local Danfoss sales company.
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10.10 Recycling
Take metals and plastics to recycling stations.

The system components are classified as electronic waste, and the packaging is classified as packaging waste.

10.11 Disposal
Devices containing electronic components cannot be disposed of as normal domestic waste.

Dispose of the system components as hazardous waste, electrical waste, recyclable waste, and so on, in accordance with applicable local

regulations.
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11 Specifications

11.1 Product Labels for MSD 520 System Module
Check the product label and compare it with the order data. Use the part number for reference. The part number uniquely identifies the

module type.

Ensure that the product label is clearly legible.

Identify system modules by the original Danfoss product label located on the front of each module.

Example of product label on the front of the system modules

The following data is shown on the product label on the front of the system modules:
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Figure 108: Product Label on the Front of the System Modules (Example)

1 MSD 520 module name 2 (P/N) Part number/(S/N) Serial number

3 Output 4 Data matrix

5 MAC addresses 6 Warning symbols

Example of product label on the side of the system modules

The following data is shown on the product label on the side of the system modules:
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Figure 109: Product Label on the Side of the System Modules (Example)

1 Type code 2 Supply voltage

3 UAUX supply 4 Output voltage

5 Maximum power 6 Ambient temperature range

7 Protection rating
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11.2 Power Supply Module (PSM 520)

11.2.1 Dimensions of PSM 520

All dimensions are in mm [in].
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Figure 110: Dimensions of PSM 520

11.2.2 Characteristic Data for PSM 520
Table 158: Characteristic Data for Power Supply Module (PSM 520)/DAM Option

Definition Unit Power size 1 Power size 2 Power size 3

Input

Mains input voltage V AC 208–480 ±10%, 3-phase

Input current A 16 32 48

5 (230 V AC) 10 (230 V AC) 15 (230 V AC)Input power(1) kVA

10 (400 V AC) 20 (400 V AC) 30 (400 V AC)

UAUX input voltage V DC 24/48±10%

UAUX current consumption at 24 V DC(2)(2) A DC 2.0

UAUX current consumption at 48 V DC(2) A DC 1.0

Output

DC-link voltage V DC 290–680 ±10%

DC-link capacitance μF 1500

Output rated current IN A 20 40 60

VLT® Multiaxis Servo Drive MSD 520 > Operating Guide > Specifications



Table 158: Characteristic Data for Power Supply Module (PSM 520)/DAM Option - (continued)

Definition Unit Power size 1 Power size 2 Power size 3

5 (230 V AC) 10 (230 V AC) 15 (230 V AC)Output rated power PN kW

10 (400 V AC) 20 (400 V AC) 30 (400 V AC)

Output peak current Imax (t < 3.0 s) A 40 80 120

10 (230 V AC) 20 (230 V AC) 30 (230 V AC)Output peak power Pmax( t < 3.0 s) kW

20 (400 V AC) 40 (400 V AC) 60 (400 V AC)

Derating @Tamb 55 °C

(Max output current to nominal value)

% 60

Protective measures – Overload

Short-circuit

Ground fault protection

NOTE: Ground fault protection active only for DC+ side

Internal brake resistor(3)

Peak power Pmax (t < 0.35 s) kW 8.0

Average rated power PN W 110.0

Nominal resistance Ω 20

External brake resistor

Peak power Pmax (t < 50 s) kW 33

Average rated power PN kW 33

Minimum resistance Ω 20

DAM option/Input

UAUX input voltage A DC UAUX PSM

UAUX current consumption at 24 V DC A DC 0.2

UAUX current consumption at 48 V DC A DC 0.1

DAM option/Output

Output voltage V DC VOUT PSM

Output current DC-link Arms 12.8 20 28

Peak current DC-link (rms value) t < 1.0
s

Arms 25 40 56

Output current UAUX A DC 15 15 25

DC-link output cable cross-section [mm2(A
WG)]

2.5 (14) 4.0 (12) 6.0 (10)

Protective measures – Overload

Short-circuit

Ground fault protection

General

Line filter(4) – Category C3

Cooling – Integrated fan

188  < AQ448939736224en-010101 < 130R1343                                                                                                                                                                 Danfoss A/S © 2026.05

VLT® Multiaxis Servo Drive MSD 520 > Operating Guide > Specifications



Danfoss A/S © 2026.05                                                                                                                                                                 AQ448939736224en-010101 > 130R1343 >  189

Table 158: Characteristic Data for Power Supply Module (PSM 520)/DAM Option - (continued)

Definition Unit Power size 1 Power size 2 Power size 3

Mounting – Wall-mounted on backplate using backlink connector

Weight [kg (lb)] 5.8 (12.8)

Dimensions (W x H x D) [mm (in)] 137.3 x 475 x 270 (5.41 x 18.70 x10.63)

1) The PSM 520 overload protection is based on the DC-link average output rated-current IN. The input and output power depends on the effective mains input voltage.

2) Module consumption, under the following condition: Running, no load on I/Os, fan full speed.

3) An external brake resistor can be connected.

4) In accordance with EN 61800-3.

Recommendation of PSM 520 with DAM option output cable

The output cable for the PSM 520 with DAM option supplies DC link and AUX voltage, STO, and fieldbus communication. The output

cable is available in the hybrid cable type for the 2.5 mm2 (AWG 14) and 4.0 mm2 (AWG 12) size.

Standard cables can be used as an alternative. In such a case, ensure that the following conditions are met:

l The selected cables must comply with the minimum ampacity requirements stated in Table 158, with additional 25% margin for the

DC link.

¢ For example, a 12.8 A rated current needs a 16 A rated cable.

l The selected cable must also ensure the minimum required ampacity at the temperature rating of the cable.

¢ Usually 80 °C (176 °F) for CE.

¢ Usually 75 °C (167 °F) for UL.

l The selected fuse must always ensure the cable protection to load condition. See 10.7 Fuse Replacement in PSM 520 with DAM

Option for further information of the fuse replacement.

l The STO cable must be a shielded cable to comply with functional safety requirements. See Table 182 for further information of the

electrical ratings of the STO cable.

l The fieldbus cable must comply with the requirements specified in Table 18.

11.3 Servo Drive Module (SDM 521/SDM 522)

11.3.1 Dimensions of SDM 521/SDM 522

All dimensions are in mm [in].
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Figure 111: Dimensions of SDM 521/SDM 522, Enclosure Size 1 (FS1)
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Figure 112: Dimensions of SDM 521 Enclosure Size 2 (FS2)

11.3.2 Characteristic Data for SDM 521
Table 159: Characteristics Data for SDM 521

Specifications Unit Enclosure size
1 (FS1), 2.5 A

Enclosure size
1 (FS1), 5 A

Enclosure size
1 (FS1), 10 A

Enclosure size
1 (FS1), 20 A

Enclosure size 2
(FS1), 40 A

Input

DC-link V DC 290–680 ±10%

DC-link capacitance μF 330 1000

UAUX input voltage V DC 24/48±10%

UAUX current consumption

(at 24 V DC)(1)(1)

A DC 1.5 1.5 1.5 1.5 2.5

UAUX current consumption

(at 48 V DC)(1)

A DC 0.75 0.75 0.75 0.75 1.25

Output

Output number of phases – 3

Output voltage

phase-to-phase

V AC VDC/sqrt(2)

Output rated current IN Arms 2.5 5 10 20 40

Output rated power PN kW 1.6 3.2 6.4 12.7 25.5

Output peak current Arms 7.5 15 30 45 90
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Table 159: Characteristics Data for SDM 521 - (continued)

Specifications Unit Enclosure size
1 (FS1), 2.5 A

Enclosure size
1 (FS1), 5 A

Enclosure size
1 (FS1), 10 A

Enclosure size
1 (FS1), 20 A

Enclosure size 2
(FS1), 40 A

Nominal switching frequency kHz 5

Possible switching frequency kHz 4/8/10

fSW=4 kHz – 100% (no derating)

fSW=5 kHz – 100% (no derating)

fSW=8 kHz – 75%

Derating of nominal and peak
current for switching frequency

%

fSW=10 kHz – 65%

Derating @Tamb 55 °C

(For any switching frequency)

% 60

Protective measures – Overload

Short-circuit

Ground fault protection

Maximum output frequency Hz 590

Functional safety – STO (standard)

VLT® FlexSafety™ (optional)

General

Cooling – Integrated fan

Mounting – Wall-mounted on backplate using backlink connector

Number of motor connectors – 1

Weight [kg (lb)] 3.9 (8.6) 5.5 (12.1)

Dimensions

(W x H x D)

[mm (in)] 84.3 x 476 x 270 (3.32 x 18.74 x 10.63) 134.3 x 476 x 270
(5.29 x 18.74 x 10.63)

1) Module consumption, under the following condition: Running, no brake current, no load on I/Os, fan full speed, HDSL active.

11.3.3 Characteristic Data for SDM 522
Table 160: Characteristic Data for SDM 522

Specifications Unit Enclosure size 1 (FS1),
2 x 2.5 A

Enclosure size 1 (FS1),
2 x 5 A

Enclosure size 1 (FS1),
2 x 10 A

Input

DC-link V DC 290–680 ±10%

DC-link capacitance μF 330

UAUX V DC 24/48±10%

UAUX current consumption (at 24 V DC)(1)(1) A DC 2.0 2.0 2.0

UAUX current consumption (at 48 V DC)(1) A DC 1.0 1.0 1.0

Output

Output number of phases – 3

Output voltage V AC UDC/sqrt(2)

Output rated current IN Arms 2 x 2.5 2 x 5 2 x 10
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Table 160: Characteristic Data for SDM 522 - (continued)

Specifications Unit Enclosure size 1 (FS1),
2 x 2.5 A

Enclosure size 1 (FS1),
2 x 5 A

Enclosure size 1 (FS1),
2 x 10 A

Output rated power PN kW 2 x 1.6 2 x 3.2 2 x 6.4

Output peak current Arms 2 x 7.5 2 x 15 2 x 30

Nominal switching frequency kHz 5

Possible switching frequency kHz 4/8/10

fSW=4 kHz – 100% (no derating)

fSW=5 kHz – 100% (no derating)

fSW=8 kHz – 75%

Derating of nominal and peak current for
switching frequency

%

fSW=10 kHz – 65%

Derating @Tamb 55 °C

(For any switching frequency)

% 60

Protective measures – Overload

Short-circuit

Ground fault protection

Maximum output frequency Hz 590

Functional safety – STO (standard)

VLT® FlexSafety™ (optional)

General

Cooling – Integrated fan

Mounting – Wall-mounted on backplate using backlink connector

Number of motor connectors – 1

Weight [kg (lb)] 4.0 (8.8)

Dimensions

(W x H x D)

[mm (in)] 84.3 x 476 x 270 (3.32 x 18.74 x 10.63)

1) Module consumption, under the following condition: Running, no brake current, no load on I/Os, fan full speed, HDSL active.

11.3.4 Motor Overload Protection

  NOTICE

l Internal motor overload protection operates at 120% of the motor full load current.

l Instruct SDM 521/SDM 522 with nominal motor current (full load current according to the motor technical label) to use the

protection properly.

  NOTICE

Ensure that the following parameters are set as follows, otherwise the trip time may not be respected.

l Motor overload enable = 1

l Motor overload default value = 70

SDM 521/SDM 522 incorporates internal overload protection in the following multiples of current setting:
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Table 161: Multiples of Current Setting

Multiple of current setting Maximum trip time

7.2 20 seconds

1.5 8 minutes

1.2 2 hours

11.3.5 Motor Overtemperature Protection

The internal motor overload protection implemented in SDM 521/SDM 522 has thermal memory retention and speed sensitivity.

  NOTICE

l Internal motor overtemperature protection is incorporated. Ensure that the parameters defined in 11.3.4 Motor Overload

Protection are set as specified.

l Motor overtemperature sensing is also available. The SDM 521/SDM 522 has an input for motor temperature sensor.

11.4 Expansion Module (EXM 520)

11.4.1 Dimensions of EXM 520

All dimensions are in mm [in].

e3
0b

h6
62

.1
0

87.3
[3.4]

50

[2]
21.3
[0.8]

16
[0.6]

144.75
[5.7]

38
0

[1
5]

6

[0
.2

]

25
[1]

25
[1]

Ø5.2
[0.2]

36
7

[1
4.

4]
7

[0
.3

]

Ø5.2
[0.2]

Figure 113: Dimensions of EXM 520

11.4.2 Characteristic Data for EXM 520
Table 162: Characteristic Data for Expansion Module (EXM 520)

Definition Unit Value

DC link V DC 290–680 ±10%

Maximum current A DC 62
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Table 162: Characteristic Data for Expansion Module (EXM 520) - (continued)

Definition Unit Value

Mounting – Wall-mounted on backplate using backlink connector

Weight [kg (lb)] 0.6 (1.3)

Dimensions (W x H x D) [mm (in)] 87 x 380 x 145 (3.43 x 14.96 x 5.71)

11.5 Connectors on the System Modules

11.5.1 Connector Requirements

  NOTICE

All connectors in the following chapter are intended for a single conductor (solid or stranded).

11.5.2 Backlink Connector

The backlink connector is at the top of the backside of all the system modules.
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Figure 114: Pin Assignment of Backlink Connector

Table 163: Pin Assignment of Backlink Connector

Pin Description

1 24/48 V

2 GND

3 FE: Functional earth

4 DC–

5 DC+
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11.5.3 Brake Connectors

11.5.3.1 Overview of Brake Connectors

Brake connectors are located on the Power Supply Module (PSM 520) and the Servo Drive Modules (SDM 521/SDM 522).

11.5.3.2 Brake Resistor Connector on PSM 520
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Figure 115: Brake Connector on PSM 520

Table 164: Pin Assignment of Brake Connector on PSM 520

Pins
(Left to right)

Description Notes Ratings

1 DC+/R+

2 R–

Used for connecting a brake re-
sistor.

Nominal voltage: 290–680 V DC

Maximum voltage: 290–820 V
DC

Maximum brake current: 41 A

Conductor cross-section range:
0.75–16 mm2 (AWG 18–AWG 4)

  NOTICE

l The maximum length of the brake cable is 30 m (98.4 ft) (shielded).

11.5.3.3 Brake, Motor Temperature Sensor and HIPERFACE® DSL or EnDat 3® Connector on SDM 521/SDM 522

The brake connector on SDM 521/SDM 522 is used for 3 main functions:

l Mechanical brake

l Temperature sensor (If present)

l Motor feedback: HIPERFACE® DSL or EnDat 3® (If used)
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Figure 116: Brake Connector on SDM 521/SDM 522
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Table 165: Brake Connector on SDM 521/SDM 522

Connector name Description Pins Ratings/notes

Mechanical brake, motor tem-
perature sensor, and motor
feedback systems, as HIPER-
FACE® DSL or EnDat 3®.

Used to connect the motors
mechanical brake, thermis-
tor, and HIPERFACE® DSL (if
present).

See Table 166. Nominal voltage: 24 V

Maximum (peak) voltage: 48 V
±10%

Maximum brake current: 2.5 A

Conductor cross-section range:
0.2–1.5 mm2(AWG 24–AWG 16)

Table 166: Pin Assignment of Mechanical Brake and Motor Temperature Sensor Connector on SDM 521/SDM 522

Pins Description Notes Rating/parameter

1 HIPERFACE_DSL+ or P_SD+ for En-
Dat 3

4 HIPERFACE_DSL- or P_SD- for EnDat
3

Used to connect the motors HIPER-
FACE ® DSL or EnDat 3 ® feedback (if
present).

–

2 BRAKE+

5 BRAKE-

Used to connect the motors me-
chanical brake (if present).

Nominal voltage: 24 V

Maximum (peak) voltage: 48 V ±10%

Maximum brake current: 2.5 A

Conductor cross-section range: 0.2–
1.5 mm2 (AWG 24–AWG 16)

3 TEMP+

6 TEMP-

Used to connect the motors temper-
ature sensor (if present).

KTY83–110

KTY84-130

PT1000

PTC

  NOTICE

l The motor temperature measurement can either be connected to the motor feedback connector (see 11.5.14 Motor

Feedback Connectors) or the brake and motor temperature sensor connector on the servo drive module SDM 521/SDM 522.

The connectors cannot be connected in parallel.

  NOTICE

l The signals on this connector are referred to GND and must therefore fulfill reinforced insulation requirements against the

motor phases. The internal insulation must withstand 4240 V DC and an 8000 Vpeak impulse.

  NOTICE

l Only PELV potential can be connected to the temperature sensor input.

  NOTICE

l The maximum length of the brake cable is 80 m (262.5 ft)(shielded).

11.5.4 Ethernet Connectors

11.5.4.1 Overview of Ethernet Connectors

There are Ethernet connectors on all the system modules.
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Figure 117: Ethernet Connector

  NOTICE

l Only PELV potential can be connected to the digital inputs and outputs.

11.5.4.2 Ethernet Connectors on PSM 520 and DAM Option

Table 167: Ethernet Connectors on PSM 520 and DAM Option

Connector name Description Pins Ratings

X1 IN Ethernet IN

X2 OUT Ethernet OUT1

X3 OUT Ethernet OUT2(1)

1: TX+

2: TX-

3: RX+

4: –

5: –

6: RX-

7:–

8:–

According to standard
100BASE-T.

1) Connection to hybrid cable, available only if DAM option is mounted.

11.5.4.3 Ethernet Connectors on SDM 521/SDM 522

Table 168: Ethernet Connectors

Connector name Description Pins Ratings

SDM1 X1 IN Ethernet IN1

SDM1 X2 OUT Ethernet OUT1

SDM2 X1 IN (1)(1) Ethernet IN2

SDM2 X2 OUT (1) Ethernet OUT2

1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

According to standard
100BASE-T.

1) Only on SDM 522.
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11.5.5 I/O Connectors

11.5.5.1 I/O Connector on PSM 520

e3
0b

n3
10

.1
0

1 2 3 4

Figure 118: I/O Connector on PSM 520 (I/O PSM)

Table 169: Pin Assignment of I/O Connector on PSM 520

Pins Description Notes Rating/parameter

1 DIN 1- Digital input

2 DIN 1+ Digital input

Galvanic isolated.

Input voltage: 0–30 V DC.

High (logic 1) voltage: 15–30 V
DC.

Low (logic 0) voltage: <5 V DC.

Maximum input signal fre-
quency: 50 Hz.

Maximum input current at 48 V:
11 mA.

Maximum input resistance: 4.5
KΩ.

3 – – –

4 – – –

The conductor cross-section range is 0.2–1.5 mm2 (AWG 24–AWG 16).

  NOTICE

l Only PELV potential can be connected to the digital inputs and outputs.

11.5.5.2 I/O Connector on SDM 521/SDM 522

1 2 3 4 5 6
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Figure 119: I/O Connector on SDM 521/SDM 522
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Table 170: Pin Assignment of I/O Connector on SDM 521/SDM 522

Pins Description Notes Rating/parameter

1 DigIn1 Digital input Nominal voltage: 0–24 V.

High (logic 1) voltage: 10–30 V
DC.

Low (logic 0) voltage: <5 V DC.

Maximum switching frequency:
100 Hz.

2 GND Ground –

3 DigIn2 Digital input Nominal voltage: 0–24 V.

High (logic 1) voltage: 10–30 V
DC.

Low (logic 0) voltage: <5 V DC.

Maximum switching frequency:
100 Hz.

4 DigOut1 Switched 24 V as digital output
or supply (24 V/50 mA)

Nominal voltage: 24 V ±15%.

Maximum current: 50 mA.

Maximum switching frequency:
100 Hz.

5 GND Ground –

6 DigOut2 Switched 24 V as digital output
or supply (24 V/50 mA)

Nominal voltage: 24 V ±15%.

Maximum current: 50 mA.

Maximum switching frequency:
100 Hz.

The conductor cross-section range is 0.2–1.5 mm2 (AWG 24–AWG 16).

  NOTICE

l Only PELV potential can be connected to the digital inputs and outputs.

11.5.6 UAUX Connector

11.5.6.1 UAUX Connector on PSM 520

The UAUX connector is on the Power Supply Module (PSM 520).
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Figure 120: UAUX Connector
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Table 171: Pin Assignment of UAUX Connector

Pins
(Left to right)

Description Notes Rating/parameter

1 24 V AUX

2 GND

Used for 24–48 V DC input to
the Power Supply Module (PSM
520).

Nominal input voltage:
24 V/48 V DC ±10%

Maximum current: 50 A

Maximum cross-section:
16 mm2

Maximum cable length: 3 m (9.8
ft)

Conductor cross-section range
0.75–16 mm2, solid or flexible
(AWG 18–AWG 4)

  CAUTION

POSSIBLE LOSS OF FUNCTIONAL SAFETY PROTECTION

The functional safety feature may be affected if the UAUX input exceeds 60 V.

l Ensure that the UAUX input remains below 60 V.

  NOTICE

l Only PELV potential can be connected to the UAUX input.

11.5.6.2 UAUX Cable Cross-sections for PSM 520

Table 172: UAUX Cable Cross-sections for PSM 520

Description Value

Minimum cable cross-section for CE (minimum 70 °C, Cu) 16 mm2

Minimum cable cross-section for UL (minimum 60 °C, Cu) 4 AWG

11.5.7 LCP Connector

There is an LCP connector on the front of all the system modules. It is used to connect the LCP directly via a cable. The LCP connector is a

DSUB (9 pole), located on the front of the modules.
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Figure 121: LCP Connector

Position numbers in Figure 121 refer to pin numbers in Table 173.

Table 173: Pin Assignment of LCP Connector

Pins Description Notes Rating/parameter

1 – – –

2 – – –
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Table 173: Pin Assignment of LCP Connector - (continued)

Pins Description Notes Rating/parameter

3 LCP RS-485 Positive RS-485 signal (1)(1) –

4 – – –

5 GND Ground –

6 VCC 5 V supply for LCP 5 V±10% at 120 mA maximum
load

7 – – –

8 /LCP RS-485 Negative RS-485 signal (1) –

9 /LCP RESET Reset Active at < 0.5 V

1) Speed: 38.4 kBd. The levels fulfill the RS-485 specification.

  NOTICE

l Only PELV potential can be connected to the LCP input.

11.5.8 AC Mains Connector

11.5.8.1 AC Mains Connector on PSM 520

The AC mains connector is on the bottom of the Power Supply Module (PSM 520).
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Figure 122: AC Mains Connector

Table 174: Pin Assignment of AC Mains Connector

Pins
(Right to left)

Description Notes Rating/parameter

3 L3

2 L2

1 L1

Used to connect L1/L2/L3 Nominal voltage: 208–
480 V AC ±10%

Nominal power: 30 kW

Maximum cross-section:
16 mm2 (AWG 4)

Conductor cross-section range
0.75–16 mm2, solid or flexible
(AWG 18–AWG 4)
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11.5.8.2 AC Mains Cable Cross-sections for PSM 520

Table 175: AC Mains Cable Cross-sections for PSM 520 

PSM 520 (10 kW) PSM 520 (20 kW) PSM 520 (30 kW)

Minimum cable cross-section
for CE

4 mm2

(minimum 70 °C, Cu)

16 mm2

(minimum 70 °C, Cu)

16 mm2

(minimum 90 °C, Cu)

Minimum cable cross-section
for UL

AWG 10

(minimum 60 °C, Cu)

AWG 6

(minimum 60 °C, Cu)

AWG 4

(minimum 75 °C, Cu)

11.5.9 Motor Connector

11.5.9.1 Overview of Motor Connector

The motor connectors are located on the bottom of the Servo Drive Modules (SDM 521 and SDM 522).
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Figure 123: Motor Connector

Table 176: Pin Assignment of Motor Connector

Pins
(Left to right)

Description Notes Rating/parameter

1 U

2 V

3 W

SDM 521 has 1 motor connec-
tor.

SDM 522 has 2 motor connec-
tors.

Nominal voltage: 208–480 V AC
±10%

Nominal power: Depends on
the servo drive size.

Conductor cross-section range:

l SDM 521 2.5–20 Arms:

Conductor cross-section

range 0.2–6 mm2, flexible
(AWG 24–AWG 8)

l SDM 521 40 Arms: Conductor

cross-section range 0.75–16

mm2, solid or flexible (AWG
18–AWG 4)

l SDM 522 2.5–10 Arms:

Conductor cross-section

range 0.2–6 mm2, flexible
(AWG 24–AWG 8)
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11.5.9.2 Motor Cable Cross-sections for SDM 521

Table 177: Motor Cable Cross-sections for SDM 521 

SDM 521 (2.5 Arms) SDM 521 (5 Arms) SDM 521 (10 Arms) SDM 521 (20 Arms) SDM 521 (40 Arms)

Minimum cable
cross-section for CE

1.5 mm2

(minimum 70 °C, Cu)

4 mm2

(minimum 70 °C, Cu)

10 mm2

(minimum 70 °C, Cu)

Minimum cable
cross-section for UL

14 AWG

(minimum 60 °C, Cu)

10 AWG

(minimum 60 °C, Cu)

6 AWG

(minimum 60 °C, Cu)

11.5.9.3 Motor Cable Cross-sections for SDM 522

Table 178: Motor Cable Cross-sections for SDM 522

SDM 522 (2.5 Arms) SDM 522 (5 Arms) SDM 522 (10 Arms)

Minimum cable cross-section
for CE

1.5 mm2

(minimum 70 °C, Cu)

Minimum cable cross-section
for UL

14 AWG

(minimum 60 °C, Cu)

11.5.10 Relay Connector

11.5.10.1 Overview of Relay Connector

The relay connector is used for a user-defined reaction and is located on the Power Supply Module PSM 520: 1 relay connector.

  NOTICE

l Only PELV potential can be connected to the relay outputs.

l The relay connector has no strain relief, if required fix the cable by other means.

11.5.10.2 Relay Connector on PSM 520

e3
0b

m
69

7.
10

1 2 3

Figure 124: Relay Connector on PSM 520

Table 179: Pin Assignment of Relay Connector on PSM 520 (REL PSM)

Pins Description Notes Rating/parameter

1 NC Normally closed, 24 V DC

2 NO Normally open, 24 V DC

3 COM Common

Nominal current: 2 A

Conductor cross-section range:
0.2–1.5 mm2 (AWG 24–AWG 16)
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11.5.11 STO Connectors

11.5.11.1 STO Connectors on PSM 520

There is 1 input and 1 output STO connector on the Power Supply Module (PSM 520).
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Figure 125: STO Output Connector on PSM 520
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Figure 126: STO Input Connector on PSM 520

Table 180: Pin Assignment of STO Connectors on PSM 520

Connector name Pins Description Notes Rating/parameter

1 STO–

2 STO+

Used for STO output volt-
age to the input of the
other system modules.

3 STO–

STO PSM

4 STO+

Used for STO input volt-
age.

Nominal voltage:
24 V DC ±10%

Nominal current: De-
pends on the number of
servo drives in the appli-
cation

Maximum current: 1 A

Conductor cross-sec-
tion range: 0.2–1.5 mm2

(AWG 24–AWG 16)
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11.5.11.2 STO Connector on the Bottom of PSM 520 with DAM Option

There is 1 output STO connector on the bottom of the Decentral Access Module (DAM option). The output is for the hybrid cable.
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Figure 127: STO Connector DAM Output

Table 181: Pin Assignment of STO Connector on the Bottom of DAM Option

Connector name Pins
(Left to right)

Description Notes Rating/parameter

1 STO+STO DAM

2 STO–

Used for the STO output
from the DAM to the hy-
brid cable.

Nominal voltage:
24 V DC ±10%

Nominal current: De-
pends on the number of
servo drives in the appli-
cation.

Maximum current: 1 A

Conductor cross-sec-
tion range: 0.2–1.5 mm2

(AWG 24–AWG 16)

Plug terminal tighten-
ing torque: 0.22–0.25 Nm
(1.95–2.21 in-lb)

11.5.11.3 STO Connectors on SDM 521 and SDM 522

The STO connectors are on the Servo Drive Modules as follows:

l SDM 521: 1 input and 1 output STO connector

l SDM 522: 2 input and 2 output STO connectors
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Figure 128: STO Connectors on SDM 521/SDM 522
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Table 182: Pin Assignment of STO Connectors on SDM 521/SDM 522

Connector name Pins Description Notes Rating/parameter

1 STO–

2 STO+

Used for STO output
voltage 1/2 to the in-
put of the PSM 520, or
SDM 521/2.

3 STO–

SDM521:

l STO SDM

SDM522:

l STO SDM1

l STO SDM2

4 STO+

Used for STO input volt-
age 1/2.

Nominal voltage: 24 V DC
±10%

Nominal current: De-
pends on the number of
servo drives in the appli-
cation.

Maximum current: 1 A

Conductor cross-sec-
tion range: 0.2–1.5 mm2

(AWG 24–AWG 16)

  NOTICE

l Only PELV potential can be connected to the STO inputs.

11.5.12 UDC Connector

The UDC connector is on the bottom of the PSM 520 with DAM option.
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Figure 129: UDC Connector

Table 183: Pin Assignment of UDC Connector

Pins
(Left to right)

Description Notes Rating/parameter

1 UDC+

2 UDC–

Used to connect the DC-link
voltage from the PSM 520 with
DAM option to the hybrid cable
for the ISD line.

Nominal voltage: 290–800 V DC

Nominal current: Depends on
the number of servo drives in
the application.

Maximum current: 25 A

Conductor cross-section range:
0.2–6 mm2 (AWG 24–AWG 10)

Plug terminal tightening
torque: 0.5–0.8 Nm (4.43–
7.08 in-lb)

11.5.13 AUX Connector

The AUX connector is on the bottom of the PSM 520 with DAM option.
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Figure 130: AUX Connector

Table 184: Pin Assignment of AUX Connector

Pins
(Left to right)

Description Notes Rating/parameter

1 AUX+ (24/48 V)

2 AUX– (GND)

Used to connect the AUX out-
put from the PSM 520 with DAM
option to the hybrid cable for
the line of drives.

Nominal voltage:
24/48 V DC ±10%

Nominal current: Depends on
the number of servo drives in
the application.

Maximum current: 25 A

Conductor cross-section range:
0.2–4 mm2(AWG 24–AWG 12)

Plug terminal tightening
torque: 0.5–0.6 Nm (4.43–
5.31 in-lb)

  NOTICE

l Only PELV potential can be connected to the AUX output.

11.5.14 Motor Feedback Connectors

The motor feedback connectors allow the connection of an encoder or resolver to the Servo Drive Modules SDM 521/SDM 522.

SDM 521 has 1 motor feedback connector (E SDM1).

SDM 522 has 2 motor feedback connectors (E SDM1 and E SDM2).

The motor feedback connectors fulfill the following specifications:

l BISS B

l BISS C

l SSI

l Resolver

l EnDat 2.1

l EnDat 2.2

l For HIPERFACE DSL® and EnDat 3®, refer to the connector in 11.5.3.3 Brake, Motor Temperature Sensor and HIPERFACE® DSL or EnDat

3® Connector on SDM 521/SDM 522 .

Use a shielded feedback cable that fulfills the requirements for the used feedback type. The maximum cable length is 80 m (262.5 ft).
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Figure 131: Motor Feedback Connector on SDM 521/SDM 522

Position numbers in Figure 131 refer to pin numbers in Table 185.

Table 185: Pin Assignment of Motor Feedback Connectors E SDM1 and E SDM2

Pins Description Resolver BISS B, BISS C, SSI HIPERFACE® EnDat 2.1 and 2.2 Rating/parameter

1 SUPPLY+(1) – X X X +5/11 V (depend-
ing on feedback
type), maximum
250 mA.

2 SUPPLY_SENSE+(2) – X X X Positive supply
sense line.

3 TEMP+ X X X X Motor tempera-
ture sensor input.

4 RESSY X – – (3)(3) Resolver positive
exciter output.

5 RESCOS+ X – X (3) Resolver positive
cosine input.

6 RESSIN+ X – X (3) Resolver positive
sine input.

7 ENC_CLK- – X – X Encoder negative
clock signal.

8 ENC_RXTX- – X X X Encoder negative
data signal.

9 GND – X X X Ground.

10 TEMP- X X X X Motor tempera-
ture sensor input.

11 RESSY- X – – (3) Resolver negative
exciter output.

12 RESCOS- X – X (3) Resolver negative
cosine input.

13 RESSIN- X – X (3) Resolver negative
sine input.

14 ENC_CLK+ – X – X Encoder positive
clock signal.

15 ENC_RXTX+ – X X X Encoder positive
data signal.

1) The supply switches automatically between 5 V and 11 V depending on which feedback type is selected.

2) To activate the internal power supply compensation, connect only the positive sense lines (SUPPLY_SENSE+, pin 2) on the motor side to the supply (SUPPLY+, pin 1). This

automatically adapts the supply voltage, depending on the cable length, and compensates the voltage drop over the feedback cable.

3) The SINE and COSINE signals are optional for EnDat.
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  NOTICE

l The motor temperature measurement can either be connected to the motor feedback connector or the brake and motor

temperature sensor connector on the servo drive module SDM 521/SDM 522 (see 11.5.3.3 Brake, Motor Temperature Sensor

and HIPERFACE® DSL or EnDat 3® Connector on SDM 521/SDM 522 ). The connectors cannot be connected in parallel.

l The motor temperature measurement can either be connected to the motor feedback connector or the brake and motor

temperature sensor connector on the servo drive module SDM 521/SDM 522. The connectors cannot be connected in

parallel.

  NOTICE

l Only PELV potential can be connected to the motor feedback connector.

11.5.15 Expansion Module Connector

11.5.15.1 Expansion Module Connector on EXM 520
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Figure 132: Expansion Module Connector

Table 186: Pin Assignment of Expansion Module Connector

Pins
(Left to right)

Description Note Rating/parameter

1

2

DC+

3

4

DC–

Shield the DC cables using the
cable tie on the EXM 520 EMC
plate.

5 FE (functional earth) –

6 GND –

7 24/48 V –

Nominal voltage: 290–680  V DC

Maximum voltage: 290–800 V
DC

Nominal current: Depends on
the number of servo drives in
the application.

Maximum current: 62 A(1)

Conductor cross-section range:
0.75–16 mm2, solid or flexible
(AWG 18–AWG 4)

Only use with ferrule without
plastic sleeve with CRIMPFOX
16 S.

Use shielded conductors for
UDC (DC+, DC–).

Plug terminal tightening
torque: 1.7–1.8 Nm (15.05–
15.93 in-lb)

1) The maximum current rating for 1 pair of EXM is 62 A. In systems with 2 PSM 520 modules, 2 pairs of EXM 520 modules can be used to achieve a maximum current rating of 124 A.
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11.5.15.2 Cable Cross-sections for EXM 520

Table 187: Minimum Cable Cross-sections for EXM 520 Cables

Cable CE UL

DC+/DC– 16 mm2 (minimum 70 °C, Cu) 6 AWG (minimum 75 °C, Cu)

24 V, functional PE 16 mm2 (minimum 70 °C, Cu) 6 AWG (minimum 90 °C, Cu)(1)

1) Minimum 75 °C is allowed if less than 45 A is measured on the cable.

11.6 General Specifications and Environmental Conditions for MSD 520 System
Table 188: General Specifications and Environmental Conditions for MSD 520 System

Specification Value

Protection rating IP20 according to IEC/EN 60529 (except connectors, which are
IP00).

  WARNING

RISK OF ELECTRICAL SHOCK

The IP20 rating of system modules is not fulfilled if the

system is operated with a module that is not connected to

the backplate. This may result in death or serious injury.

l Do not touch the backplate when a module is

removed from the backplate.

Vibration test Sinusoidal vibration: 1.0 g (2h/axis according to EN 60068-2-6)

Storage/transport: 5–95% (non-condensing)Maximum relative humidity

Stationary use: 5–93% (non-condensing)

Operating: 5–40 °C (41–104 °F) nominal, up to 55 °C (131 °F) with
derating (see Figure 133)

Transport: (-25 °C...+55 °C) (-13 °F...+131 °F)

Ambient temperature range

(Surrounding air temperature)

Storage: (-25 °C...+55 °C) (-13 °F...+131 °F)

Installation altitude Nominal current up to 1000 m above sea level.

Derating of output current (1% / 100 m) at 1000–3000 m.

Operation above 3000 m is not allowed.

EMC standard for emission and immunity EN 61800-3

EMC immunity for functional safety EN 61800-5-2 Annex E

Degree of pollution according to EN 60664-1 2

Overvoltage category according to EN 61800-5-1 III
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Figure 133: Derating

11.7 Storage
Store the system components in a dry, dust-free location with low vibration (veff ≤0.2 mm/s).

The storage location must be free from corrosive gases.

Avoid sudden temperature changes.

Long-term storage

To recondition the electrolytic capacitors, system components that are not in service must be connected to a supply source once per

year. This allows the capacitors to charge and discharge, and prevents them from suffering permanent damage.
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